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Unit- 1 

Introduction to Information Technology- I 

1.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Define terms and explain characteristics associated with computer technology. 

 Discuss the influence of computer technology in a society. 

 Discuss the contributions of computer technology to education. 

 Discuss the contributions of computer technology to business. 

 Discuss the contributions of computer technology to everyday living. 

1.1 Introduction 

Technology influences different areas of society and business, whether it is a particular age 

group or gender, or the entire population. We may be resistant to its influences, whether in the 

long or short term, until we are more aware on how this change impacts our lives, families, 

work, entertainment, or daily living. 

This unit explains terms associated with computer technology, explains its influence, and 

contributions to various aspects of work and play. Then it briefly reviews the development of 

the technology and explains the different categories of computer systems. 

1.2 Introduction to Information Technology 

Let us start by understanding the concept of computer technology. Quickly, in 30 seconds, 

calculate the answer to 12 + 54 + 23.65 + 12.89 + 23¼ + 90 + 12 + 980 + 234 + 567 in your 

head or on paper. Did you complete it in time? See the next page for the answer. 

You may be surprised to learn that people were the first computers! The term computer means 

someone who computes or performs calculations. Centuries ago, people were called computers. 

They were usually women who worked out mathematical problems such as tidal charts or 

navigational tables, and so ‘Computer’ was actually a job title. 

However, as you can imagine, performing mathematical tasks every day, every week, every 

month would eventually cause boredom which would cause errors in the calculations. 

Therefore, the computer became a machine which automated these repetitive tasks. 

A computer therefore is a machine which: 

 accepts data (called INPUT); 

 follows instructions given on what to do with the data (called PROCESSING); 

 stores the results for future use (called STORAGE); and 
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 display the results (called OUTPUT). 

Answer: 2008.79 

 

By applying technology to different problems and work environments we can enhance 

situations or events that would have been almost inconceivable without it. For example, voice 

mail, satellite television or cell phones are all examples of technology that use a computer to 

operate the system. Computer technology therefore involves any machine, tool or piece of 

equipment that is essentially controlled by a computer chip that is able to make calculations. 

The role of computers and computer technology is the ability to manipulate data into 

information or commands. Data can be in many forms, such as text, pictures or sound and can 

also be retrieved from the environment. An air conditioner which monitors the temperature in 

a room to keep it cool at a specific temperature, or turning on lights outside a building at dusk 

are both examples of a computer controlled environment that requires input to produce a 

specific result or output. 

 

1.2.1 Computer Technology is Everywhere 

Information has become very important as a result of the computer technology which provides 

it. Computer driven technology is an integral part of our daily routines, however we tend not 

be aware of its presence. Many of our daily tasks are automated; such as our answering 

machines, televisions, cable boxes, vehicles that use this technology. Similarly, as a cashier 

prints out our receipt for a purchased item or the mail we receive that was stamped by a 

machine, computer technology supported the creation of the receipt or the delivery of our mail 

automatically. 

We therefore say that computer technology is ubiquitous, or everywhere (almost!) once 

information is present. To summarize, many utility companies are now recording our usage to 

prepare monthly bills, which will be printed by a machine, while a local or overseas phone 

companies record voice messages and the calls we missed. Also, our banks’ automated systems 

are automatically charging us every time we use the debit or credit card. The automated systems 

are controlled by a computer process based on the input from your retailer, the machine itself 

or from the scanner. 
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1.3 Generating Information 

Remember that computers store the results or output of processing the data. Well computer 

technology has enabled us to access information at our "finger tips"; from many places, in 

many places, at any time, and in many different forms whether printed or stored. Hence as more 

information is requested, more information is generated and more data stored. It seems like a 

never ending cycle of information growing exponentially! 

Unfortunately, there is a drawback to generating information on every transaction. Imagine 

how one minor error can mushroom into major problems because of your computer technology, 

and this can have a negative impact on businesses and customers alike. In addition, most people 

who are not in the computer field may believe that whatever the computer produces is correct. 

Consider the consequences of transposing (switching) two digits in a bank account number or 

entering the wrong data in payroll system. This can cause embarrassment to the persons 

involved if deposits are made to the wrong account or employees do not receive the correct 

pay. Even so, it is also more difficult to locate someone who is willing to accept responsibility 

for an error made by a computerized system. This lack of accountability for the error would be 

better addressed if the software glitch was corrected as soon as possible! 

We should also realize that since information is constantly generated, then it should be possible 

to store it over a long period of time. It is reasonable to assume therefore that information 

cannot be entirely destroyed or lost. 

1.4 Accessing Information 

Much of the computer information that is generated and held in a database is available online. 

For example, customers can use the telephone or Internet to access current bank balances and 

perform transactions. Access to your banking information can be made from almost anywhere 

in the world. This has led to a new work ethic where computer technology has enabled 

employees to work from various geographic locations, or time zones. Computer technology 

has provided people with increased mobility while talking with someone on the phone, or 

receiving a fax. 

Information can be retrieved and sent in many forms including text, voice, graphics, photos 

and video. Additionally, the "information superhighway" has increased the availability of these 

forms of information delivery methods. One major concern of the recording industry is the 

ability to reproduce digital material such as video tapes and DVDs, which are indistinguishable 

from the original. This technology has caused headaches to the industry’s composers and 

performers since any digital file can be easily duplicated and shared. 

With access to information, and digital voice and smart technologies automated voices have 

replaced operators who traditionally greeted customers and initially responded to their queries. 
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It is now commonplace to call businesses and hear an automated switching system and voice‐

mail system instead of an actual person who can assist you. 

1.5 Surveillance 

Computer technology has certainly allowed surveillance or the gathering of information for 

different of purposes. Surveillance software allows individuals, companies and government to 

monitor you in a variety of locations including other countries. Surveillance equipment such 

as cameras and key pads now include transactional data which is collected from virtually all 

types of transactions, including cash purchases and the acquisition of services to analyze trends. 

One example is the use of Google Earth to capture topographical pictures of different locations 

on the earth and more recently Google has released their street view software that allows you 

to wander the streets of your city using 3D technologies.  

1.6 Changing the way we communicate 

With the use of the computer and its technology used extensively throughout our society, you 

are probably aware of how computer technology has changed the way we communicate with 

another person or among groups of people. The use of email, instant messenger and text 

messages have modified the usual visual and verbal signs when communicating with someone 

else. This of course can be both a benefit and a detriment to the communication process. For 

example, the use of computer tools such as email, instant messenger and text messages mask 

features such as gender, race, age, and physical disability, social or marital status. Even distance 

learning has changed the way people are educated, as this manual and your online activities 

illustrate! Your relationship with the facilitator is remote and you may only hear a voice or read 

the words on a page written by your instructor. Much of the distance or blended learning 

materials and content are delivered though the use of databases, audio or video feeds and other 

means such as Moodle or Blackboard. This has become a reality for many who wish to further 

their education while employed full‐time or those who are unable to access a physical campus 

at a local institution. 

1.7 What is Information Technology(IT) 

Let’s start with the term information. Information refers to data that has been put into a 

meaningful and useful context. 

Information systems refer to a set of people, procedures and resources that collects, transforms, 

and disseminates information in an organization. Information systems are implemented within 

an organization for the purpose of improving the effectiveness and efficiency of that 

organization. 

As an entrepreneur you will need to use a system to provide for the flow of information within 

your business. Computers is playing a vital part in obtaining, processing and sharing 
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information within a business which means that an entrepreneur will have to make use of a 

computer‐based information system. 

This requires that you must have an understanding technologies used in computer‐based 

information systems – use of hardware, software and people resources to transform data 

resources into information. 

Information Technology (IT) is the area of managing technology and spans a wide variety of 

areas that include but are not limited to things such as processes, computer software, 

information systems, computer hardware, programming languages, and data constructs. In 

short, anything that renders data, information or perceived knowledge in any visual format 

whatsoever, via any multimedia distribution mechanism, is considered part of the domain space 

known as Information Technology (IT) (Wikipedia). 

TechAmerica defines IT as the study, design and implementation of computer-based 

information systems, particularly software applications and computer hardware. IT deals with 

the use of electronic computers and computer software to convert, store, protect, process, 

transmit and securely retrieve information (www.answer.com). 

The discipline of Information Systems can best be described as the effective analysis, design, 

construction, delivery, management and use of information and information technology in 

organizations and society. An Information System, per se, is an organized collection of people, 

procedures, data, machines and services that work together to deliver information 

(http://www.is.ru.ac.za/?q=content‐2 ). 

So we can conclude that: 

Information technology (IT) refers to the different ways (electronic computers and computer 

software) of obtaining, processing, storing, and transmitting data in the form of voice, pictures 

and words. 

The term Information Technology (IT) is also known as Information Communication 

Technology (ICT), and we shall continue to use that term henceforth because it combines 

computing and communications. The computer is a key feature of ICT and the key to an 

effective business is how the entrepreneur uses his or her ICT resources to grow and manage 

the business. 

1.8 Impact of Information and Communication Technology (ICT) 

on Society  

Today’s society is referred to as the ‘digital age’. Computers and ICT devices have become an 

integral part of our lives and are used everywhere. Be it the desktop computers, laptop 

computers or more recently tablet computers, all contribute to the activities we experience in 
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our daily life. We use these devices in schools, at home, hospitals, institutions, businesses and 

even in government offices. 

In general the impact of computers on society and how we live our lives is as follows: 

 You can use computers to communicate with your family and friends, create a 

household budget, book travel and movie tickets, or manage your business. The internet 

has also tremendously increased people’s ability to communicate with others from all 

over the world efficiently and relatively cheaply. 

 In business and industry, you use computers to maintain accounts, create personnel 

records, track inventory, prepare presentations and reports, manage projects, and 

communicate by e‐mail. You can use computers to design any type of publication 

ranging from simple newsletters to fashion magazines, marketing materials, books, or 

newspapers. 

 In the field of education, trainers can use computers to deliver training through audio‐

visual learning aids, maintain student records to track performance, search for 

information on different topics, and create or submit assignments. 

 In government organizations, you use computers to organize information by storing and 

updating records. Computers are also used for providing services to citizens. For 

example, you can view information on current policies and government issues on a 

computer. 

 In the field of medicine, doctors use computers to review medical records of patients. 

Doctors also use computers to find information about the latest drugs available to treat 

a disease. Doctors can also use computer technology to discuss and share information 

about various diseases. 

 You can use computers to view the details of your bank account. Traders use computer 

technology to get instant information on stock markets, to trade stocks, and to manage 

investments. 

 Scientists use computers for scientific research, and to gather and analyze information. 

For example, they use computers to view images from space and to publish information 

on their recent research. 

 You can also use computers to create drawings and paintings. Photographers use 

computers to edit and enhance pictures. Writers use computers to write content for their 

books and to also create illustrations. By using computers, writers can make changes in 

the content easily and save a lot of time. 

 In the field of entertainment, you can use computers to listen to music, watch movies, 

store and print photographs, send greetings, and play games. 
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                                                                                                        [Source: Microsoft 

Corporation] 

1.9 Threats to Information Systems 

Computer‐based information systems are much more vulnerable to crime and abuse, natural 

disaster, and even human error than manual systems that they have replaced. 

1.9.1 Computer Crime 

Computer Crime ranges from the use of information technology to commit an act that would 

be criminal no matter how committed (such as the theft of money or other property) to activities 

more specifically related to computers, such as the unauthorized access and use of information 

systems, theft of computer and telecommunications services, and the theft, intentional 

alteration, or destruction of data or programs. The protection of customer data and business 

confidential information is an issue that faces all entrepreneurs. 

1.9.2 Theft of Money 

As financial institutions become more and more reliant on computers, new opportunities have 

arisen for criminals to use computers to steal or siphon off money. Password protection and 

other security tools must be used to protect bank accounts, investments and other financial 

resources. 

1.9.3 Theft of Computers and Computer Parts 

As computers and the various computer parts have become smaller and smaller, it have become 

easier to steal. Microprocessor chips, memory chips, motherboards, modems, disk drives, and 

power supplies are all frequent targets. They can be removed relatively easily and sold to a 

readily available underground market. Physical security and effective inventory control 

measures should be implemented. 

1.9.4 Alteration or Destruction of Data and Programs 

Another form of computer crime involves the alteration or destruction of data and programs. 

Motives for this crime may include monetary gain, revenge or just being malicious. This tie in 

with computer viruses, which are a set of illicit instructions implanted within a program that 

passes itself onto other programs with which it comes into contact. Appropriate software must 

be used to protect your business files, data and other online resources from external and internal 

attacks by cyber criminals and hackers. 

1.9.5 System Disasters 

In addition to computer crime, information systems are susceptible to natural disasters (Rain, 

earthquakes, fire and floods), terrorist attack, electrical power and telecommunications line 
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failure, hardware and software malfunction, even human error. Off‐site backups and in some 

cases backups to computers in another island or nation is recommended when your region is 

subjected to regular national disasters. 

1.10 Computer Technology in Work and Play 

Now that we have understood some terminology and features of computer technology, let us 

look more closely at various aspects of work and play, and how technology affects each one. 

This section will allow discussion on some of the impacts in the last, and thoughts on the next 

decade. 

Inventions already introduced into society through computer technology, have caused the 

society to change, with the cellular phone (or cell phone) being the most recent to reach the 

populations. It is now an everyday occurrence to reach anyone, anywhere with the use of a 

cellular phone. Not as openly known, but still commonplace however, is the use of the smart 

prosthesis on someone who previously could not walk after an accident. Simulations of people 

walking or running for example have furthered the invention of essential types of prostheses. 

1.10.1 Science, Medicine, Health and Technology 

Simulation and simulators are often used in scientific research to mimic the event that is being 

studied. These programs quickly perform number crunching calculations, so that the event can 

be accelerated, slowed or changed to help predict and test certain outcomes. Therefore 

programs can assist with the simulation of training in dangerous situations, without using 

expensive resources. 

Since health care matters to everyone, it is not surprising that computer technology has become 

a natural part of our health and wellbeing, but its use and relevance has implications in 

everything we do…and not do! If you would like to explore how medical organizations are 

using simulation and other computer technologies to provide professional development to 

health care professionals and support science education in the schools go to the Howard Hughes 

Medical Institute, Bio‐interactive site. 

Computer technology is integral part of the health and wellness sector. CTI scanners and other 

diagnostic tools are driven by computer technology. Our health records are placed into 

databases to be used and retrieved when you visit the hospital or your local doctor. Science has 

had an incredible impact within the last century. Toffler in his book “The Third Wave” has 

identified computer technology as a new phase in the evolution of society. 

Technology has made the following medical procedures possible. Many of these procedures 

have generated considerable debate about the ethics of these procedures. Some of these 

procedures include the use of technology to support: 

 Test tube babies; 
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 Organ transplants; 

 Cloning; 

 Nuclear radiation; 

 Limb replacement; 

 Gene therapy; and 

 Nerve regeneration. 

1.10.1.1 Telemedicine 

Some of you may have previously seen or heard the terms teleconferencing or telecommuting. 

The Greek word 'tele' means ‘distance’, so teleconferencing provides opportunities to have a 

conference without all persons having to be in the same room, city or country. Similarly 

telecommuting or the less popular term, ‘tele‐working’, was first offered in the 1960s by the 

information technology industry. This arrangement allowed employees to work at home and 

communicate with the office by methods such as phone, fax and computer. 

So we now have yet another term ‘telemedicine’, where ‘medicine’. Telemedicine involves 

telecommunications, where medical personnel and their patients are separated by some 

physical distance but are connected through technology so the professional can complete a 

medical procedure. Some of the services offered by telemedicine include medical diagnoses, 

pathology, radiology, and consultation, so that expertise can be made available in rural and 

remote areas. 

1.10.1.2 Medical Self‐Diagnoses 

Many people are using knowledge‐based database systems to research cures and symptoms of 

ailments, probably for self‐diagnoses. These database systems, called expert systems perform 

tasks that would otherwise be performed by someone with expertise in the field. Expert systems 

can be used, not only to diagnose human illnesses, but also to make financial forecasts, and 

schedule routes for delivery vehicles. However, it is important to note that while some expert 

systems replace human experts, there are others designed to assist them. 

Having a medical complaint which is embarrassing should not be the sole reason to avoid 

consulting a doctor. Although there are well‐documented and researched medical expert 

systems (such as WebMD) being able to access a website on the Internet to diagnose symptoms 

does not automatically validate the authenticity or correctness of the online diagnosis. Only a 

doctor can do this. Database technologies are now used to store dental records, x‐rays, medical 

insurance forms and other records for administrative, management and cross referencing. Here 

are some further examples of the development of database systems with associated 

technologies which are used as expert systems and have become tools for medical research. 
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1.10.1.3 Research 

Research on genetics has discovered entire sets of genetic instructions in the cells of our body, 

their sequences and any possible unique features or abnormalities. Using computer technology 

has afforded: 

The discovery of a gene which has the pre‐disposition to develop colon cancer can save a life 

if genetic screening is done early. In contrast, persons in the early 1970s were either denied 

insurance coverage or were asked to pay increased premiums if they carried the gene for sickle 

cell anemia. Forensic personnel used computer technology to assist in the identification of 

people missing at the World Trade Centre. Tools were used to compare the victims’ DNA with 

an item used by the victims, such as a toothbrush. 

1.10.2 Education and Technology 

Computer technology has moved the classroom from a teacher using a ‘chalk and blackboard’ 

to deliver passive instruction to student centred, discovery learning environments that employ 

a variety of computer and Internet technologies. Computer technology has allowed 

disenfranchised students in places like rural areas who at one time could not participate in 

traditional instruction to benefit from an anywhere, anyplace philosophy for the delivery of 

educational programs. 

In Barbados, technology is now becoming a part of the classroom with the assistance of a 

government sponsored educational initiative called Edutech 2000. This programme is 

providing training in Information and Computer Technologies (ICTs) for teachers and students 

alike in order to develop the country’s future workforce and ensure the country has suitable 

skills to compete in the international market. 

In most countries today the typical public school program includes some instruction in 

computer technology, computer literacy skills and software familiarization. Most public 

schools throughout the Caribbean and parts of Africa have access to computers within their 

schools. Technology is being used to support instruction and increase student and teacher 

technical knowledge and skills. 

The introduction of computers to support classroom instruction has met mixed reactions. Some 

teachers embrace it, but many resist it because they don’t have the pre‐requisite skills to 

properly employ the technologies. Change will take time, resources and more teacher 

professional development. The Commonwealth of Learning is supporting the Open School 

Movement and the use of ICT to support instruction and student learning. Check it out. 

Computer technologies and the advent of the Internet have allowed online universities to 

flourish. Examples of fully online universities include Indira Gandhi National Open University, 

Uttarakhand Open University, National Open University of Nigeria, Athabasca University and 

the Open University of the United Kingdom Online universities and similar organizations 
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around the world provide opportunities for millions of students to study anywhere and at any 

time. 

Working professionals are now able to further their education without having to travel while 

maintaining full‐time employment and an appropriate quality of life. 

There are some disadvantages however with online activities, which include the lack of 

opportunity for human interaction and socialization. Many online students experience the 

feeling of isolation. Although the inclusion of online discussion forums and chat capabilities 

have somewhat alleviated this problem, there is still an issue with misinterpretation and 

miscommunication associated with text messages and phrases. 

The online learning environment is slowly embracing new technologies like Podcasts, social 

networking software like Facebook, instant messaging technologies like Skype and web 

conferencing systems like Elluminate. Web 2.0 tools are helping close the social divide and 

providing more opportunities to interact with peers learners and others in the educational 

communities. 

1.10.3 Business and Technology 

Computer technology has had a major impact on day to day business operations. Today 

companies that have failed to incorporate technology are viewed as being ‘not‐up‐to‐date’ or 

archaic. Today organizations must have a presence on the Internet. Their company’s goods and 

services must be marketed online. Prolific use of electronic mail (or email) and electronic forms 

have replaced paper based forms and traditional snail mail (letters mailed through a post office). 

It is now the norm for business professionals to use technology to produce every memo, 

envelope, label and document using a word processer. Effective marketing materials require 

the use of graphic software and more to create and produce the layouts. Business presentations 

are created using computer software and delivered via laptop computers and projectors. 

Electronic payments and business banking accounts require the use of e‐commerce software 

and secure Internet connections. The computer revolution has allowed traditional businesses to 

reduce infrastructure costs by allowing their employees to work from home. In North America 

over 40 million employees work from home using different types of Information and 

Communications Technologies (ICTs). 

As traditional business practices become automated business leaders and HR personnel now 

demand that their current and future employees be computer literate. In the many parts of the 

developing world it is proving to be a challenge for those who are unable to reach the required 

standard thus impacting their employability. 

1.10.4 Social Interactions and Relationships 

The ability to text chat in a real time environment with your peers is known as Internet Relay 

Chat (IRC). IRC tools to support chat are available through your cell phone provider or on the 
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Internet. Some of the more popular real time chat tools include Microsoft Live Messenger, 

Yahoo Messenger and others. These tools are becoming the norm for social interaction 

(especially among younger computer users) and it challenges in how people have traditionally 

interacted with each other – face to face discussions vice text chats with its own sub‐culture 

language. As the cartoon below illustrates texting has become part of our culture. 

 

I suspect there were smiles as you read the cartoon, but has the cartoon become a reality today? 

Are people unknowingly hiding behind the technology in order to minimize communicating 

with each other? Do people speak more freely with the use of technology or in person? 

Over the years the Internet has evolved from a deliverer of static information text based 

technology to a platform that encourages social networking, idea exchange, collaboration and 

online community building. Tools like Facebook, Yahoo Groups and others allow individuals 

to connect with individuals of like minds and create their own virtual network of friends and 

colleagues. Tools like YouTube and Blogger have allowed everyone to create and share their 

own information. Everyone has opportunity to contribute to the world knowledge base and 

provide their own interpretation of personal, local, regional or national events. 

This form of the Internet is known as Web 2.0 and has democratized our virtual space. 

Everyone is now equal and can post personal messages for the world to read. 

1.10.4 Man- Machine Connection 

I would hope by now that you would agree much of the world cannot live without having some 

form of computer technology in their lives. Does this mean that we are controlling computer 

technology or is the technology controlling us? During the late 1980s and 1990s, the Internet 

invaded our lives. Movies and TV shows included the Internet and sophisticated computers to 
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entertain us. Some interesting ones were the 1982‐1986 weekly television crime fighter series 

‘Knight Rider’ which portrayed a modern‐day hero who drove a high‐tech smart car equipped 

with artificial intelligence. Sandra Bullock’s 1995 movie ‘The Net’, involved an Alfred 

Hitchcock style drama about having her identity electronically erased and replaced with a 

stranger’s information. Then in 1998, there is Will Smith starring in ‘Enemy of the State’ which 

speaks about the use of satellites to track people, as well as in ‘I Robot’ in 2004 about a 

‘humanoid’ robot that is suspected to have murdered its creator. Whether you have seen these 

movies or not, the implicit use of computer technology in each of them sends the message that 

whether to help or hinder, that technology is everywhere. Today it is digitally generated 3D 

movies and animations like Avatar have caught our attention. These movies would not be 

possible without computer generated images and human machine interactions to capture life 

like character movement. 

Technology has advanced so fast that more and more computers have an incredibly high fault 

tolerance, with robots automating the repair process, without any human intervention. One 

example are the robots that are used by NASA to repair the International Space Station. 

Seriously, we are not that far away from computers repairing themselves. 

Let us now consider computer logics. Do “they” have the capability of handling complex 

thought processes like human ones? Almost! 

1.10.4.1 An Example – Man Machine Practical Application 

In 1998, a technology entrepreneur in northeastern Washington was implanted wtih a Radio 

Frequency Identification (RFID) chip into his hand in order to experiment with the technology. 

The chip and supporting computer technology was used to gain keyless entry to his car and 

home, turn on lights, logon to his and other remote and repetitive applications. The experiment 

was successful and led to other applications for RFID technology. 

An implantable RFID chip is a minuscule capsule containing a microchip and an antenna, all 

enclosed in glass. The chip is about the size of a grain of rice. RFID chips work by storing a 

unique identification number in the microchip. This number can be retrieved by a special RFID 

reader that is held within close proximity. Today there are most often implemented in animals 

to track their whereabouts and to include owner information that can be retrieved by a scanner 

used by a vet or other animal agency. 

Although RFID technology is relatively old, it is still considered a controversial technology. 

Privacy advocates fear that the technology might be abused by governments and used to track 

people. Microchip implants have been used for years for tracking lost pets. Further European 

research in the area was recently dealt a blow when the European Group on Ethics in Science 

and New Technologies made a presentation to the European Union raising privacy concerns 

over the potential for such chips to be used to track members of the public. 
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When employing different technologies, we must be aware of not only the technical issues, but 

issues of privacy, morality, society norms and ethical practices. 

1.11 Summary 

After reviewing this unit, reading the suggested articles and exploring the different links you 

should have concluded that: 

 It seems that computer technology is largely responsible for the ‘emergency’ attitude 

of modern society. The perception that everything must be done faster, arrive sooner, 

or be available immediately has pushed services and information to be frequently 

available on a 24‐hour basis. 

 With computer technology, the types of negative impacts and the number of people 

directly affected by a single system error has grown enormously to where millions can 

be directly affected. 

 There is unprecedented accessibility to information and communications, available to 

large numbers of people from nearly anywhere we happen to be. 

 A computer is a machine which accepts data (called input), follows instructions given 

on what to do with the data (called processing), stores the results for future use (called 

storage) and displays the results (called output). 

 The main role of computers and computer technology is the ability to manipulate data 

into information. 

 Computer technology is ubiquitous, or (almost) everywhere. 

 Computer technology has enabled us to access information at our ‘finger tips’, from 

many places, in many places, at any time, and in many different forms whether printed 

or stored. 

 Information can be retrieved in many forms such as text, voice, graphics, and video. 

 Computer technology has allowed surveillance to be made easier with the additional 

software that can monitor locations in other countries. 

 Computer technology has changed the way we communicate with another person or 

among groups of people. 

 Computer technology can improve our lives in health and medicine such as research in 

cures for diseases. 

 Teleconferencing provides opportunities to have a conference without all persons 

having to be in the same room, city or country. 
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 Telecommuting allows employees to work at home and communicate with the office 

by methods such as phone, fax and computer. 

 Telemedicine involves telecommunications, where medical personnel and the patient 

are separated by some physical distance. 

 Expert systems perform tasks that would otherwise be performed by someone with 

expertise in the field. 

 Databases are now used to store dental records, x‐rays, medical, insurance and other 

records for searches and purposes of cross referencing. 

 Computer technology has not completely replaced previous inventions; rather it is 

enhancing and improving on previous ones. 

 Businesses have felt most of the impact of computer technology, such that if there is 

little technology incorporated then the business may be frowned upon as being ‘not‐up‐

to‐date’ or archaic. 

 Internet relay chat (also known as messenger), is a common method of chatting with 

someone either next to you in class, or is a local phone call away. 

 Many of us cannot live without having some form of computer technology in our lives. 

 

Reference 

Powley, R. (2011). Introduction to Computers. Retrieved Sep. 21, 2017, from 

http://doer.col.org/bitstream/123456789/8192/1/2011_VUSSC_Intro-Computers.pdf avaialble 

under CC‐BY‐SA license. 

 

License 

 
This work is licensed under a Creative Commons Attribution-ShareAlike 4.0 International 

License. 



CVDMM(N) 202- Office Automation and Internet Skills  UOU 

Unit- 2: Introduction to Information Technology- II Page 19 of 207 

Unit- 2 

Introduction to Information Technology- II 

 

2.0 Learning Objectives 

After studying this topic, you will be able to: 

 Describe the major developments in each generation of computer development. 

 Evaluate the need for different types of computer systems. 

 Distinguish between different hardware components of a computer. 

 Explain the functions/uses of the different components. 

2.1 Introduction 

Today many jobs mainly depend on the either the creation or collection, and distribution of 

information. This topic addresses the different advancements in computer technology and the 

various types of computers and their critical components. As each new computer generation 

improves on its previous generation, there have been a corresponding reduction in size (or 

miniaturization) of computer circuitry. In contrast to this miniaturization, the speed, power, 

and memory of computers have proportionally increased. Although this Topic will describe the 

major developments of each computer generation, it is more important to consider how the 

technology has influenced the development of current computer systems. 

Table 1: Generations of Computer 
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2.2 The First Generation Computer (1940S‐1950S) 

2.2.1 Vacuum Tubes 

These early computers comprised huge vacuum tubes (similar to light bulbs) whose main 

purpose was to strengthen weak signals for transmission. The vacuum tubes acted as switches 

to start and stop the instant flow of electricity. The concept underlying the on/off switch was 

the idea of ones and zeros. The combination of ones and zeros or on and off created a type of 

machine language that could be used to process information. 

The first computer, the Mark 1, was so huge that it filled a typical stadium field and was said 

to have used more than 500 miles of wire. Its success however was its processing power, such 

as a mathematical problem that normally took 40 hours to solve, only took the Mark 1, 20 

seconds to produce a result. It was used by the U.S. Navy during World War II, to help solve 

strategic military mathematical problems such as cracking secret codes and creating complex 

fire tables for naval guns and artillery. Scientists used the computer to predict weather patterns 

and for analyzing problems in airplane design. As noted earlier the language of this first 

generation was called machine language, which comprised zeros and ones for programming 

the computer. 

The next computer, the ENIAC (Electronic Numerical Integrator and Computer) was an 

improvement on the Mark 1, since its processing power was about 1,000 times faster. The 

ENIAC was about 80 feet (24.4 m) long by 3 feet (0.9 m) wide, and used about 18,000 vacuum 

tubes. Unfortunately, the tubes were very hot, had to be replaced frequently, and were costly 

in using much electricity to keep them cool. The UNIVAC (Universal Automatic Computer) 

soon replaced the ENIAC by containing a compact 5000 tubes, a reduction from the 18,000 

used in the ENIAC. 

2.3 The Second-Generation Computer (Mid 1950s – early 1960s) 

2.3.1 Transistors 

During this generation the significantly smaller transistors (a new technology) eventually 

replaced vacuum tubes as the processing component of the computer. This allowed engineers 

to dramatically reduce the size and space needed to house a computer. Transistors proved to be 

cheaper to produce and emitted no heat, thus reducing the costs of manufacturing and making 

the technology more reliable since they conducted electricity faster vacuum tubes and failed 

less often. 

This generation was noted for making space travel possible, and for the development of more 

sophisticated programming languages that allowed programmers to use short specific terms 

(e.g. ADD) to represent certain computer processing instructions. Higher level programming 

languages such as FORTRAN, ALGOL and COBOL, which use short English‐like words, were 
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developed during this generation. During this generation computer hardware and software was 

created that allowed users to store and retrieve programming instructions. 

2.4 The Third Generation Computer (Early 1960s – Early 1970s) 

2.4.1 Integrated Circuits 

This generation improved on the previous one by miniaturizing the transistor and building 

several onto a single chip of silicon. This compacting of millions of transistors in a small space, 

also called an integrated circuit, greatly increased the power of computer, the processing speed, 

lowered its production costs even more and reduced the size of the computer. 

During this generation the creation of new input and output devices were created. Keyboards, 

monitors, and the mouse made the computer a more user-friendly environment and eliminated 

the need for huge stacks of punch cards to input data into a main frame computer. Output of 

the computer calculations could be read on screen vice printing out large amounts of paper with 

graphic symbols on them 

2.5 The Fourth Generation Computer (Early 1970s – Mid 1980s) 

2.5.1 The Microprocessor 

Again, an improvement on the previous generation, this generation continued to reduce the size 

of the silicon chip comparable to the size of a pencil eraser while vastly increasing its 

computational speeds. This single chip with the components and processing speeds of a 

computer was called a micro‐processor and was initially intended for use in calculators, not 

computers. 

During this generation the silicon chip technology was harnessed by the chip manufacturer 

Intel. Intel in partnership with IBM created the first microcomputer, or personal computer. A 

few years later Apple in partnership with Motorola introduced the Macintosh to compete 

against the IBM personal computer. Only recently has Apple recognized the need for 

standardization and has embraced the Pentium technologies currently supported by Intel. 

During this periods new and more powerful programming languages developed. This included 

Pascal, C and compilers which converted the program to a lower-level language that the 

machine could process. The UNIX operating system was also developed during this time to 

manage system resources.2.6 The Fifth Computer Generation Computer (Mid 1980s – Early 

1990s) 

2.6.1 Artificial intelligence and Parallel Processing 

The goal of this generation is to develop devices that are capable of responding sensibly to a 

user’s natural language and also capable of learning and self‐organization. It is characterized 

by the introduction of computers with hundreds of processors that could be assigned to work 
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on different sections of a single program. This is called parallel processing, and is being used 

to develop communication between a computer in natural spoken language and its user, through 

access to a vast knowledge database to make intelligent inferences and draw logical 

conclusions in the way that humans do. 

Several programming languages known as artificial intelligence (AI) languages have been 

developed simply because they are used almost exclusively for AI applications. The two most 

commonly used languages are LISP and Prolog. The linking of computers together, called 

computer networks, and the increasing use of workstations were also developed during this 

generation. 

2.7 The Sixth Generation (Mid 1990s to Present) 

2.7.1 Computers and Video Games 

This era refers to the generation of computer and video games which became popular around 

1998. The Nintendo Game Cube, Sony PlayStation 2, and Microsoft's Xbox are noted to have 

dominated game playing in all age groups. 

 

Figure 1: General Timelines of Generations of Computer 

2.8 Types of Computer Systems 

In the past computers were classified as microcomputers, minicomputers, or main‐frame 

computers, based on their size. Today these distinctions are rapidly disappearing as the 

capabilities of even the smallest units rival that of their earlier big brothers. Today’s 

microcomputers are faster, more powerful and more versatile than the minicomputers and the 

main‐frame computers were a few years ago. Table below describes the terms used to classify 

todays of computers and computing devices. 

Type of 

Computer System 
Brief Description 
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Desktop Computer 

A PC that is expected to be placed on the top of a computer or other 

desk. Desktops usually are powerful and have reasonably large 

secondary storage. Desktops require a number of input and out devices 

to make them useful. 

Laptop 

Compared to the desktop, laptops are portable computers that have 

their monitor, keyboard, and other memory and storage devices all 

included in a package that is up 17 inches in size and is powered by a 

special battery. Laptops are also called notebooks. 

Mainframe 

Mainly associated with large companies, that process millions of 

transactions calculations from multiple sources at one time, 

mainframes previously filled large rooms, but today consist of a 

number of linked components that allow the different processors to 

communicate with one another and share their total computing power. 

Minicomputer 
Minicomputers are powerful and can support many users at once. Their 

size is between microcomputers (PCs) and mainframes. 

Palmtop 

More commonly called Personal Digital Assistants (PDAs). They are 

compact computers that often use special secondary flash memory 

instead of a typical hard drive for storage. Palmtops usually have 

optional keyboards but mainly use touch screens for input. They are 

typically the size of a paperback novel or even smaller and are very 

lightweight and use battery power. 

Personal Computer 

Personal Computers (PC) was designed to be used by individuals for 

general use. The PC is not usually associated with the Apple Mac 

although it is a PC. Often the term desktop and PC are used 

interchangeably. 

Server 

A computer that has been optimized to provide services to other 

computers over a network. Servers usually have powerful processors, 

lots of memory and large hard drives. They often provide custom 

services such as an e‐mail server, a backup server, a database server, 

etc. 

Supercomputer 

Supercomputers have the world’s fastest processors and are able to 

perform millions of computations a minute. Supercomputers are 

normally comprised of multiple high-performance computers working 

in parallel as a single system. The best-known supercomputers are built 

by Cray Supercomputers. 
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Wearable 

Computer 

This is the latest trend in computing where common computer 

applications such as electronic mail, are integrated into watches, cell 

phones, visors and even clothing. 

Workstation 

A workstation is a desktop computer with a more powerful 

processor, and more memory for performing a special function, such 

as 3D Graphics 

 

2.9 Computer Hardware and Peripherals 

2.9.1 INPUT Devices 

You use input devices to provide information to a computer, such as typing a letter or giving 

instructions to a computer to perform a task. Some examples of input devices are described in 

the following list. 

1. Mouse: A device that you use to interact with items displayed on the computer screen. 

A standard mouse has a left and a right button. 

2. Trackball: This is an alternative to the traditional mouse and is favoured by graphic 

designers. It gives a much finer control over the movement of items on the screen. Other 

screen pointing devices are pointing stick, touch pad, joystick, light pen, digitizing 

table. 

3. Keyboard: A set of keys that resembles a typewriter keyboard. You use the keyboard 

to type text, such as letters or numbers into the computer. 

4. Scanner: A device that is similar to a photocopy machine. You can use this device to 

transfer an exact copy of a photograph or document into a computer. A scanner reads 

the page and translates it into a digital format, which a computer can read. For example, 

you can scan photographs of your family using a scanner. 

5. Barcode Readers: When used in a business barcodes provide a lot of information. Made 

up of columns of thick and thin lines, at the bottom of which a string of numbers is 

printed. 

6. Multimedia devices: This is the combination of sound and images with text and 

graphics. To capture sound and image data, special input devices are required. 

a. Microphone: Voice input, for instance, can be recorded via a microphone. A 

device that you can use to talk to people in different parts of the world. You can 

record sound into the computer by using a microphone. You can also use a 

microphone to record your speech and let the computer convert it into text. 
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b. Webcam: A device that is similar to a video camera. It allows you to capture 

and send the live pictures to the other user. For example, a webcam allows your 

friends and family to see you when communicating with them. 

c. Digital cameras: record photographs in the form of digital data that can be stored 

on a computer. These are often used to record photographs on identity cards. 

2.9.2 OUTPUT Devices 

Output devices in the computer system are the equipment whereby the result of a computer 

operation can be viewed, heard or printed. You use output devices to get feedback from a 

computer after it performs a task. 

1. Monitor: A device that is similar to a television. It is used to display information, such 

as text and graphics, on the computer. 

 

Figure 2: Monitor 

2. Printer: A device that you use to transfer text and images from a computer to a paper or 

to another medium, such as a transparency film. You can use a printer to create a paper 

copy of whatever you see on your monitor.  

a. Impact printers: Dot matrix printers are an example of impact printers. They 

form characters from patterns of dots. They are inexpensive, but the output can 

be difficult to read. 

 

Figure 3: Impact printer 

b. Non impact printers: Inkjet printers work by shooting a jet of ink in the shape 

of the character required, they provide good, low‐cost colour printing. 
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Figure 4: Non-impact printer 

c. Laser printer:  a laser beam is directed at an electro‐statically charged surface, 

creating a template of the page to be printed. This template is then used to 

transfer the ink to the page. Toner sticks to the light images and is transferred 

to paper. 

 

Figure 5: Laser Printer 

3. Plotter: A plotter is an output device similar to a printer, but normally allows you to 

print larger images. It is used for printing house plans and maps. 

 

Figure 6: Plotter 

4. Multimedia Output Device: The most common multimedia output is sound, including 

music. The audio output device on a computer is a speaker. Headphones can also be 

used to receive audio output. 
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Figure 7: Multimedia Output Device 

2.10 Process and Storage Devices 

The system unit is the name given to the main computer box that houses the various elements 

as illustrated in the picture below. How do we get the different computer parts to work together 

so that your computer can work? Let’s start of our discussion with the process devices. 

 

Figure 8: System device 

2.10.1 Mother Board 

Inside the systems unit is a circuit board with tiny electronic circuits and other components 

which is called a mother board. It is sometimes called a system board. The motherboard 

connects input (keyboard, mouse and scanner), output (monitor, speakers, and printer), 

processing (CPU, RAM and ROM) and storage (hard drive, CD‐ROM/DVD‐ROM and flash 

drives) components together and tells the CPU how to run (Lubbe and Benson, 2010:18). Other 

components on the motherboard include the video card, the sound card, and the circuits that 

allow the computer to communicate with devices like the printer. 

 

Figure 9: Motherboard 
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2.10.2 Expansion Cards 

Yes you can play music and video files on your computer. But how is it possible? 

Inside the computer system box you also find an expansion card which is another circuit board 

that can be attached to the motherboard to add features such as video display and audio 

capability to your computer. Expansion cards are also called expansion boards that enable your 

computer to use the multimedia devices. An expansion card either improves the performance 

of your computer or enhances its features. Examples of expansion cards that can be added 

include: 

1. Video Card: It is connected to the computer monitor and is used to display information 

on the monitor. 

2. Network Interface Card (NIC): The NIC allows the computer to be connected to other 

computers so that information can be exchanged between them. 

3. Sound Card: It converts audio signals from a microphone, audio tape, or some other 

source to digital signals, which can be stored as a computer audio file. Sound cards 

also convert computer audio files to electrical signals, which you can play through a 

speaker or a headphone. The microphone and the speakers or the headphones connect 

to the sound card. 

2.11 Storage Devices 

All computers need to store and retrieve data for processing. The CPU is constantly using 

memory from the time that it is switched on until the time you shut it down. There are two 

types of storage devices as illustrated in the flow chart below. 

 

Figure 10: Types of storage devices 

Primary Storage is also called main memory or immediate access store (IMAS). This is 

necessary since the processing unit can only act on data and instructions that are held in 

primary storage. Primary storage consists of two types of memory chips: 

 

 Random Access Memory (RAM) 
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 Read Only Memory (ROM) 

2.11.1 Random Access Memory (RAM) 

Random Access Memory (RAM) is the main working memory. RAM is only filled after 
computer has been turned on and is given something to do. It holds data and instructions 
temporarily while processing takes place. RAM is volatile – this means that if the power is 
turned off or the computer reboots (start up again) all the information held in RAM will be 
lost. RAM is measured in MB (megabytes) and most entry level computers will have 1024 

MB RAM but you also find some computers having up to 3 GB RAM. RAM chips are 

expensive and the price of a computer is determined by the amount of RAM space in the chip. 

 

Figure 11: RAM 

2.11.2 Read Only Memory (ROM) 

Read Only Memory (ROM) holds data and instructions necessary for starting up the computer 

when it is switched on. These instructions are hard‐wired at the time of manufacture. ROM is 

permanent and cannot be deleted but can only be accessed or read, hence the name Read Only 

Memory. Data stored in ROM is non‐volatile – meaning that memory will not be lost when 

power is turned off. 

 

Figure 12: ROM 

2.11.3 Units of Storage 

The memory of all digital computers is two‐state (bi‐stable) devices. Computers operate using 

a binary number system – and therefore use binary digits (bits). Bits have only two values by 
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0 and 1. A bit is the smallest unit of storage in a computer. The amount of data and instructions 

that can be stored in the memory of a computer or secondary storage is measured in bytes. 

A byte is made up of a combination of eight (8) bits and has the storage power to represent 

one character (a character is a letter or symbol or punctuation mark or blank space). 

 

2.11.4 Secondary Storage Devices 

PCs use a simple method of designating disk drives to store data. These drives are assigned 

letters of the alphabet. 

 

Data and information stored on a permanent basis for later use. Secondary storage is cheaper 

to purchase and access. Hard disks, Zip drives, Optical disks (CD’s and DVD’s) are all 

examples of secondary storage. 

1. Internal Hard Disks are rigid inflexible disks made of highly polished metal. Data is 

stored magnetically. They can contain a single disk or two or disks stacked on a single 

spindle. They come in a variety of sizes but all have a very high storage capacity 

compared to floppy disks. An average computer has a hard disk of about 80 ‐250GB. 

It provides direct access to information. 

 

Figure 13: Internal hard disc 
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2. External hard Disks/Drive ‐ same features as the internal hard disks, but are external 

to the system unit and therefore can be carried around.  

 

Figure 14: External hard Disc 

3. USB flash drive consists of a flash memory data storage device integrated with a USB 

(Universal Serial Bus) interface. USB flash drives are typically removable and 

rewritable. They come in a variety of sizes to include 128MB, 256MB, 512MB, 1G, 

2G, 8G etc. 

 

Figure 15: USB flash drive 

4. Memory Card ‐ Use mainly with digital cameras, cellular phones and music players 

(MP3, MP4 and iPods). They offer high‐re‐record ability and fast and power‐free 

storage. Data can be access by linking the card to a computer using a USB cable or a 

memory card reader. 

 

Figure 16: Memory card 

5. Optical Disks are disks that are read by laser beams of lights. The three main types are 

CD‐R, CD‐RW and DVD. 
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Figure 17: Optical disc 

a. CD‐R or CD‐ROM (Compact Disk – Read Only Memory) are so called because 

you can only red the information on the CD‐ROM. They are particularly useful 

for storing multimedia (texts, graphics, sound and videos), application 

software packages. 

b. CD‐R or Compact Disk Recordable allows you to write information onto the 

disk only once using a CD recordable burner. 

c. CD‐RW or Compact Disk Rewriteable, allows you to write and erase 

information from the disk many times. They are used to store large volumes 

of information such as texts, graphics, sound and video. 

d. DVD disks or Digital Versatile Disks are specifically created to store movies. A 

typical DVD disk can hold between 4.7GB and 17GB of information. 

2.12 Activity 

1. Consider the advantages and disadvantages of the development of artificial intelligence 

in this generation. 

2. Reflect upon what facilitated the increase in speed, power or memory in each of the 

computer generations. 

3. Explain, with reasons, which computer system(s) would be most appropriate in the 

following examples: 

a. Business executive who travels often 

b. Student who needs to prepare a history project report 

c. A multi‐million dollar company with six branches in the country and three in 

other countries 

d. Banking system with many tellers who access the same customer database 

4. Look around in your immediate environment (shops, government institutions, at home, 

etc) and see if you can recognize any of the above discussed input devices. Can you 

remember the functions of each of the devices that you have identified? 
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2.13 Summary 

1. Since the 1940s when computer technology was used to support the creation of firing 

tables for the artillery and to the introduction of the World Wide Web network of 

computers in the 1980s computer technologies have become a large part of our 

everyday life. The use of computers is accelerating. They are now in our cars, our 

phones, our refrigerators. Almost every type of electronic device has a computer chip 

in it. Each chip relays on commands. Commands must be input using different devices. 

The next topic will examine some of these input and output devices. 

2. Computer hardware consists of input, output, process and storage devices. 

3. You use input devices such as keyboard, mouse, scanner and multimedia devices to 

provide information to a computer. 

4. Output devices are use to get feedback from a computer after it performs a task. 

5. Examples include monitor, printer and multimedia devices. 

6. CPU takes raw data and turns it into information. The CPU is made up of Control Unit, 

Arithmetic Logic Unit (ALU) and the main memory. 

7. Storage devices are divided in primary and secondary storage devices. 

8. Primary/main memory is subdivided into ROM and RAM. 

9. Random Access Memory (RAM) is the main memory and allows you to temporarily 

store commands and data. 

10. Read Only Memory (ROM) retains its contents even after the computer is turned off. 

11. A bit is the smallest unit of storage in a computer. 

12. The amount of data and instructions that can be stored in the memory of a computer or 

secondary storage is measured in bytes. A byte is made up of a combination of eight 

bits and has the storage power to represent one written character. 

13. Hard disks, CD‐R, CD‐RW and DVD are secondary storage devices. 

Reference 

Powley, R. (2011). Introduction to Computers. Retrieved Sep. 21, 2017, from 

http://doer.col.org/bitstream/123456789/8192/1/2011_VUSSC_Intro-Computers.pdf avaialble 

under CC‐BY‐SA license. 

License 

 
This work is licensed under a Creative Commons Attribution-ShareAlike 4.0 International 

License 



CVDMM(N) 202- Office Automation and Internet Skills  UOU 

Unit- 3: Introduction to Information Technology- III Page 34 of 207 

Unit- 3 

Introduction to Information Technology- III 

3.0 Learning Objectives 

After studying this topic, you will be able to: 

 Distinguish between a computer and a computer system. 

 Explain the term general computer system. 

 Explain the term embedded system. 

 Show diagrammatically the components of a computer system. 

 Describe a central processing unit (CPU). 

 Explain arithmetic and logic unit (ALU). 

 Define primary memory and how it functions. 

3.1 General Purpose Computer System 

When you look at a desktop computer, it comprises a monitor, keyboard, mouse, and a vertical 

or horizontal box called a system unit.  It is acceptable to refer to all of these components as a 

computer. Technically the systems unit houses the actual ‘computer’ or programmable machine 

(hardware, firmware and software), which executes (carries out) or responds to a sequence of 

program instructions. A computer system then is a collective term for a computer (housed 

within the system unit), as well as these other components that are attached to it to allow the 

user to input data and view output using different devices. Some of these components include 

a monitor, keyboard, mouse, printer, disk drives, scanners, microphones, and speakers, which 

are also referred to as peripherals.  The peripherals work together to help the user accomplish 

a given task effectively. Therefore, as an example, when you perform a calculation, the 

keyboard – a peripheral device‐ is used to input the data.  

It is the system unit that accepts and processes the data, and generates the results. Other 

peripheral devices such as the hard drive store the data and results, which can be viewed on the 

monitor. 
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Figure 18: General Purpose Computer System 

The peripheral devices mentioned above are collectively called hardware devices, since they 

can be physically attached to the computer. However, computer systems also include software, 

or programs that are integral in the functioning of some of these peripheral devices and are 

necessary to make the computer operate. Every computer system, for example, requires an 

operating system. An operating system is a program that establishes communications with the 

various peripherals and acts as a bridge to other application specific software programs. An 

operating system is like the command centre of the ship. It makes all of the decisions about 

how the computer will function and work with others. 

3.2 Embedded Computer Systems 

The typical personal computer or laptop described in the last discussion is categorized as a 

general‐purpose computer system. This section will explore a special type of computer system 

called an embedded system. Embedded systems are designed to perform a very small number 

of very specific functions. For example, a GPS computer in a car only provides driving 

instructions. It cannot perform any other computing function. A typical embedded system also 

uses certain types of hardware, and limited resources, such as small keyboards, screen and 

reduced memory. These systems are also actually built into the device they are controlling. 

Compared to a typical computer, embedded systems are often smaller in size, tend to be 

cheaper, and as a result many are mass‐produced. Embedded systems range from small portable 

devices to large complex systems. The major difference is that they are single purpose devices 

with only one form of input or output. Some may also have simple user interfaces or displays 

which include buttons, or touch screens, while others have none at all. 
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Table 2: Examples of systems and devices which comprise embedded systems 

 

Mobile (cellular) phones and handheld computers may be categorized as embedded systems, 

but since these devices can be enhanced with the addition of other applications and peripherals, 

they are better suited to the category of general-purpose computer systems and not really 

embedded systems. 

3.3 Computer System- How it Works 

The major components of a computer system include input and output devices as well the 

important processor or central processing unit (CPU). The CPU comprises a set of electronic 

circuits kept within the system unit. The CPU is the brain of a computer system and is 

responsible for processing the data that is input from a peripheral device and output to another 

peripheral device. Figure 19 illustrates the major components of a system unit that is attached 

to an input and output device.  

Figure 19: Central Processing Unit 
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The Central Processing Unit (CPU), also known as the processor or microprocessor has 

components that control the operating system and other software installed on the computer. 

The CPU also sends commands and data to the peripherals attached to the computer, such as 

the monitor or printer.  

Therefore the speed (how fast the electrons move around the chip) at which the CPU executes 

its tasks (or commands) determines how quickly you can view or hear the output from the 

command; such as printing a page or allowing you to view a letter on the monitor. This speed 

is called ‘clock speed’, and is measured in megahertz (MHz). A computer system that responds 

to commands quicker means that its clock speed is working faster to execute these commands. 

Table 2 compares some common CPUs and their clock speeds. Different CPUs use different 

silicon chips to execute the commands and process data. Different types of chips have different 

clock speeds based on the technology that was used to create them. Some examples are 

provided below. 

Table 3: Typical CPU Speeds Based on Chip Type 

 

Now let’s look deeper into the operation of the CPU. All computer systems have a CPU which 

comprises (1) a control unit and (2) arithmetic and logic unit (ALU). 

3.3.1 The Control Unit (CU) 

The control unit is similar to an efficient manager.  It is responsible for directing other parts of 

the computer system in order to carry out the instructions for the task required. The control unit 

(CU) must interact with the arithmetic and logic unit (ALU) and memory to complete its tasks.  

As instructions are fetched from memory, the CU interprets the instruction. The CU then sends 

commands to other components to gather data that may be needed to complete the instruction, 

even if it involves a transfer of data from other components and devices. The CU than 

determines where to send the result. This may include activating the printer, showing the result 

on the monitor or playing a sound on the speakers. 
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3.3.2 Arithmetic and Logic Unit (ALU) 

The Arithmetic and Logic Unit (ALU) is the part of the CPU which performs all arithmetic and 

logic operations this involves arithmetic calculations including addition, subtraction and 

multiplication. As calculations are required, the Control Unit sends them to be performed in 

the ALU which sends the result back to the Control Unit. It also performs logic operations such 

as comparisons of numbers or letters to test for, such as equal‐to (=), less‐than (<), greater‐than 

(>) and other combinations, such as less‐than or equal‐to (<=). 

3.3.3 Memory 

Primary memory is necessary to store instructions and data for processing, but they are not part 

of the CPU. Memory is a separate chip stored on a mother board which connects all the 

hardware together. Program instructions or data are kept in primary memory for only as long 

as the program currently using them. In human terms this would be considered “short term 

memory”. The original instructions and data are lost once the computer is turned off; therefore, 

primary memory is deemed volatile. In later units we discuss those non‐volatile devices which 

allow data and instructions to be permanently stored in a computer system for use later on. 

Primary memory is also as – memory, main memory, primary storage, main storage, internal 

storage, computer memory and RAM (Random Access Memory). 

3.4 Processing Data 

Processing data is the most important activity in the computer, and so the task of the processor 

is to interpret and execute program instructions, in order to transform data into information. 

The processor is also responsible for interacting with the input, output and storage devices. 

Keeping instructions and data in primary memory when a program is not in use is not feasible 

for three reasons: 

 The processed data may be too much to be held in primary memory. 

 Generally primary memory only stores data and instructions while the computer is 

turned on, but once the computer is turned off, the data and instructions are lost. 

 If more than one program or application is opened at the same time, then, a single 

program should not exclusively use all the memory; some memory should be available 

for the other programs to use. 

The amount of memory available to hold the data and instruction is measured in megabytes or 

MB. A personal computer with a minimal amount of memory of say less than 512 MB may not 

be able to perform efficiently and may be rather slow in executing the applications. Memory is 

also loosely known as RAM which is an acronym for Random Access Memory. It should be 

noted there that the word random implies that data can be retrieved quickly, and in the same 

length of time, regardless of where the data is located (that is, the address of the data). 
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3.4.1 Read Only Memory (ROM) 

Read‐only memory or ROM is an integrated circuit, programmed with specific data when it is 

manufactured. It is used in computer systems and other electronic devices. RAM and ROM are 

different since data stored in ROM cannot be modified easily. In other words, ROM is ideally 

suitable for storing a set of data for the life of the device, and is therefore non volatile. Modern 

types of ROM include such as Programmable ROM (PROM), Erasable Programmable ROM 

(EPROM), Electrically Erasable Programmable ROM (EEPROM) and flash memory can be 

erased and re‐programmed many times, although they are still called ROM because the 

reprogramming process is usually rarely done. Many ROM chips are often identified by the 

prominent circular ‘window’ which allows ultraviolet (UV) light to enter and erase its contents. 

Flash memory (or simply flash) is a modern type of EEPROM which can be erased and 

rewritten faster than EEPROM. Flash memory is mainly used in memory cards, USB flash 

drives, memory stick, flash stick and jump drive), which are used for general storage and 

transfer of data between computers and other digital products. 

3.4.2 Function of the Machine Cycle 

Consider a user who needs to add two numbers, 10 and 15. These numbers may be input at the 

keyboard and the results shown on a screen. The processing of this simple addition is carried 

out in the CPU. 

Let us examine how a single instruction is executed or carried out in the central processing 

unit. Of course, computers today generally execute one instruction at a time, although as 

quickly as a fraction of a second. 

In order to carry out an instruction, the program instructions and data must be moved into 

memory from either an input device or a secondary storage device. Once in memory, the control 

unit and ALU in the CPU work together to perform the following four steps (fetch, decode, 

execute, and store) for each instruction. These steps are collectively known as the machine 

cycle or the processing cycle. This machine cycle has two phases, the instruction cycle 

(instruction time, or I‐Time) and the execution cycle (execution time or E‐Time). Let us 

examine these cycles in more detail. 
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Figure 20: Machine Cycle 

Phase A: Instruction Cycle 

1. Fetch Instruction: The control unit fetches (gets) the program instruction from 

memory. 

2. Decode Instruction: The control unit decodes the instruction (decides what it means) 

and then moves the necessary data from memory to the ALU. 

Phase B: Execution Cycle 

3. Execute Instruction: The ALU performs the requested action, by executing the 

arithmetic or logical instructions on the data. 

4. Store (write) Result: The ALU writes or stores the result of this operation in memory 

or in a temporary register. 

Once these two phases are complete, the control unit instructs memory to send the result to an 

output device or a secondary storage device. The figure below illustrates how these cycles 

interact to produce a result. 

We have already noted that the Control Unit is ideally the brain of the CPU, and must be very 

organized. For all instructions to be processed the Control unit must have the data ready and 

the cycles working like, well, like clock work! If the control unit is regarded as the brain, then 

the clock is regarded the heart of the computer. Every operation in the processor takes place 

like the ticking of a typical old‐fashioned mechanical clock. Each ‘tick’ may indicate the 
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beginning and each ‘tock’ the end of a basic interval of time in the processor during a clock 

period. During this beginning and end phase, data moves as directed from the CU. 

We have discussed instructions, data, and memory, as well as the machine cycle functions in 

two phases. Let us now briefly mention how the control unit is able to retrieve the correct data 

and instructions from memory. This is done by giving each instruction and each piece of data 

an address, just as persons have an address for their home. So, the addresses say the same, but 

just as people move to new addresses, different instructions and data are moved to new 

addresses or locations when the old data is no longer needed in memory. Just like a mailbox 

for an address can hold so many letters and packages, similarly each memory location can also 

only contain a fixed amount of data. Finally, as mailboxes may have a label or number affixed 

to it, so do memory addresses have representative address names such as Hours, Age, or Name. 

3.5 Summary 

The following concepts were covered in this unit: 

 A computer is a device that accepts data, uses a program to process the data, and 

generate results. 

 A computer system is a collective term that includes a computer and all peripheral 

devices attached to it, such as a monitor, keyboard and mouse. 

 An embedded system is a special‐purpose computer system designed to perform a 

dedicated function. 

 The main components of a computer system include the Central Processing Unit (CPU), 

primary memory, input and output devices, and secondary storage. 

 The Central Processing Unit (CPU) comprises the Arithmetic and Logic Unit (ALU) 

and the Control Unit (CU). 

 The ALU is the part of the CPU which performs all arithmetic and logic operations this 

involves arithmetic calculations including addition, subtraction and multiplication, as 

well as comparison of numbers and text. 

 The control unit is responsible for directing other parts of the computer system in order 

to carry out program instructions. 

 Both primary memory and secondary storage are also necessary to store instructions 

and data for processing, but they are not part of the CPU. 

 Each new computer generation improves on its previous generation, by reduction in 

size (or miniaturization) of computer circuitry. 
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 First Computer Generation is characterized by the huge vacuum tubes whose main 

purpose was to strengthen weak signals for transmission, and used switches to start and 

stop the instant flow of electricity. 

 Second Computer Generation replaced vacuum tubes by a much smaller transistor. 

 Third Computer Generation produced and compacted millions of transistors on to an 

integrated circuit. 

 Fourth Computer Generation is instrumental in the invention of the microcomputer, 

also known as a personal computer. 

 Fifth Computer Generation is developing communication between a computer in 

natural spoken language and its user. 

 Sixth Generation refers to the generation of computer and video games. 

 Primary storage is used to temporarily hold data and instructions. 

 Primary memory is known by other terms which are used interchangeably – memory, 

main memory, primary storage, main storage, internal storage, and RAM (Random 

Access Memory). 

 In order to carry out an instruction, the program instructions and data must be moved 

into memory from either an input device or a secondary storage device. 

 The control unit and ALU in the CPU work together to perform the following four steps 

(fetch, decode, execute, and store) for each instruction 

 

In this unit, the evolution of computer systems through a number different generations were 

considered. Although it may have appeared to many as simply a historical perspective, it is 

important to view this history as clues for the underlying trend that brought computer systems 

to what they are today. This trend illustrates the reduction in size at each stage which also 

coincided with increased speed of the system designed to handle the many tasks required of it 

in this latest generation. 

 

We also explored the distinction between a computer and a computer system along with 

introducing the concept of special–purpose computer systems. We also explored the 

components of a general computer system and their inter‐connections and reliance on each 

other. Finally, a description of how a computer processes data was explained. 

 



CVDMM(N) 202- Office Automation and Internet Skills  UOU 

Unit- 3: Introduction to Information Technology- III Page 43 of 207 

Reference 

Powley, R. (2011). Introduction to Computers. Retrieved Sep. 21, 2017, from 

http://doer.col.org/bitstream/123456789/8192/1/2011_VUSSC_Intro-Computers.pdf avaialble 

under CC‐BY‐SA license. 

 

License 

 
This work is licensed under a Creative Commons Attribution-ShareAlike 4.0 International 

License 



CVDMM(N) 202- Office Automation and Internet Skills  UOU 

Unit- 4: Operating System and Software Page 44 of 207 

Unit- 4 

Operating System and Other Software 

 

4.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Explain the purpose of system software. 

 Distinguish among the three major categories of system software. 

 Explain the interaction between the user and the computer and the role of system 

software to support this interaction. 

 Explain the different types of useful application software. 

 Explain the word processing document life cycle. 

 Explain the purpose of spreadsheets in business. 

 Describe a statistical application that is used to analyze data. 

 

4.1 Operating Systems, Utility Programs and Language 

Translators 

There are three different types of software that are part of all computer systems and that ensure 

that the hardware and application programs can effectively communicate with each other. This 

software is classified as operating systems, utility programs and language translators. 

4.1.1 Operating System 

A computer cannot work without an operating system! The operating system comprises a set 

of coded programs that work with the peripheral devices and computer hardware to control and 

organize the general operating functions of the computer. Some of these functions include: 

 Starting the computer (also called ‘booting’), 

 Managing and monitoring other programs, memory management, communications 

management and the management of peripheral devices, 

 Enabling interaction between the user and the computer system through the use of 

external input devices, and 
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 monitoring and security of access to data and applications. 

4.1.1.1 Starting the Computer 

Starting the computer, also called booting, is the process of loading the operating system into 

the computer’s memory so it can execute the different operations and mange the hardware 

devices. When the power button on the computer is turned on to load the operating system, 

this process is called a cold boot.  

If the computer system is already on and the system needs re‐started for a number of reasons 

(like the hardware stops operating or the user gets an error message), then the process of 

reloading the operating system is called a warm boot (because the computer was already on). 

A warm boot in a Windows based PC is normally done by holding down the CTL‐ALT‐DEL 

keys at once. 

4.1.1.2 Managing Other Programs 

The computer system needs to manage the programs that the computer user needs to complete 

business or personal tasks such as a word processing, Internet research, spreadsheet production 

and others. The operating system must therefore be able to manage one or more software 

application programs at the same time. This is known as multi‐tasking and the computer is 

considered a multi‐tasking operating environment. For example, multitasking operating 

systems run more than one application program at a time. Suppose a user has a word processing 

program, Internet browser and a spreadsheet are open at the same time and the computer user 

currently typing a report, using the word processing program. The word processing program 

is called the active program, since it is the current program in use while the other programs – 

the Internet browser and spreadsheet – are called inactive programs since they are running in 

the background and are not currently in use. 

Since computers use primary memory to increase processing efficiency, the operating system 

allocates memory spaces for each running program so that the individual programs do not 

interfere with each other. In order to accomplish this, the operating system uses ‘virtual 

memory’ or secondary storage, as an extension of random-access memory (RAM). 

This is illustrated in the figure 3.1. Sometimes, if there are too many applications opened, then 

the operating system is unable to allocated adequate memory to each application. When this 

happens, none of the applications may appear to work and the computer system may need a 

warm boot. 
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Figure 21: Memory CPU Interaction 

4.2 Types of Operating Systems  

Now that the purpose of an operating system has been explained, let us examine some operating 

systems that were developed for specific purposes. The Macintosh (or Mac) and the IBM 

personal computer operate with hardware and software configurations. This is known as the 

platform. The platform of a computer system is the underlying hardware and software that it 

allows it to function. For example, the Apple computer was developed with a Mac platform 

using Motorola chips and unique operating software called “Mac OS” The original IBM 

computer uses Intel chips and originally employed an operating system called “DOS” or Disk 

Operating System. Today’s PCs now use a Windows based operating system that incorporates 

many of the original concepts in DOS. Operating systems differ in functionality, flexibility and 

ease of use. Today there are a number of different operating systems in use. They can be 

classified as either personal operating system, network (client/servers) operating systems and 

handheld operating systems. A representative list of different operating systems is described 

below. 

Operating 
System 

(OS) 
 

Type Main Purpose or Major Development 

Unix Network 

These are network operating systems that are powerful. 
Runs on many types of PCs, mainframes and 

workstations; is the primary operating system for Internet 
servers; first multitasking system, widely used by large 

corporations 
Linux Network Uses a command line interface; more stable than 
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Windows, but applications using Linux are rare. 
Macintosh 

(MAC) OS X 
Personal 

Graphical user interface. Also considered the easiest 
system for beginners 

Microsoft 
Windows 95, 

98 
and XP 

Both 
personal & 

network 

Capable of Internet browsing, and multimedia support. 
None of these earlier versions of Windows are supported 

by Microsoft. 

Microsoft 
Windows 
NT/2000 

Network 

Also network operating systems that were designed 
specifically for corporate and other large businesses, and 
were also known as client/server systems (one computer 
‘serves’ provides applications for many users ‘clients’). 

Offered enhanced security, and remote access to computer 
systems among other features 

Microsoft 
Windows 
Mobile 7 

Handheld 
and Cell 
Phone 

Supports handheld devices and smartphones. Supports 
integration with other Microsoft software. 

Microsoft 
Windows 7 

All Types 
The current Microsoft operating system with a number of 

variants which can be used in all types of computer 
environments. 

 

4.3 Functions of an Operating System 

Birbal and Taylor, (2004: 39‐40) summarise the functions of an operating system as follows: 

4.3.1 Managing computer resources 

The operating system allows application software programmes such as word processing, 
spreadsheet and database packages to communicate with the computer’s hardware. For 
example, if you work on a document in Excel and you want to print the document, you just 
press the print button on the toolbar. Excel will direct the operating system to select a printer 

to print the document. The operating system then notifies the computer to begin sending data 

and instructions to the appropriate program to get the document printed. The operating system 

therefore acts as an interface between the application programmes and the hardware. 

4.3.2 Managing files and memory 

The operating system manages all files on a computer. It keeps tracks of the locations where 

programmes and data are stored within the computer’s memory. For example, when you open 

a file that has been saved to the hard drive, you are first instructing the computer to find the 

file, and then to open it. The operating system also allows you to easily find files stored in 

secondary storages devices. Other file management functions include copying, erasing, 

renaming and backing‐up files. 
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4.3.3 Maintaining security 

In networks and larger computers each user is given a user name or ID and password to gain 

access to the computer system. The operating system keeps a register of all these names so 

that only persons with valid usernames and passwords can access the system. This prevents 

access by hackers and unauthorized persons. The operating system also keeps a log which 

records users logged in, the length of time each user stayed on the system, and heat they did. 

Administrators can check the log to look for security breaches and abuse of resources. 

4.3.4 Managing tasks 

A computer can perform many tasks simultaneously. One way of doing this is multi‐tasking – 

ability of the computer to run more than one programme at the same time. For example, a user 

can listen to music on his/her computer whilst at the same time typing a document or typing 

an e‐mail while another e‐mail is being sent. In the case of networks, the multiuser operating 

system allows more than one user to access the same data at the same time. 

4.3.5 Providing a user interface 

Many operating systems functions are never apparent on the computer’s display screen. What 

you do see is what is called the user interface. The interface helps the user to interact with the 

computer. 

4.4 User Interface 

In order to interact with the computer, a user uses a part of the operating system called a user 

interface. The functions of the user interface are to start application programs, manage 

secondary storage, such as hard disks, as well as manipulate files and folders, and finally shut 

down the computer safely. 

The three principal types of interfaces include: 

 Graphical User Interface (GUI), 

 menu‐driven interface, and 

 command‐line interface. 

The Graphical User Interface (GUI) uses graphics or icons which represent various tasks. For 

example, the icon to print is a small picture of a printer  which when clicked with a mouse, 

will invoke the printing dialog box. Once the printer dialogue box is opened you can pick other 

commands that will be used to send your document to the printer. A GUI is a user‐friendly 

interface that eliminates the need to remember complex computer commands or programming 

languages. 
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Figure 22: Graphical User Interface 

The menu‐driven interface is used to show all of the options available to the user in the form 

of pull‐down or pop‐up menus. An illustration of a pull‐down menu is shown in figure 4.2. 

Many menu interfaces now include the GUI icons with text menu options. 

 

Figure 23: Menu‐driven interface 

The command‐line interface requires the user to type keywords or commands at a prompt, in 

order to enter data or execute commands. You can experience this type of command when you 

open the “Run” interface to input DOS based commands to execute an operating system task. 

This interface is the most difficult one for the average computer users to learn. They are often 

used in programming applications or in support of systems software. 
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Figure 24: Command line interface 

4.5 Utility Programs 

Utility programs are tools that help the operating system manage the computer system’s 
secondary or non‐priority jobs. These jobs are repetitive in nature. Some examples of utility 

programs include antivirus software, backup software, disk defragmentation, disk scanning; 

file compression software, file management programs, and searching software. Often are 

automatically loaded into member when the system is booted and they operate in the 

background at the same time as the application program. Often you do not know they are 

working until they send you a message like “Virus detected, click here to eliminate”. Only 

then does the user need to engage some form of interface to take the appropriate action. 
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4.6 Language Translators 

Language translators convert the data in a program (source code) into machine language code 

(object code) so that the computer can then process. The main purpose of translating source 

code to object code is to create a program in machine language so that the computer can 

produce the desired results. An example of different types of language translators are compilers 

and interpreters. The compiler is a computer program or in some cases a set of programs that 

translates another program’s source code into object code all at once, while the interpreter is a 

set of programs that translate the application program’s source code, one line at a time while 

the program is running. 

4.7 Application Software 

Application programs assist the user in completing workplace tasks, personal tasks or research 

when using the computer. They are the programs that a regular user sees and manipulates. This 

includes word processing, spreadsheet, graphic presentations software and others. This Topic 

discusses some categories of application software, including their strengths that enhance a 

user’s productivity. 

4.7.1 Personal Productivity Applications 

Personal productivity applications serve the needs of various users and have several 

subcategories. Generally, personal productivity software includes word processing, 
spreadsheet, presentation, and database programs. Another area, Internet applications, includes 

Web browsers and electronic mail programs. Multi‐media or graphics applications use desktop 

publishing, as well as editing of photos and graphics, while home and educational applications 

include personal finance programs, tax preparation programs, reference software and game 

playing software. These personal productivity programs are usually stand‐alone programs 

which do not depend on other application software to function. 

However, there are some applications whose interfaces are the same, and also share data and 

resources with each other. These applications together are called software suites, and some 

examples are Microsoft Office‐ which is the most popular, Corel WordPerfect Office, and 

Lotus SmartSuite. 
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Figure 25: Some useful application software 

 

Types Description 
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Financial Software Provides automated assistance for tax preparation and submission. 
An example is Turbo Tax. 

Accounting Software Provides assistance for personal accounting and cheque writing. 
Examples are Quicken and QuickBooks. 

Word Processing 
Software 

Provides assistance in formatting, printing documents. Some 
examples are Microsoft Word, and Corel WordPerfect. 

Spreadsheet 
Software 

Provides built‐in functions to perform calculations and graphics. 
Some examples are Microsoft Excel and Lotus 

Database Software Stores, manipulates and retrieves data. Some examples are 
Microsoft Access, dBase and FoxPro. 

 

4.7.2 Word Processing Features 

All word processing software is designed based on the document life cycle. The word 
processing document life cycle, includes creating a document, editing or modifying the 
document, formatting the document, saving and finally printing to provide a hard copy. Editing 

the document allows sections of text to be deleted, moved, or re‐typed, and text can also be 

searched and replaced. Formatting the document enhances its appearance, using various 

features include using different font types and sizes, line spacing, colours and borders. 

Mail merge is one of the powerful features of word processing software. This feature makes it 

easy to create personalized letters and reports, as well as print addresses on envelopes and 

mailing labels. With a bit of creative thinking, mail merge can be used to simplify many routine 

tasks such as personalizing invitations, preparing flyers, making certificates, labeling file 

folders, and preparing name tags. 

4.7.3 Workgroup Applications 

These applications are used by two or more users who work as a team to achieve a common 

task. The programs therefore should support the sharing of information and sections of the 

work or a project, scheduling group meetings, group electronic mail services, group decision 

making and conferencing. Some examples of this software are project management software, 

groupware like Microsoft Sharepoint and collaborative software like WIKIs (an example of a 

WIKI is Wikipedia). 

4.7.4 Enterprise Applications 

These applications are used by personnel to support the company in its interaction with 
customers and employees. Some of the activities include entry of orders, billing, payroll, 
human resource management, and general reporting activities. Enterprise applications are 
specialized or tailor made to the specific activities of the company. Examples of enterprise 
software include PeopleSoft a complete package of company operations and Banner an 

enterprise system used by universities and colleges to support records management, financial 

management, course management, student management, etc. 
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4.7.5 Application Software Development 

Some applications, are developed ‘in‐house’ specifically for use in the company. Other 
applications are developed via a contract by technology companies that specialize in producing 

custom application software for their customers. One example of custom software 

development would the book ordering process for Amazon.com. Finally, there are off the shelf 

application software packages which, as the name implies, can be purchased and used without 

the ability to customize the software. 

4.7.6 Spreadsheet Features 

Electronic spreadsheets organize data in a grid of rows and columns. Spreadsheet programs 

are considered a simple database that can be used to manipulate data in the form of numbers, 

percentages, etc. 

The benefits include the elimination of much of the tedious tasks of performing the calculations 

manually, so that the calculations are generally error‐free. Data is automatically recalculated 

when one value or calculation is changed. What‐if analysis allows users to change one value 

and have the results instantly recalculated. This is very useful in financial forecasting. 

The intersection of a row and column is called a cell. A cell is known by its address which 
consists of a column letter, followed by row number, for example B7. Cells contain: 

 A label, which provides text information or headings of the entries in the spreadsheet, 

 A value, which is an actual number that is entered into a cell 

 A displayed value which is what is displayed in the cell. This displayed value can 

represent: 

 A formula – an instruction to the program to calculate a number, such as 10% of a value, 

or 

 A function – a pre‐programmed formula, such as sum to add some numbers 

Spreadsheets produce graphs based on the data given in a visual, easily understood format. 

Analytical graphs are designed to help users analyze and understand specific data using simple 

line, bar, and pie chart graphs. 

4.7.7 Presentation Software Features 

The use of pictures, photos and other graphics in a lecture can help the audience remember and 

understand what is being presented. This is why electronic presentations have become popular 

in the oral delivery of many topics. Presentation software is also effective for training purposes 

since video clips can also be included to illustrate certain topics. 

Presentation software programs such as Microsoft PowerPoint presents information, usually 

in point form on many pages called a ‘slides’. Presentations can be projected and enlarged 

using a projector. Indeed, the presentation can be published on the Internet as well as printed 
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as outlines or scaled slides on paper. The usefulness of presentation software includes the easy 

updating or re‐arrangement of the slide content, the inclusion of multi‐media to enhance the 

audience’s understanding of the content, the content can be viewed be a larger audience since 

the presentation can be magnified as necessary, and the presenter can use links within the 

presentation to link to other documents, files and web resources. 

4.8 Proprietary Versus Open-Source Software 

Proprietary software is computer software licensed under exclusive legal right of the copyright 

holder. The licensee is given the right to use the software under certain conditions, but 

restricted from other uses, such as modification, further distribution, or reverse engineering. 

The distributors of this type of software limit the number of computers on which software can 

be used, and prohibit the user from installing the software on additional computers. Restricted 

use is sometimes enforced through a technical measure, such as product activation, a product 

key or serial number, a hardware key, or copy protection. 

Public domain software is not subject to copyright and can be used for any purpose. This 
includes free software, licensed by the owner under more permissive terms and open source 

software. 
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Figure 26: Commercial Software 

 

Figure 27: Open source software 

4.9 Summary 

The major systems software concepts discussed in this unit were: 

 System software monitors the activities of the computer so that it functions efficiently. 

 The operating system comprises a set of programs that work with the peripheral devices 

and computer hardware to control and organize the general operating functions of the 

computer. 

 Operating systems differ in functionality, flexibility and ease of use. 

 A platform of a computer system is the underlying hardware and software that it allows 

it to function. 

 The functions of the user interface are to start application programs, manage secondary 

storage, such as hard disks, as well as manipulate files and folders, and finally shut 

down the computer safely. 

 The Graphical User Interface (GUI) uses graphics or icons which represent various 

tasks. 
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 The command‐line interface requires the user to type keywords or commands at a 

prompt, in order to enter data or execute commands. 

 Utility programs are tools that help the operating system manage the computer system’s 

secondary or non‐priority jobs. 

 Language translators are these systems programs convert the data in a program (source 

code) into machine language code (object code) that the computer can then process. 

 Windows Explorer is a tool for organizing files on disk and uses several important 

components to manage drives such as disks (floppy disks, CDs, DVDs, and memory 

sticks), folders and files. 

 Files are a collection of information, data, or program files. 

 Folders are used to organize where the files are located, so that a particular folder may 

contain all spreadsheet files, while another folder can contain all word processing files. 

 A disk is a secondary storage device such as a floppy disk, CD, DVD, or memory stick, 

where folders and files can be stored. 

 The root folder is the main or general folder found on all disks. 

 Folders created within the root folder, are called subfolders. 

 Deleting folders also removes files and any subfolders in that folder. 

The application software concepts discussed in this unit were: 

 Application software is what users require to complete their tasks, while system 

software is the software that interfaces between the hardware to perform what is 

required by the application software. 

 Personal productivity software programs are usually stand‐alone programs which do 

not depend on other application software to function. 

 The word processing document life cycle, includes creating a document, editing or 

modifying the document, formatting the document, saving and finally printing to 

provide a hard copy. 

 Mail merge is one of the powerful features of word processing software which makes 

it easy to create personalized letters and reports. 

 Workgroup applications are used by two or more users who work as a team to achieve 

a common task. 

 Enterprise applications used by personnel to support the company in its interaction with 

customers and employees, such as entry of orders, billing, or payroll. 

 Electronic spreadsheets organize eliminate much of the tedious tasks of performing 

numerical calculations manually. 

 Spreadsheets produce graphs based on the data given in a visual, easily understood 

format. 
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 The usefulness of presentation software includes the easy updating or rearrangement of 

the slide content, and the inclusion of multi‐media to enhance the audience’s 

understanding of the content. 

 SPSS (Statistical Package for the Social Sciences) is a software application that 

manages data in a systematic way in order to perform statistical analysis on a set of 

data. 

System software plays an important role in the proper functioning of a computer system. This 

unit explained the three main programs that comprise system software, namely operating 

systems, utility programs and language translators. Of course, different types of system 

software are necessary for the different types of operating systems available. The user interface 

was also discussed as a mediator between the user and the computer system, to ensure that the 

computer system performs certain complex or other mundane tasks for the user. 

This unit also introduced personal productivity software or applications software which are 

stand‐alone programs that do not depend on other applications to function. Some popular 

application software programs discussed were for word processing, spreadsheet analysis, 

presentations, and statistical analysis. Some other applications such as workgroup and 

enterprise applications were also introduced, since they are also widely used in the day‐today 

tasks in many businesses. 
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Unit- 5 

File System 

 

5.0 Learning Objectives 

After studying this topic, you will be able to: 

1. Describe a computer the operation of a computer file management system. 

2. Show diagrammatically basic file and data management structures. 

3. Carry out basic file and data management operations. 

4. Explain different disk and file management operations. 

5.1 Disk and File Management Operations 

In Microsoft Windows operating system, Windows Explorer is a tool for organizing files on 

disk and uses several important components to manage drives such as disks (floppy disks, CDs, 

DVDs, and memory sticks), folders and files. When Explorer is started, you will see the 

directory window, which displays the contents of a specified folder on a selected drive. Files, 

folders and disks must interact to organize information in a meaningful way. 

Files are a collection of information, data, or program files. For example, an application 

software program such as a spreadsheet or word processor is a program file, while the document 

created using the spreadsheet or word processor is called a data file. Folders are used to 

organize where the files are located, so that a particular folder may contain all spreadsheet files, 

while another folder can contain all word processing files. 

A disk is a secondary storage device such as a floppy disk, CD, DVD, or memory stick, where 

folders and files can be stored. Consider a disk to be like a filing cabinet with the folders similar 

to physical folders or drawers in the filing cabinet. These folders can therefore contain files or 

rather paper files! So you can have many folders in a file, and the folders can contain many 

files! Also, just as your filing cabinet can become full of files, your disk (storage device) can 

also become full. 

5.2 Root Folder and Subfolders 

Two terms need to be explained before beginning the practical Topic. A root folder is the main 

or general folder found on all disks and is identified with the disk drive letter followed by a 

backslash (\ ). A root folder is often known as a drive or storage device. Table 4.2 illustrates 

some other designated disk drive letters. So, the root directory of the floppy drive is designated 

A:\ 
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Figure 28: Designated Drive Letters 

Once you create folders within the root folder, then these folders are called subfolders. So if 

the root folder contains another folder called WORD, then the folder is identified by its name 

preceded by the name of the root. Therefore, we have in our example, A:\WORD which 

indicates that the subfolder WORD is in the root folder of the A: drive. Folders can have more 

folders within them. So, if ASSIGN1, is created within the WORD Subfolder, then 
A:\WORD\ASSIGN1 indicates that the ASSIGN1 subfolder is within the WORD subfolder 
contained in the root folder of the floppy disk. Another way to describe the hierarchical nature 

of the above example is below: 

− Root Folder (e.g. C:\) 

o Sub Folder (e.g. C:\WORD) 

 Sub‐Sub Folder (c:\WORD\ASSIGN1) 

Activity 1: Using the Directory Window 

Launch Windows Explorer by right‐clicking the Start button and selecting Explore. Then 

maximize the resulting window. 
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Double‐click on the icon located in the left panel. (you may not see the numbers before the C:. 

A list of folders will be displayed in the right panel. Double click the WINNT or WINDOWS 

folder depending on the system you are using. (You may get a message telling you that these 

files are hidden for security reasons. Simply click the on the Show Files option.) You can also 

double‐click on any folder for this activity; the Explorer title will be updated to reflect the name 

of the folder that you have opened. Double‐click the Desktop folder in the left panel, or in the 

file list (in the right panel), and notice the files change to reflect those in the desktop folder. 

You should now select and click the View pull‐down menu, and notice how the Explorer panels 
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change with each option. Try the four options in the Arrange Icon option and Details option to 

see the result. 

5.3 Creating and Deleting Folders 

You can also create and delete folders in Explorer. To create a new folder, you first need to 

know WHERE your folder will be located, such as the desired drive, and then the directory 

from the tree (left panel). Select the disk and folder that you want to create this new subfolder 

within, and select File New Folder from the menu bar. You need to be careful when deleting 

or removing folders, since you may remove a folder with important files still within it. Deleting 

folders also removes files and any subfolders in that folder. Click to select the folder, and then 

select File Delete from the menu bar. 

Activity 2 ‐ Creating and deleting folders 

Launch Explorer and put your floppy disk in the floppy drive. Click on the Floppy Drive icon. 

Select File New Folder. Alternatively, you can right click in the right pane and select the New 

Folder Option 
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Type DISTANCE and press [ENTER]. The new folder has been added under the A:\ root 

directory. Double‐click the folder DISTANCE and select File New Folder (or once again right 

click and select New Folder). Type ACTIVITY. Your directory tree for the floppy disk is 

shown: 

 

If you have other folders, then they will also be shown. 

Click on the DISTANCE folder. To delete this folder (and all its contents), select File Delete 

from the menu, or press DELETE. Click OK when the Confirm Delete dialog box appears. 

5.4 Disk and File Management Software 

Windows Explorer allows the management of files such a wide range of file activities including 

copying, moving, deleting and renaming. 

1. Copying Operation ‐ In order to copy one or more files from one folder to another, 

these file(s) should be first selected from the directory list. Multiple files can be selected 

from the folder by clicking on the first file (remember, do NOT double click as this will 

open the document and not select it), then hold down the CONTROL key while clicking 

on each individual file. If the files are located together, then first hold down the SHIFT 

key and then click on the first and then the last file. All files between the first and last 

will be selected. A file can be de‐selected by clicking on the file a second time. After 

selecting the file(s) use the Edit Copy command, or hold down the CTRL key and tap 

the letter C on the keyboard. Click in the destination folder on the desired drive, and 

select Edit Paste. Your files should be copied to the desired folder. 

2. Moving Operation ‐ To move one or more files, first select the required files, as in the 

copying operation above. With the files selected or highlighted, click and hold on the 

selected files. Then drag the mouse pointer onto the destination folder name in the tree 

and release the mouse button. You should check to see that the files were actually 

moved to the desired location. Alternatively, files can be moved by first selecting the 

files and using Edit Cut, to remove the files from the first location. Then click in the 

destination folder on the desired drive, and select Edit Paste to move the files to this 

folder. 

3. Renaming Operation ‐ Renaming files is accomplished by selecting the desired file 

and then choosing File Rename from the menu. Simply type in the new filename and 

press Enter. 
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Activity 3 ‐ Disk and File Management Operations 

First create the following tree structure on your floppy disk, or memory stick (removable disk) 

 

Use Start, Programs, Accessories, and Paint to create the four bitmap files and save those files 

with a Monochrome Bitmap file format. Use WordPad or Notepad to create and save the four 

text files shown. You do not need to type anything in the file. Save these files in the root folder 

of your disk. Also make sure your files are arranged by type in Explorer. 

 

Copy all bitmap files from the root (Distance) to the Graphics folder. To do this: 

Click on the first file Assign1 Graphic, hold the SHIFT key down and click or select the 

Assign4 Graphic to select all of the graphic files. 

Select Edit Copy from the menu, or hold down the CTRL key and tap the C key. Click on the 

Graphics folder in the directory structure (left panel). Select Edit Paste, or CTRL V to copy the 

files. A dialog box will show you the files as they are copied. 

Move the text files to the folder Assignments. Click on the first file Assign1, hold the SHIFT 

key down and click or select the Assign5 text file to select all of the text files. 
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Select Edit Cut from the menu, or hold down the CTRL key and tap the C key. Click on the 

Assignments folder in the directory structure (left panel). Select Edit Paste, or CTRL V to copy 

the files. A dialog box will show you the files as they are copied. 

Delete the remaining files from the root. Select all files in the root and tap the DELETE (DEL) 

key. Select YES when the Confirm Multiple File Delete dialog box appears. 

Rename files. Click on the System Software folder in the Tree. Select File Rename from the 

menu, and type in the new file name: Operating Systems. Press ENTER. 

Click on the Application Software folder and press DELETE. What happens? Since you do not 

actually want to delete this folder, what should you do? 

5.4 Summary 

The following concepts were explored in this unit: 

1. Windows Explorer is a tool for organizing files on disk. 

2. Files are a collection of information, data, or program files. 

3. Folders are used to organize where the files are located. 

4. A disk is a secondary storage device such as a floppy disk, CD, DVD, or memory stick, 

where folders and files can be stored. 

5. The root folder is the main or general folder found on all disks. 

6. Once you create folders within the root folder, then these folders are called subfolders. 

7. To create a new folder, you first need to know WHERE your folder will be located. 

8. You need to be careful when deleting or removing folders, since you may remove a 

folder with important files still within it. 

This unit explained the difference among terms such as disks, files, folders and sub folders and 

root folder. It also noted the various disk drive letter designations when performing data and 

file management tasks. 

Reference 

Powley, R. (2011). Introduction to Computers. Retrieved Sep. 21, 2017, from 

http://doer.col.org/bitstream/123456789/8192/1/2011_VUSSC_Intro-Computers.pdf avaialble 

under CC‐BY‐SA license. 

 

License 

 
This work is licensed under a Creative Commons Attribution-ShareAlike 4.0 International 

License 



CVDMM(N) 202- Office Automation and Internet Skills  UOU 

Unit- 6: Starting up MS Word Page 66 of 207 

Unit- 6 

Starting up MS Word 

 

6.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Create and edit document 
 Review document 
 Remove text 
 Save and Retrieve Documents 
 Print a Document 

6.1 Create a Document 
Steps to create a new word processing document (Word, Office 365): 

1. Start Microsoft Word. 

2. Click the File tab. 

3. Click the New tab. 

4. Click Blank document. (A new blank document appears.) 

5. Type your text. The text you type will be inserted into the document. 

6.2 Edit a Document 

Making revisions to a document, focusing on correcting errors, improving the accuracy of 

language, rearranging, making words and sentences clearer and more effective, etc. 

Editing in word processing may include the following tasks: 

 Adding text (terms, phrases, paragraphs, etc.) 
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 Deleting a part of a text 

 Copying text 

 Moving text 

 Pasting text 

 Checking for grammar and spelling 

 Formatting text 

Select Text 

Before editing text, you’ll need to select it. This is also sometimes called “highlighting text.” 

1. Click File Explorer icon.  

2. Go to the location where stores your file or folder (hard drive, USB, etc.). 

3. Open the document you wish to edit. 

4. Move the I-beam pointer to where you wish to select text.  

1. To select a word: double-click the word. 

2. To select an entire line of text: move the I-beam to the left of the line until it 

turns into a right-pointing arrow , then click. 

3. To select a paragraph: triple-click the paragraph. 

4. To select any amount of text: click and drag the I-beam over the text to 

highlight it. 

5. To select an entire document: move the I-beam to the left of any text until it 

turns into a right-pointing arrow , then triple-click. Or click the Home 

tab, under Editing, click Select, and then click Select All. 

Delete (or remove) text 

Method 1 

1. Select the text you wish to delete. 

2. Press the Delete key (on the keyboard). 
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Method 2 

 

1. Move the I-beam pointer to the text you want to delete. Click to set the insertion point 

there (a blinking vertical line). 

2. To delete text to the left of the insertion point, press the Backspace key on the 

keyboard. (On a Mac keyboard, press the Delete key.) 

3. To delete text to the right of the insertion point, press the Delete key on the keyboard. 

(On a Mac keyboard, press the fn key plus the Delete key.) 

6.3 Review a Document 
Check Spelling and Grammar 

Method 1 

1. Open the document you wish to edit. 

2. Right-click a word that is underlined with a wavy line (that indicates a misspelled 

word). 
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3. Select the correct spelling from the suggestion list to correct the spelling error. For 

each error, Word will offer one or more suggestions. 

Method 2 

1. Open the document you wish to edit. 

2. Click the Review tab. 

3. Click the Editor button (it may also say, “Spelling and Grammar”). If the program 

finds spelling errors, the Spelling & Grammar pane will appear. 

4. Click one of the options from the suggestion list to change the spelling error. The 

program will move to the next misspelled word. 

Find Synonyms 

Method 1 

1. Open the document you wish to edit. 

2. Right-click a word for which you wish to find a synonym for. 

3. Click the Synonyms command from the pop-out menu. 

4. Find a desired word in the list and click it to replace the original word. 

5. If none of the synonyms are desired, click the Thesaurus command to open the full 

thesaurus. (The Thesaurus pane will appear.) 

6. Find a desired word in the Thesaurus pane list and right-click it and then click Insert. 

7. Close the Thesaurus pane. 
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Method 2 

1. Open the document you wish to edit. 

2. Select a word for which you wish to use the thesaurus. 

3. Click the Review tab. 

4. Click the Thesaurus button. 

5. Find a desired word in the “Thesaurus” pane and right-click it and then click Insert. 

6. Close the Thesaurus pane. 

6.4 Save and Retrieve Documents 
Save a new document or save a file to a specific location (Windows 10) 

1. Click the File tab. 

2. Click the Save As command. 

3. Choose a location on your computer (the drive and folder) to save your file. 

4. Type a name for your document in the File Name box. 

5. Click the Save button. 
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Save an existing file in its current location 

1. Click the File tab. 

2. Click the Save command. 

3. Or click the Save button icon. 

Retrieve a file from a specific location 

 

1. Start Word. 

2. Click the File tab. 

3. Click Open command. 

4. Choose the location on the computer that stores your file (the drive and folder). 

5. Click the name of the file you wish to open. 

6. Click Open or double click the file name. 
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6.5 Print a Document 

A device that is usually connected to a computer in order to transfer the text and graphic 

information to paper. 

How to print a document in Microsoft Word: 

1. Load paper in the paper tray if needed. 

2. Press the Power button to turn the printer on. 

3. Choose the location on the computer that stores your file (the drive and folder). 

4. Open the file you wish to print. 

5. Click the File tab. 

6. Click the Print command. 

7. Select the print options. Here, you can select:  

o How many copies you would like 

o Which pages you want to be printed. You can choose to print all pages, select 

pages (for example, page 3 to 6), or just the current page (meaning the page 

that is open on the screen). 
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o If the printer should print on one side of the page or both sides. 

8. Click Print to start the printing process. 
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Unit- 7 

Comfortable Navigation: Moving around in MS Word 

 

7.0 Learning Objectives 

At the end of this unit, you should be able to: 

1. Use cursor and mouse for navigation. 

2. Set the zoom factor in the page. 

3. Select words from a word document 

4. Selection using keyboard. 

7.1 Comfortable navigation: moving around in Word 

7.1.1 Moving with the mouse 

How do you move around the text most easily? Use your mouse! 

Have you already typed a few lines of text? Then move the mouse over your virtual page and 

observe the shape of the mouse pointer. 

 When the mouse pointer is completely outside the document, it looks like a hollow 

arrow facing to the left. 

 When the mouse pointer is in the document margin area, it looks like a hollow arrow 

facing to the right. 

 When you move the mouse pointer over text, it looks like a capital “I” – this is called 

the insertion point. 

To enter or edit text, you need to position the insertion point at the place in the text where you 

want to type, and then click the left mouse button. The text cursor (a thin vertical line) will 

blink to show that it is ready for you to start typing at this point. 

If you want to add text below the end of your document, you can either press [ENTER] after 

the last paragraph to move the text cursor lower down the page; or else you can position the 

insertion point where you would like to type, and do a double click. Word will automatically 

fill in any blank lines for you! 

7.1.2 Using the cursor keys 

The mouse isn’t always the fastest way to move through text. Sometimes it saves time to use 

the keyboard as a clever alternative! Have a look at the cursor keys (arrow keys), which are 
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found on the right of the normal keyboard. These provide you with flexible options for 

navigation. Note that if you hold down an arrow key, it will rapidly repeat its action. 

 

7.1.3 Moving word by word 

You’d like to move a bit faster through your text? In order to move one whole word at a time, 

hold down the [CTRL] key while you press either the left or right arrow key. 

7.1.4 Beginning and end of the line 

It can be difficult to get to the beginning or end of a line using the mouse. The keyboard offers 

you two keys intended specifically for this task! 

 

7.1.5 Beginning and end of the document 

You’d like to jump immediately to the beginning of your document? Nothing could be easier! 

Just hold down the [CTRL] key and press [HOME]. 

To jump to the end of the document, hold down [CTRL] and press [END]. 

7.1.6 Bigger steps 

If you’d like to move through the document using bigger steps, try using the following keys: 
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7.1.7 Jumping to a particular page 

You’ve already written a number of pages and now you’d like to return to a particular page? 

Here’s what to do: 

1. Press the function key [F5]. This key calls up the Find and Replace dialog box. You’ll 

find yourself automatically in the Go To tab. 

 

2. You don’t have to click anywhere; the cursor will be waiting for you in the Enter Page 

Number field. Just type the number of the page that you’d like to jump to. 

3. Click on the Go To button or press [ENTER], and you’ll find yourself transported to 

the page you wanted to see.  

There’s another way that you can jump to a particular page, which uses the mouse and the 

vertical scroll bar. 

1. Click the box on the vertical scroll bar and hold the left mouse button down. 

2. Now drag the scroll box in the desired direction. You’ll see the actual page location in 

an information box on the left of the scroll bar. 

 

3. When you’ve reached the page you want to see, release the mouse button! 

7.2 The view on the screen 

7.2.1 Setting the zoom factor 

Did you know that you can adjust the size of the text onscreen to suit your taste? Just use the 

zoom function! Here’s how you find out what the zoom factor is, and set it as you like it: 
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1. You’d like to find out what the zoom factor is? Just look on the Zoom button, which is 

located towards the right end of the status and information bar at the bottom of the 

Word window. 

 

2. The picture is too big or too small? Then drag the slider at the right of the Zoom button, 

or else click the button to open the Zoom dialog box. 

3. The dialog box lets you choose a preset zoom factor, or else you can type your own 

value in the Percent field. 

 

4. Click OK, and the screen will immediately appear as you want it. 

7.2.2 Viewing a document with Print Preview 

Word has a cool feature that you’ll definitely want to know about. I’m talking about print 

Preview. To call it up: 

1. Click the Office button, select Print and then Print Preview. The Print Preview icon 

shows a dog-eared page with a magnifying glass. 

 

2. Now you’re in Print Preview mode. You see the document exactly as it will look when 

printed. 

3. Once again, you can adjust the zoom factor to suit yourself. There is a Zoom button on 

the Print Preview ribbon, as well as the usual zoom controls on the status bar. Note that 

the Many Pages option in the Zoom dialogue box allows you to display several pages 

at once, depending on the resolution of your screen. 
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4. To close Print Preview, click the Close Print Preview button on the right of the ribbon. 

7.3 Selecting text 

Before you can do anything to your text, you need to select the parts you want to act on. 

Selected text passages are easy to manipulate. You can cut them out and paste them in 

elsewhere in your document. You’ll find out more about this on the next few pages. 

7.3.1 Selecting a word 

You want to select just one word? No problem! 

1. Position the mouse pointer directly over the word. 

2. Double-click the left mouse button. It’s that easy! 

If you want to de-select text that you’ve selected, just click anywhere outside the selected text. 

7.3.2 Selecting a group of words 

Selecting a group of words isn’t hard either. 

1. Position the mouse pointer before the first word in the passage to be selected. 

2. Click the left mouse button and hold it down. 

3. Now, while holding the left mouse button down, drag the mouse over the text. 

4. Release the mouse button only when you’ve selected all the text you want. 

7.3.3 Selecting longer sentences 

The text you’d like to select extends over multiple lines? For example, it begins on the upper 

right side of the screen but ends far below on the left? 

1. Start by positioning the mouse at the beginning of the first sentence. Hold the left mouse 

button down, and don’t release it until you’ve selected the entire area you want. 

2. Now drag the mouse directly downwards. This way you select an entire line at a time. 

Don’t let go of the mouse button! 

3. Have you selected too much text? Don’t let go of the mouse button yet! Just drag 

backwards to unselect, until you’ve reached the word that ends your selection. 

If you accidentally moved some of your text around while you were selecting it, then click the 

Undo   button on the Quick Access toolbar. Occasionally Word’s drag and drop feature can 

play tricks on you! 
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7.3.4 Selecting line by line 

You can even highlight entire lines of text at a swoop. 

1. Position the mouse in the margin to the left of the first line you’d like to select. The 

mouse pointer will look like a hollow arrow facing to the right. 

2. Click the left mouse button and don’t let go. The first line will be selected immediately. 

3. Now, holding the left mouse button down, drag the mouse down the side of the page. 

Let the mouse button go when you’ve highlighted as much text as you want to select. 

 

7.3.5 Selecting precisely what you want 

Is clicking and dragging the mouse too clumsy for you? Then here’s another approach: 

1. Click wherever you’d like the selection to begin. (Just click, don’t keep on holding 

the mouse button down.) 

2. Press the [SHIFT] key and hold it down. 

3. While still holding the [SHIFT] key down, click wherever you’d like the selection 

to end. Release the [SHIFT] key. All the text between these two points is selected! 

7.3.6 Selecting with the keyboard 

By the way, you don’t have to use the mouse to select text. You can also use the cursor (arrow) 

keys on the keyboard. 

Try holding down the [SHIFT] key and using the arrow keys to expand your selection.  

7.3.7 Selecting everything 

You’d like to select the whole document at once? That’s easy! At the right end of the Home 

ribbon, click the down arrow next to the word Select, and then click Select All. 

 

7.4 Deleting and adding text 

Now it’s finally time to reveal the secrets of deleting and adding text! 
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7.4.1 Deleting individual characters 

In Word there are two ways that you can delete your text, character by character, step by step. 

 You’ve already met the [BACKSPACE] key; use it to delete characters to the left of 

the cursor. 

  There’s also a key that deletes characters ahead of the cursor. It’s the [DEL] (delete) 

key. Go ahead and try it!  

 

 

7.4.2 Removing larger blocks of text 

You’d like to remove several sentences at once? And you’re going to do this by pressing the 

[BACKSPACE] key until you’ve erased everything? I’d like to know where you find so much 

time! Instead, I’d advise you to select the text that you want to remove, and then press the 

[DEL] key. It’s really that easy! 

7.4.3 Adding text 

One of the best things about word processing is that it’s so easy to add something to your text. 

1. Click the point where you’d like to add to your text. 

2. Type the new text. 

3. The line breaks will automatically adjust themselves to accommodate the addition to 

your text. 

If the line breaks don’t adjust themselves, then you may have pressed [ENTER] instead of 

using Word’s automatic line breaks. Display the non-printing characters and delete any 

unnecessary ¶’s. 

7.4.4 Overtype mode 

While you’re working, you may notice that your previous text is being deleted character by 

character as you type. This happens if you’ve accidentally turned on Overtype Mode. Press the 

[INSERT] key to turn this mode off and return to Insert mode. 

If Insert / Overtype mode isn’t visible on your status bar, then you can do a right click in the 

blank area of the status bar, and check the Overtype option. 
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7.5 Using the clipboard 

Cutting, copying, and pasting are some of the most practical features of a word processor. 

7.5.1 Cutting and pasting 

You’d like to move some text from one place to another in your document? It couldn’t be 

easier! Here’s how it’s done: 

1. Select the relevant text. 

2. Click the Cut button on the Home ribbon – its icon is a pair of scissors.  

3. Whoops! Where did the selected text go? It’s been moved to the Clipboard, which is an 

(invisible) storage area. 

4. Place the cursor at the point where you’d like to add the text. 

5. Now click the Paste button – its icon is a picture of a clipboard. 

 
6. If necessary, add an extra space at the end of the pasted text. 

7.5.2 Copying instead of cutting 

So how does copying work? It’s very similar! Select your text, and then click Copy (the icon 

shows two sheets of paper) instead of Cut.  

When you copy, the selected text remains in its original position in the document, and a copy 

of it is placed on the clipboard. You can paste the copied text anywhere else in your document 

(or in another document). 

 

7.5.3 Some keyboard shortcuts 

There are also some easy-to-remember key combinations to cut, copy and paste! Just hold down 

the first key [CTRL] while you type the second one. 

[CTRL] + [X] : Cut 

[CTRL] + [C] : Copy 

[CTRL] + [V] : Paste 
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Unit- 8 

Character formatting in MS Word 

 

8.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Perform character formatting 

 Change font size and color. 

 Paragraph formatting 

 Apply line spacing 

8.1 Character formatting 

Word provides an amazing range of tools to help you create professional-looking documents! 

Characteristics that affect the appearance of one or more characters are called character 

formats. 

8.1.1 Changing the font 

The style of typeface that you use is called the font, and there are literally hundreds to choose 

from! 

To change your font: 

1. First, select the relevant text. This can be anything from a single character to the entire 

document. 

2. Find the Font field on the Home ribbon. 

 

 

3. Click the drop-down arrow next to the Font field. 

4. You’ll see a list with countless font choices. Scroll through the list until you’ve found 

the font you want to use. As you move the mouse over a particular font, your document 

will show what that font would look like – this is called Live Preview. 
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5. Select the font you want by clicking its name. 

8.1.2 Changing the font size 

You can change the size of the font to suit your needs: 

1. Once again, first select the relevant text. 

2. Find the Point Size field on the Home ribbon, and click the drop-down arrow next to it. 

3. On the list, find the font size that suits you and click it. 

You can also specify your own font size. Just click in the Point Size field and type in the size 

that you’d like, then press [ENTER]. The size must be between 1 and 1638, and can include 

“half sizes” such as 12.5. 
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8.1.3 Changing the default font 

The default font is what Word uses every time you start a new document. By changing this, 

you can ensure that all new documents will use your choice of font and point size! 

1. Find the Font category label on the Home ribbon, and click the arrow on its right. 

 

2. The Font dialog box will appear. 

 

3. Select the font and size that you’d like to use as your default. Leave the style as Regular. 

4. When you’re happy with your selection, be courageous and click the Default button. 

 

5. Word will inform you that you’re about to change the default font, which will update 

the NORMAL template. Go ahead and click Yes. 

 

8.1.4 Bold, italic, and underline 

Would you like your text to be bold, italic or underlined? It’s very easy! As usual, you start by 

selecting the text that you want to format, since otherwise Word won’t know where the new 

formatting should be applied. 
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1. Select the relevant portion of your text. 

2. Click the appropriate character formatting button on the Home ribbon. 

 for Bold 

 for Italic 

 for Underline 

The arrow next to the underline button offers you a choice of underlining styles.  

3. To turn a character format off, click the same button again. 

 

8.1.5 Different colours 

Colours can really make life worth living! And Word gives you the ability to make your texts 

as colourful as you wish! The general rule applies here too: first select your text, then act: 

1. Find the Font Color button on the Home ribbon, and click the drop-down arrow. 

2. You’ll see a palette containing all the text colours available to you. 

 
3. Choose the text colour that you’d like by clicking on it. 

8.1.6 The complete selection 

But wait – there’s more! Would you like your text to appear in small caps? Do you have a thing 

for shadowed text? You can access the complete set of options through the font window. 

1. Select the required text. 

2. Click the arrow to the right of the Font category label on the Home ribbon - or even 

simpler, click the right mouse button and select Font. The Font window will be 

displayed. 

3. Use the drop-down arrows to select colour or underlining options. 

4. Check any effects that you want to apply, like Shadow or Small Caps. The Preview 

field let’s you see what your choices will look like. 
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5. Confirm your settings with OK when you’ve finished 

8.2 Paragraph formatting 

Paragraph formatting applies to a complete paragraph - that is, all the text between two 

occurrences of [ENTER]. And you don’t even need to select the text first, unless you want to 

format more than one paragraph. Just position your cursor anywhere inside the paragraph that 

you want to format. It’s as simple as that! 

8.2.1 Right, left, or in the middle? Please arrange! 

By default, paragraphs are usually left-aligned: the left margin is straight, but the right margin 

is jagged (like in this manual). Word provides you with a number of other options though. Just 

position your cursor anywhere in the paragraph, and click one of the text alignment buttons on 

the Home ribbon.     

 Align left: text is aligned at the left margin but jagged on the right. 

 Center: text is centred within each line, with jagged margins on both left and right. 

 Align right: Text is aligned at the right margin but jagged on the left. 

 Justify: text is aligned at both the left and right margins (Word does this by adjusting 

the amount of space between words). 

8.2.2 Using bullets 

Here’s how you can create a nifty bulleted list! 

1. First, type the points that you want to bullet, one under another. Make sure you create 

them as individual paragraphs by pressing [ENTER] after typing each point. 

2. Select the paragraphs that you’d like to bullet. 

3. Click the Bullets button in the Paragraph section of the Home ribbon.  

4. Look! The selected paragraphs have been formatted as bullet points. 

The drop-down arrow on the right of the Bullets button allows you to choose from different 

bullet styles. 

8.2.3 Creating a numbered list 

In much the same way, you can create a neatly numbered list. Instead of clicking the Bullets 

button, you should click the Numbering button just next to it.  

The best thing about Word numbering is that the numbers adjust themselves automatically 

when you edit the text! 
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8.2.4 Borders and shading 

You want to place a border around an entire paragraph? That’s no problem either! 

1. Place the cursor anywhere in the paragraph that you’d like to frame. 

2. Click the Outside Borders button in the Paragraph section of the Home ribbon. (Note: 

if the Outside Border button doesn’t show a “frame” icon, then click the drop-down 

arrow to select it.)  

 
 

For more complex borders and shading, select the Borders and Shading option at the bottom 

of the Outside Borders drop-down list. This will open the Borders and Shading dialogue box. 

Effects can be applied to the whole paragraph, or to selected words. 

 

 Using the Borders tab, you can select a border setting, style, colour and width. The 

Apply To field lets you specify whether this should be applied to the whole paragraph 

or to selected text. Click OK to see the effect. (And then Undo if you don’t like it!) 

 

 Using the Shading tab, you can select a background colour and/or pattern. The Apply 

To field lets you specify whether this should be applied to the whole paragraph or to 

selected text. Click OK to see the effect. 
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8.2.5 Working with indents 

If you are working with a long document, you might want to consider setting off certain 

sections of text by using indents. Indents allow you to set text within a paragraph at different 

margins. 

There are 4 different types of indents: 

 First Line: Use this option to move the first line of your paragraph to the right 

 Hanging: Use this option to control the left margin of every line in your paragraph 

except the first one 

  Left: Use this option to move the left margin of your paragraph to the right. 

 Right: Use this option to move the right margin of your paragraph to the left 

8.2.5.1 First Line Indent 

1. Click in front of the line that you want to indent. 

2. On the Page Layout tab, click Paragraph, and then Indents and Spacing 

3. In the Special list under Indentation, click First line, and then in the By box, set the 

amount of space that you want the first line to be indented. 
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8.2.5.2 Hanging Indent 

1. Select the paragraph in which you want to indent all but the first line of the paragraph. 

2. On the Page Layout tab, click Paragraph, and then Indents and Spacing 

3. In the Special list under Indentation, click Hanging, and then in the By box, set the 

amount of space that you want for the hanging indent. 

8.2.5.3 Setting left and right indents 

1. Select the paragraph that you want to change. 

2. On the Page Layout tab, click Paragraph, and then Indents and Spacing. 

3. Click the arrows next to Indent Left / Right to increase / decrease the left / right 

indentation of the paragraph. 

8.3 Working with line spacing 

Change the spacing before and after selected paragraphs 

By default, paragraphs are followed by a blank line, and headings have extra space above them. 

1. Select the paragraph before or after which you want to change the spacing. 

2. On the Page Layout tab, in Paragraph, click arrow next to Spacing Before or Spacing 

After and enter the amount of space required. 

 

Line spacing options 

 Single Default option - sets line spacing to one line 

 1.5 lines This option is one-and-one-half times that of single line spacing. 

 Double This option is twice that of single line spacing. 

 At least This option sets at minimum amount of space between lines 

 Exactly This option sets fixed line spacing, expressed in points. 

 Multiple Sets the line spacing to accommodate multiple lines 

Change the line spacing for paragraphs 

1. Select the paragraphs for which you want to change the line spacing. 

2. On the Home tab, in Paragraph, click Line Spacing 
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3. Click on Line Spacing Options, and select options you want under Spacing. 

 

8.4 Using tabs 

Use tabs to align text in your documents. It’s great for aligning columns of text! By default, 

Word has tab stops sert every 0.5” on the ruler. 

Tab stop types: 

There are five types of tab stops available which do the following: 

 Left-aligned Text flows to the right 

 Centered The text centers on this position as you type 

 Right-alighned Text flows to the left 

 Decimal-aligned Text aligns on the decimal point when using numbers 

 Bar Inserts a vertical line at tab stop 

Setting tabs using the ruler 

This is the easiest way to set tabs! 

If you can’t see the ruler, click View Ruler at the top of the vertical scroll bar. Click anywhere 

on the ruler, and you will have set a tab stop. 

Setting custom tabs 

1. On the Page Layout tab, click Paragraph. 

2. In Paragraph, click Tabs. 

 

8.5 Activity: Text entry and formatting 

Open MS Word, and type the following text. Save the completed letter on your D: drive with 

the name Word Task 2. 
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When you’ve finished typing and have saved the letter, then follow the instructions given on 

the next page to format the letter. Save your formatted document again with the same name. 

An example of what the finished document should look like, is given below the formatting 

instructions. Note that your margins may differ slightly from the example, depending on the 

setup of your default MS Word options. 

My Name: Type your name here 

Type today’s date here 

Hello Robert 

The Good and Bad of UCT 

I am writing this letter to practise my new MS Word skills. I have just completed a computer 

course. The tutors were very helpful, and taught me a lot. It’s very exciting to be able to use a 

computer! There are a lot of things to do here at UCT, both academically and socially. It’s 

going to be tricky to balance it all; but I am definitely looking forward to the year. 

So far I have visited the following attractions in Cape Town: 

Table Mountain 

Robben Island 

Cavendish Square 

Ratanga Junction 

They are all amazing – especially Ratanga Junction. 

The bad side has been the amount of work we have to do. Lectures are OK because you can 

skip those, but you can’t bunk tutorials. 

I have to run now, I have to go and research an essay. 

Regards 

Thabo 

Now follow the instructions on the next page to format your document. 
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Unit- 9 

Arranging Text with Tables 

 

9.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Arrange table with text. 

 Add clipart to documents. 

 Control text flow around graphics. 

9.1 Arranging text with tables 

If you need to include structured text in your document, then using a table is the easiest way to 

make sure that it will remain neatly formatted, even when you edit it. 

9.1.1 Creating a table 

1. It’s really easy to create a table. Here’s what you need to do: 

2. Click at the point in your document where you’d like to add a table. 

3. Click on the Insert ribbon tab. 

4. Click on the Table button just below the Insert tab. 

5. A blank table grid will appear. 

6. Position the mouse pointer in the top left square of the table grid. Click the left button, 

and hold it down while dragging the mouse down and to the right. This is how you 

specify the number of columns and rows you’d like in your table. 

7. Release the left mouse button, and the framework of your table is included in the 

document. 

After you create a table, the Design ribbon will be displayed giving you a choice of standard 

table styles. Or use the Borders and Shading buttons to design your own! 
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9.1.2 Adding text to your table 

You want to fill the table in? Nothing could be easier! 

1. After you’ve created the table, the cursor will be blinking in the first cell. You can begin 

typing here. 

2. To move on to the next cell, just press the [TAB] key. 

3. When you want to move to the next line, just press [TAB] again. Don’t press [ENTER] 

– that will create a new line inside the current cell. 

What if you’ve reached the end of the table and you need another row? Pressing the [TAB] key 

will automatically add it. 

9.1.3 Deleting rows and columns 

You’d like to delete a row? Or a column? Here’s how: 

1. Position the cursor in the row or column that you want to get rid of. 

2. Click on the Layout ribbon tab. 

3. Click on the Delete button, and a drop-down menu will appear. 

4. Select an option to delete cells, columns, rows, or even the entire table. 
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9.1.4 Adding rows and columns 

You need to have the Layout ribbon visible for this too. 

1. Position the cursor in the row (column) next to which you want add another row 

(column). 

2. Click on one of the Rows & Columns options (located on the right of the Delete button). 

The new row or column will be included in your table. 

 

9.2 Adding ClipArt to documents 

You can add pizzazz to your documents with ClipArt, the ready-made pictures that come with 

Word! 

9.2.1 Adding ClipArt graphics 

Here’s what you need to do to add ClipArt graphics to your document: 

1. Click at the point in your document where you’d like to add a ClipArt graphic. 
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2. Click on the Insert ribbon tab.  

3. Click on the ClipArt button. 

4. A ClipArt pane will open on the right of your document. 

 

5. Type a descriptive term in the Search For field, for example sport. Then click Go or 

press [ENTER]. 

6. The ClipArt Gallery will show you all the available graphics related to this theme. 

7. Clicking on a picture will insert it in your document. 

To remove a graphic from your document, click on it and then press the [DEL] key. 

9.2.2 Moving graphics 

It’s easy to move a graphic wherever you want it: 

1. As you move the mouse pointer over the graphic, it will change into a four-headed 

arrow. 

2. Hold down the left mouse button, and drag the graphic to wherever you’d like it.  

9.2.3 Scaling graphics 

You’d like to change the size of the image? Simple! 

1. Click on the graphic to select it. You’ll know it’s selected when you see eight small 

selection marks around it. 

2. Move the mouse to one of the corners. The mouse pointer changes to a double arrow. 

3. Hold down the left mouse button, and drag the corner of the graphic until it’s the size 

you’d like it to be. 
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9.2.4 Text flow around graphics 

When you add a graphic, it will probably obstruct some of your text. That isn’t good! So let’s 

make the text flow around the graphic instead: 

1. As soon as you click on a graphic, a Format ribbon tab appears at the top of the screen. 

2. Click the Format ribbon tab. 

3. Click on the Text Wrapping button. 

 

4. Select a position for the graphic relative to the text around it. For example, if you’d like 

the text to flow around the contours of the graphic, select Through.) 

9.3 Activity: Tables and formatting 

This section focuses mainly on the use of tables inside documents. A table is the most effective 

way aligning text in rows and columns. If you align text using tabs, then any subsequent editing 

is likely to upset the alignment – check that you understand why this is so. Using a table makes 

it easier to modify and re-use the same document structure, improving business efficiency. In 

fact, this exercise has been laid out using a table. It’s also an excellent way of drawing up 

timetables, lists, minutes of meetings etc. 

1. Log in: Log in to the network and open MS Word. 

2.  Enter text On a blank page, type the following text: 

                      CERTIFICATE IN COMPUTER APPLICATIONS TIMETABLE 

3. Save Save your document in the Word exercises folder on your F drive, with the name 

Table. 
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4.  Formatting Make the first line centered, bold, and a 16 point font. Change the colour 

of the font to be anything you like except Black. 

Add two blank lines after the heading line. They should both be 12 point size. 

5. Insert a table Under the Insert tab, click the Table icon to insert a table with 4 columns 

and 5 rows. 

Type the following text into the table: 

Day  Venue Time  Group 

Wednesday Computer Lab 13:00 Hrs Group 1 

  14:00 Hrs Group II 

Friday Computer Lab 11:00 Hrs Group I 

  13:00 Hrs Group II 

Then save your document again (with the same name). 

6. Format table Click anywhere in the table. A Layout tab will appear under Table Tools. 

Click the Layout tab, and at the left of the ribbon click Select > Table. (You can also 

select the entire table by clicking on the four-headed arrow icon floating next to the top 

left corner of the table.) With the table selected, click the Properties icon and Under the 

Table tab, centre the alignment of the table on the page. Under the Column tab, set the 

column width for all columns to be 3 cm. When you have applied these settings, then 

select all the cells in the heading row of the table. Under the Design tab, click the 

Shading button and choose a background colour for the cells in the heading row.  

7. Borders Select the last two rows of the table (Friday). Use Design > Borders and click 

on Inside Borders to remove the borders INSIDE the last two rows, while keeping the 

outside borders. 

Select the two Wednesday rows, but instead of using the Design tab, go to the 

Home tab and remove the inside borders by using the Borders icon in the Paragraph 

section of the ribbon. 

Do the same for the heading row. 

Use the Office button, then Print > Print preview to check that your table borders are 

done correctly. Close print preview and save your work again. 

8. Add text Below your table, add the following lines (including all the spelling mistakes): 

Notes 

If you do not finish your practical exercices during class, then you are expected to 

complet them in your own time before the stat of the next lecture. 
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All work covered in lectures may be includedin the final exam. 

9. Spell check Under the Review tab, click on the Spelling & Grammar icon to identify 

any spelling mistakes and replace them with the correct spelling. You may have noticed 

when you typed that MS Word will make its own corrections as far as possible. 

10. Format text Underline the word “Notes”. 

11. Bullet points Select the two sentences following “Notes” and use the Home tab to make 

them a bulleted list. 

12. Indent Select the word “Notes” plus the two bullet points, and indent all of them by 

two tab stops. Save your document again. 

13.  Paragraph formatting Use the Paragraph section of the Home ribbon to add a 6 point 

space after each paragraph below your table (i.e. after the Notes heading and after each 

bullet point). 

14. Insert footer Use Insert > Header and select Edit header to add a header region at the 

top of the page. Click on the Date & Time icon and display the current date and time in 

your header. Close the header. 

15.  Insert picture Go to the bottom of your document, add a few blank lines, and then use 

Insert > Clip Art to add a clip art picture from the category “people” below the text on 

your page. Go to the Home tab and centre the picture. Save your document one last 

time.  

9.4 Model Questions 

1. 

 

 

 

 

 

 

 

 

 

 

Mr. Rattan is a trainee editor working with BBB Publishers. He is 

currently working on a book related to Computer Hardware. Read the 

following paragraph carefully and help Mr. Rattan in his job by 

answering the questions that follow: 

The term computer hw refers to the physical 

components of a computer, namely Keyboard, 

Monitor, Mouse, and Printer, including the 

digital circuitry. Computer hw is an integral 

part embedded in all modern day automobiles, 

microwave ovens, electrocardiograph machines, 

compact disc players, and other devices. The hw 

of a computer is not changed frequently, in 

contrast with software and data. The present 

computers are much advanced in terms of 

processing speed and have an efficient memory 
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structure. The present lesson aims at providing 

an insight into the various hw concepts of a 

Computer System. 

i) All the occurrences of the word “hw” need to be substituted by 

the word “hardware”. Name the feature to be used for achieving 

the same. 

ii) The editor needs to create a list of errors at the end of the 

paragraph. Name the feature to be used for achieving the same. 

iii) To simplify editing selected words, suggest the mouse shortcut 

for selecting a complete word. 

iv) The word formatting of the words “computer hw” in the first line 

needs to be copied on certain other words in the paragraph. Name 

the feature to be used for achieving the same. 

 

2.    Reproduce the official letter using MS Word with the font type “Verdana” as per  the 

format  

      and guidelines given below, run the spell check and correct the spelling mistakes      

      (if any) and save the file in correct format, Perform the following as per the sample. 

     There are 3 font sizes of “10 point”, “11 point” and “12 point” and the line spacing- single   

     and double used in the sample along with right insertion. 

 

Not to be typed. All text is 

in 

Font type of “Verdana” 

Date: 19th November, 2011 

 

To, 

The Director, 

ESIC-HQ, 

PANCHDEEP BHAWAN, 

NEW DELHI. 

Subject: Submission of the Candidature for the advertised 

post in the September 2011 News daily. 

 

Respected Madam/Sir, 

This is with reference to the “ADVERTISEMENT” published 

in 

Font Size “12”→ 

Double line spacing→ 
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the News Daily on 15th September, 2011 for the recruitment 

of Group “C” Category post. 

I would like to submit my candidature for the same as per the 

prescribed format of the application form. 

Further, I have read and understood the eligibility criteria and 

process involved in the recruitment and at any stage during 

the recruitment process, any of the information declared by 

myself found incorrect my candidature would stand canceled 

and there would be no claim from my side whatsoever. 

 

Thanking you with warm regards, 

Yours sincerely 

Name: ANTONY JOSE 

Contact address: 

2/8, RESIDENTIAL ENCLAVE, 

NEAR PLAZA CORNER, 

DELHI-110023. 

Enclosure: Copy of the application form with certificates for 

verification. 
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Unit- 10 

Controlling Page Layout 

 

10.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Control page layout. 

 Add a header and footer in a word document. 

 Set page orientation. 

 Set page margin. 

 Insert a manual page break. 

 Delete a page break. 

 Make a spell check in a word document 

 Print a word document 

 Insert a clip art to a word document 

10.1 Controlling Page Layout 

You’d like to add page numbers, or perhaps a header or footer, to your document? That’s not 

hard! (Headers and footers are elements of a document that are repeated on every page.) 

10.1.1 Adding page numbers 

Let’s start by adding page numbers to your document: 

1. Select the Insert ribbon tab, and click on the Page Number button. 

 

2. From the drop-down menu, select the position you’d like for your page numbers, and 

one of the built-in formats. It’s as simple as that! 

3. Page numbers will be inserted into your document, and the Design ribbon will replace 

the Insert ribbon above the document window. 

4. If you want to adjust the page numbering style or sequence then click the Page Number 

button again, and select Format Page Numbers. 
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5. Finally, click Close Header & Footer to return to your document text. 

 

10.1.2 Adding a header 

Headers and footers aren’t automatically included in a new document. But that’s easily 

remedied! Let’s start with a header: 

1. On the Insert ribbon, click the Header button. 

 

2. The Header menu will drop down, offering you a choice of built-in header layouts. 

Select a layout by clicking on it. 

3. The header area will appear above your document text (which will be greyed out). The 

Design ribbon will replace the Insert ribbon above the document window. 

4. You’ll see a text placeholder in the header area. Click on it and then type the text that 

you want to appear in the header. 

5. When you’ve finished creating your header, you can either 

a.  click the Close Header and Footer button, or 

b. if you’d like to add a footer as well, then click the Footer button. 

To edit an existing header, just double-click anywhere in the header area. To remove a header, 

click the Header button and then select Remove Header from the bottom of the drop-down 

menu. 
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10.1.3 Adding a footer 

Adding, editing or removing a footer follows the same steps as described above for a header. 

Just click the Footer button instead of the Header button! 

 

10.1.4 Setting page orientation 

You can decide on the orientation of your page ie. portrait or landscape by selecting Page 

Layout, then Orientation. 

10.1.5 Setting page margins 

To change the margins of your document, select Page Layout, then Margins. The most common 

margin width to use is the Normal option. You are also welcome to select your own margin 

settings by selecting Margins, Custom Margins. 

 

10.1.6 Inserting a manual page break 

You will often need to insert a manual page break to add a blank page to your document. You 

do this by clicking on Insert and then selecting the Blank Page option. 

 

10.1.7 Deleting a page break 

1. Select Print Layout. 

2. Click on the page break in Print Layout view and hit the delete key 
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10.2 Spelling and grammar checking 

Have you sometimes noticed a wavy red line appearing beneath your typing? This indicates a 

typo, or a word that Word doesn’t recognise. Note that Word also regards a missing space after 

a comma or a period, or the doubling of a word (the the), as a mistake! 

10.2.1 Proofing while you type 

Now I’ll show you how to use the nifty spell checker! 

1. Mistype a word so that the wavy red line appears. 

2. Click the right mouse button on the underlined word. A context-sensitive menu will 

open up. 

 

3. Click with the left mouse button on the correct suggestion, and the mistyped word will 

automatically be replaced. 

What if Word doesn’t make any suggestions? Then check whether maybe you left out a space 

after a period or comma. 

 

10.2.2 Spell checking the entire document 

Maybe you’d rather get your thoughts down on paper without stopping to make corrections as 

you go? Word also has an option to spell check the entire document or selected passages of 

text. 

1. Position the cursor at the point where you’d like to begin spell checking. 

2. Click on the Review ribbon tab, and then on the Spelling & Grammar button. The 

Spelling and Grammar dialogue box will open. 
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3. The first spelling or grammar error will be highlighted and a list of suggestions 

provided. 

4. Click the correct suggestion and then Change, or click the Ignore Once button to skip 

over it. 

 

5. Each subsequent problem will be highlighted in turn. 

6. Press OK when the spelling and grammar check is complete. 

 

 

10.2.3 Automatic error correction 

Did you know that Word is already looking for errors while you are still typing a word? Try it 

– for example, type adn instead of and, or teh instead of the. You can’t do it! The force 

behind this is an intelligent function called Auto-Correct. 

10.3 Printing a document 

Now it’s finally time to see your words on paper! 

10.3.1 The Print dialog box 

This is the approach that I recommend: 

1. Click the Office button and select the Print command. 
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2. The Print dialog box will appear. 

3. If you have more than one printer to choose from, they will be available in the Printer 

area. Click the drop-down arrow next to the Name field to select your preferred 

printer. 

4. Would you like to print selected pages only? Find the Page Range area, and type the 

page numbers that you’d like printed in the Pages field. 

5. If you’d like more than one copy of the document, then enter the required number of 

copies in the Number of Copies field. 

6. If you’d like to print more than one page per sheet (compressed printing), then select 

the required number in the Pages per Sheet field. 

7. Click OK when you’re satisfied with your settings. The specified document pages will 

be sent to the printer. 

 

10.4 Word tips and tricks 

Now we’re almost at the end of this manual. Almost – but I still have a few tricks for you 

hidden up my sleeve! 

10.4.1 Beginning on a new page 

You’d like to begin a piece of text on a new page? Perhaps you’ve tried to do this by repeatedly 

pressing [ENTER] until you reach the right position? And then when you changed something 

on the previous page, the entire line count became scrambled! Here’s a trick to ensure this will 

never happen to you again. 

1. Click just before the text that you’d like to place on a new page. 
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2. Hold down the [CTRL] key and press [ENTER]. 

3. Word will automatically add a hard page break to your document. 

 

10.4.2 Searching for text 

You’re working on a long document, and looking for a particular item of text? 

1. Click the Find button at the left end of the Home ribbon. 

 

2. The Find and Replace dialog box will appear. Click the Find tab. 

3. Type in the word or phrase you’re searching for and click Find Next. 

 

4. Word will display and highlight the next occurrence of the specified word or phrase. 

5. You can continue pressing Find Next to locate all occurrences of the specified word or 

phrase, or click Cancel to close the window. 

6. Word will tell you when all occurrences of the word or phrase have been displayed. 
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10.5 Text effects with WordArt 

How would you like to create cool text effects with shadows and 3D? Check out the WordArt 

functions! 

1. Select the text to which you want to add WordArt effects. 

2. Click the WordArt button on the Insert ribbon. 

 

3. A selection of WordArt design options will appear. 

 

4. Click on a design option to select it. 

5. The Edit WordArt Text dialog box will allow you to change the font style and size. 

Click OK to accept the settings. 
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6. Your selected text will be transformed by the WordArt you have chosen! 

 

10.6 Activity: Page layout and graphics 

In this exercise, you’ll create a brochure that can be used for advertising a business. The 

brochure will be printed in “landscape mode”, and set in columns so that it can be folded in 

three to stand upright on a counter top. 

1. Open MS Word Start MS Word, open a new blank document and save it in your home 

director with the name “Brochure”. 

2. Formatting Under the Page Layout tab, set the page Orientation to be Landscape. Set 

the top and bottom Margins to be 2.5 cm each, and the left and right margins to be 1 

cm each. 

3. Columns Use the Columns button and select More Columns. Choose a three column 

layout with equal column width, and with Spacing of 2 cm. Click OK to confirm your 

settings, and then save your file again. The ruler bar above your document should 

display the columns that you have set up. 

4. Insert Word Art Under the Insert tab, click WordArt in the Text section of the ribbon. 

Select any Word Art style and type the word SHARP. When you close the Word Art 

window, the word SHARP should be positioned at the top of your first column. Drag 

the borders if necessary to fit the width of the column. Press Enter twice below the 

Word Art box. 

5. Insert a Text Box Go back to the Insert tab, click the Text box button and select a 

Simple text box. Inside the text box type the words Hair Salon. Change the font to be 

Verdana 48 point, and centre align the text. Format thefont colour to your own choice. 

Right click on the text box border and format the text box to have no line visible. Press 

enter twice below your text box. 

6.  Insert a picture Use Insert > ClipArt to insert a picture below your text box. Drag the 

edges to resize it if necessary. Column one should now contain the word SHARP in 

Word Art, the words “Hair Salon” in a text box, and a clip art picture. You can use Print 

Preview to see how the column looks. Save your document again. 

7. Enter text in Column Two Press Enter until your cursor is at the top of the second 

column. Then type the following text in 20 point Verdana: At Sharp Hair Salon we 

know how to style your hair! We offer hair cuts, treatments, braids, extensions and 

dreadlocks at affordable prices. Try us - we guarantee you won’t regret it. Contact 082 

678123 for prices and appointments. 
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8. Insert pictures Search on the Internet for some pictures of hair styles and insert them 

in the third column. Size them appropriately. (If you are feeling adventurous, then you 

can click on your clip art picture in column one, delete it, and replace it with an Internet 

picture as well.) Use Print Preview to see what your brochure looks like, and save your 

document. Tip: to find pictures, go to www.google.com and click on the Images 

hyperlink on the Google search page. 

Your document should look similar to the example shown (in reduced size) below. 
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Unit- 11 

Getting started with MS Excel 

 

Learning Objectives 

At the end of this unit, you should be able to: 

 Define excel. 

 Open an excel document 

 Close an excel document 

 Navigate within a worksheet 

 Select a cell in an excel document. 

 Select rows and columns in an excel document. 

 Enter the data into a cell. 

 Understand various data types available in excel. 

 Move data among cells. 

 Copy data between cells. 

 Use autofill feature. 

 Save a workboos. 

11.1 Getting started with Excel 

Excel and Word have a lot in common, since they both belong to the MS Office suite of 

programs. This means that if you are familiar with Word, then you already know how to use 

several Excel features! 

In the Word section of this manual, you’ll be able to find more information and guidance on 

 Using the mouse and keyboard 

 Starting the program 

 The Office button and ribbon 

 Character formatting 

 Opening, saving and printing files 

 Accessing Help 

11.1.1 What is Excel? 

Excel is all about numbers! There’s almost no limit to what you can do with numbers in Excel, 

including sorting, advanced calculations, and graphing. In addition, Excel’s formatting options 

mean that whatever you do with your numbers, the result will always look professional! 
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Data files created with Excel are called workbooks (in the same way as Word files are called 

documents). But where Word starts up with a single blank page, Excel files by default contain 

three blank worksheets. This gives you the flexibility to store related data in different locations 

within the same file. More worksheets can be added, and others deleted, as required. 

You’ll often hear Excel files referred to as spreadsheets. This is a generic term, which 

sometimes means a workbook (file) and sometimes means a worksheet (a page within the file). 

For the sake of clarity, I’ll be using the terms workbook and worksheet in this manual. 

11.1.2 The Excel 2007 window 

As in Word 2007, the old menu system has been replaced by the Ribbon and the Office button. 

The title bar displays the name of your current workbook. Tabs at the bottom of the screen 

identify the different worksheets available to you – I’ll show you a little later how to give them 

meaningful names. 

Notice how the working area of the screen is divided into rows (1, 2, 3, 4, ...) and columns (A, 

B, C, D, …). Together these provide an address, such a C10 or G21, that uniquely identifies 

each cell in the worksheet. A range of cells extends in a rectangle from one cell to another, and 

is referred to by using the first and last cell addresses separated by a colon. For example, the 

group of cells from A3 to G4 would be written as A3:G4. 

In the example above, the current or active cell is B7. It is surrounded by a heavy black border, 

and its address is displayed in the name box above column A. Its row and column numbers are 

also highlighted. 
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On the right of the name box is the formula bar. This displays the value stored in the active 

cell, and is also the place where you would enter a new data value or formula into that cell. 

11.1.3 Starting Excel 

If you have an icon on the desktop for Excel, then all you have to do is double-click it to open 

Excel. 

 

Alternatively, click the Start button and then select All Programs, Microsoft Office, Microsoft 

Excel. 

 

 When you open Excel from a desktop icon or from the Start menu, a new empty 

workbook (consisting of three worksheets) will be displayed on your screen. 

 If you double-click on an existing Excel file from inside the Windows Explorer 

window, then Excel will open and display the selected file on your screen. 

11.1.4 Closing Excel 

Close Excel by clicking the X on the far right of the title bar. 

11.1.5 Navigating within a worksheet 

Using the mouse: 

 Use the vertical and horizontal scroll bars if you want to move to an area of the screen 

that is not currently visible. 

 To move to a different worksheet, just click on the tab below the worksheet. 

Using the keyboard: 

 Use the arrow keys, or [PAGE UP] and [PAGE DOWN], to move to a different area of 

the screen. 

 [CTRL] + [HOME} will take you to cell A1. 
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  [CTRL] + [PAGE DOWN] will take you to the next worksheet, or use [CTRL] + 

[PAGE UP] for the preceding worksheet. 

You can jump quickly to a specific cell by pressing [F5] and typing in the cell address. You 

can also type the cell address in the name box above column A, and press [ENTER]. 

11.1.6 Selecting cells 

Using the mouse: 

 Click on a cell to select it. 

 You can select a range of adjacent cells by clicking on the first one, and then dragging 

the mouse over the others. 

 You can select a set of non-adjacent cells by clicking on the first one, and then holding 

down the [CTRL] key as you click on the others. 

Using the keyboard: 

 Use the arrow keys to move to the desired cell, which is automatically selected. 

 To select multiple cells, hold down the [SHIFT] key while the first cell is active, and 

then use the arrow keys to select the rest of the range. 

11.1.7 Selecting rows or columns 

To select all the cells in a particular row, just click on the row number (1, 2, 3, etc) at the left 

edge of the worksheet. Hold down the mouse button and drag across row numbers to select 

multiple adjacent rows. Hold down [CTRL] if you want to select a set of non-adjacent rows. 

Similarly, to select all the cells in column, you should click on the column heading (A, B, C, 

etc) at the top edge of the worksheet. Hold down the mouse button and drag across column 

headings to select multiple adjacent columns. Hold down [CTRL] if you want to select a set of 

non-adjacent columns. 

You can quickly select all the cells in a worksheet by clicking the square to the immediate left 

of the Column A heading (just above the label for Row 1). 

 



CVDMM(N) 202- Office Automation and Internet Skills  UOU 

Unit- 11: Getting started with MS Excel Page 118 of 207 

11.2 Entering data 

11.2.1 First you need a workbook 

Before you start entering data, you need to decide whether this is a completely new project 

deserving a workbook of its own, or whether the data you are going to enter relates to an 

existing workbook. Remember that you can always add a new worksheet to an existing 

workbook, and you’ll find it much easier to work with related data if it’s all stored in the same 

file. 

If you need to create a new workbook from inside Excel: 

1. Click on the Office button, select New and then Blank Workbook. 

2. Sheet 1 of a new workbook will be displayed on your screen, with cell A1 active.  

To open an existing workbook from inside Excel: 

1. Click on the Office button, click Open, and then navigate to the drive and folder 

containing the file you want to open. 

2. Double-click on the required file name. 

11.2.2 Overview of data types 

Excel allows you to enter different sorts of data into the cells on a worksheet, such as dates, 

text, and numbers. If you understand how Excel treats the different types of data, you’ll be able 

to structure your worksheet as efficiently as possible. 

 Numbers lie at the heart of Excel’s functionality. They can be formatted in a variety of 

different ways – we’ll get to that later. You should generally avoid mixing text and 

numbers in a single cell, since Excel will regard the cell contents as text, and won’t 

include the embedded number in calculations. If you type any spaces within a number, 

it will also be regarded as text. 

 

Note that dates and times are stored as numbers in Excel, so that you can calculate the 

difference between two dates. However, they are usually displayed as if they are text. 

If a number is too large to be displayed in the current cell, it will be displayed as 

“#####”. The formatting section of this manual explains how to widen a column. 

 Text consist mainly of alphabetic characters, but can also include numbers, punctuation 

marks and special characters (like the check mark in the example above). Text fields 
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are not included in numeric calculations. If you want Excel to treat an apparent number 

as text, then you should precede the number with a single quotation mark (‘). This can 

be useful when entering for example a phone number that starts with 0, since leading 

zeros are not usually displayed for Excel numbers. 

If a text field is too long to be displayed in the current cell, it will spill over into the 

next cell if that cell is empty, otherwise it will be truncated at the cell border. The 

formatting section of this manual explains how to wrap text within a cell. 

 Formulas are the most powerful elements of an Excel spreadsheet. Every formula starts 

with an “=” sign, and contains at least one logical or mathematical operation (or special 

function), combined with numbers and/or cell references.  

11.2.3 Data entry cell by cell 

To enter either numbers or text: 

1. Click on the cell where you want the data to be stored, so that the cell becomes active. 

2. Type the number or text. 

3. Press [ENTER] to move to the next row, or [TAB] to move to the next column. Until 

you’ve pressed [ENTER] or [TAB], you can cancel the data entry by pressing [ESC]. 

To enter a date, use a slash or hyphen between the day, month and year, for example 

14/02/2009. Use a colon between hours, minutes and seconds, for example 13:45:20. 

11.2.4 Deleting data 

You want to delete data that’s already been entered in a worksheet? Simple! 

1. Select the cell or cells containing data to be deleted. 

2. Press the [DEL] key on your keyboard. 

3. The cells remain in the same position as before, but their contents are deleted. 

11.2.5 Moving data 

You’ve already entered some data, and want to move it to a different area on the worksheet? 

1. Select the cells you want to move (they will become highlighted). 

2. Move the cursor to the border of the highlighted cells. When the cursor changes from a 

white cross to a four-headed arrow (the move pointer), hold down the left mouse button. 

 

3. Drag the selected cells to a new area of the worksheet, then release the mouse button. 
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You can also cut the selected data using the ribbon icon or [CTRL] + [X], then click in the top 

left cell of the destination area and paste the data with the ribbon icon or [CTRL] + [V]. 

11.2.6 Copying data 

To copy existing cell contents to another area on the worksheet: 

1. Select the cells you want to copy (they will become highlighted). 

2. Move the cursor to the border of the highlighted cells while holding down the [CTRL] 

key. When the cursor changes from a white cross to a hollow left-pointing arrow (the 

copy pointer), hold down the left mouse button. 

 

3. Drag the selected cells to a second area of the worksheet, then release the mouse button. 

You can also copy the selected data using the ribbon icon or [CTRL] + [C], then click in the 

top left cell of the destination area and paste the data with the ribbon icon or [CTRL] + [V]. 

To copy the contents of one cell to a set of adjacent cells, select the initial cell and then move 

the cursor over the small square in the bottom right-hand corner (the fill handle). 

 

The cursor will change from a white cross to a black cross. Hold down the mouse button and 

drag to a range of adjacent cells. The initial cell contents will be copied to the other cells. 

Note that if the original cell contents end with a number, then the number will be incremented 

in the copied cells. 

 

11.2.7 Using Autofill 

This is one of Excel’s niftiest features! It takes no effort at all to repeat a data series (such as 

the days of the week, months of the year, or a numbers series such as odd numbers) over a 

range of cells. 

1. Enter the start of the series into a few adjacent cells (enough to show the underlying 

pattern). 

2. Select the cells that contain series data. 
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3. Move the cursor over the small square in the bottom right-hand corner of the selection 

(the fill handle). Hold down the mouse button and drag to a range of adjacent cells. 

4. The target cells will be filled based on the pattern of the original series cells. 

11.2.8 Saving a workbook 

So now it’s time to save your work. As usual, you need to specify the file name, and its location 

(drive and folder). 

1. Click the Office button and select Save, or click the Save icon on the Quick Access 

toolbar. If this workbook has been saved before, then that’s it – your workbook will be 

saved again with the same name and location. 

2. If it’s the first time of saving this workbook, then the Save As dialogue box will open. 

3. Click the drop-down arrow next to Save In to select the desired drive and folder. 

4. Type the new file name in the File Name field. 

5. Click the Save button. 
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Unit- 12 

Editing data in MS Excel 

 

Learning Objectives 

At the end of this unit, you should be able to: 

 Perform editing in an excel document. 

 Insert or delete a cell 

 Insert or delete rows, columns. And worksheets. 

 Perform formatting of data in an excel sheet. 

 Hide rows and columns. 

12.1 Editing data 

In data entry mode, when you move the cursor to a new cell, anything you type replaces the 

previous cell contents. Edit mode allow you to amend existing cell contents without having to 

retype the entire entry. Note that while you are in edit mode, many of the Ribbon commands 

are disabled. 

12.1.1 Editing cell contents 

There are two different ways to enter edit mode: either double-click on the cell whose contents 

you want to edit, or else click to select the cell you want to edit, and then click anywhere in the 

formula bar. 

 To delete characters, use the [BACKSPACE] or [DEL] key. 

 To insert characters, click where you want to insert them, and then type. You can toggle 

between insert and overtype mode by pressing the [INSERT] key. 

 You can force a line break within the current cell contents by typing [ALT] + [ENTER].  

Exit edit mode by pressing [ENTER]. 
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12.1.2 Inserting or deleting cells 

You can insert a new cell above the current active cell, in which case the active cell and those 

below it will each move down one row. You can also insert a new cell to the left of the current 

active cell, in which case the active cell and those on its right will each move one column to 

the right. 

 

To insert a cell: 

1. Select the cell next to which you want to insert a new cell. 

2. On the Home ribbon, find the Cells group and click Insert followed by Insert Cells. 

 

3. A dialog box will open. Click the direction in which you want the surrounding cells to 

shift. 

 

To delete a cell, do as follows: 

1. Select the cell that you want to delete. 

2. On the Home ribbon, find the Cells group and click Delete followed by Delete Cells. 
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3. A dialog box will open. Click the direction in which you want the surrounding cells to 

shift. 

You can also right-click on the active cell and select Insert or Delete on the pop-up menu. 

12.1.3 Inserting or deleting rows 

When you insert a row, the new row will be positioned above the row containing the active 

cell. 

1. Select a cell in the row above which you want to insert a new row. 

2. On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet 

Rows. 

3. A new row will be inserted above the current row. 

To delete a row, do as follows: 

1. Select a cell in the row that you want to delete. 

2. On the Home ribbon, find the Cells group and click Delete followed by Delete Sheet 

Rows. 

3. The row containing the active cell will be deleted. All the rows below it will move up 

by one. 

You can also right-click on the active cell and use the pop-up menu to insert or delete a row. 

12.1.4 Inserting or deleting columns 

When you insert a column, the new column will be positioned on the left of the column 

containing the active cell. 

1. Select a cell in the column to the left of which you want to insert a new column. 

2. On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet 

Columns. 

3. A new column will be inserted to the left of the current column. 

To delete a column, do as follows: 

1. Select a cell in the column that you want to delete. 

2. On the Home ribbon, find the Cells group and click Delete followed by Delete Sheet 

Columns. 
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3. The column containing the active cell will be deleted. All the columns on its right will 

move left by one. 

You can also right-click on the active cell and use the pop-up menu to insert or delete a column. 

12.1.5 Inserting or deleting a worksheet 

To insert a new worksheet at the end of the existing worksheets, just click the Insert Worksheet 

tab at the bottom of the screen. 

 
To insert a new worksheet before an existing worksheet, do as follows: 

1. Select the worksheet before which you want to insert a new worksheet. 

2. On the Home ribbon, find the Cells group and click Insert followed by Insert Sheet. 

3. A new worksheet will be inserted before the current worksheet. 

To delete a worksheet, 

1. Select the worksheet that you want to delete. 

2. On the Home ribbon, find the Cells group and click Delete followed by Delete Sheet. 

3. The current worksheet will be deleted. 

12.1.6 Moving or copying a worksheet 

Right-click on the worksheet tab, and select Move or Copy from the pop-up menu. A dialog 

box will open: 

 

The To Book field allows you to move or copy the current worksheet to another workbook. 

The Before Sheet field allows you to specify the new position of the worksheet. 
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The Create a Copy checkbox lets you specify whether the worksheet should be moved or 

copied. 

12.1.7 Renaming a worksheet 

Right-click on the worksheet tab, and select Rename from the pop-up menu. Type the new 

worksheet name and press [ENTER]. 

 

 

12.2 Formatting data 

12.2.1 Cell formatting 

The icons on the Home ribbon provide you with a variety of formatting options. To apply any 

of these, just select the cell or cells that you want to format, and then click the desired icon. 

Commonly used formatting attributes include: 

  Font and size 

   Bold, Italic, Underline 

     Cell borders 

   Background and Font colour 
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    Alignment: Left, Centre or Right 

     Merge text across multiple cells 

     Wrap text within a cell 

      Rotate angle of text 

    Format number as Currency, Percentage or Decimal 

     Increase or Decrease number of decimal places 

The Format Painter allows you to copy formatting attributes from one cell to a range of cells. 

1. Select the cell whose formatting attributes you want to copy. 

2. Click on the Format Painter icon.  

3. Select the cell or range of cells that you want to have the same formatting attributes. 

The cell values will remain as before, but their format will change. 

12.2.2 Formatting rows and columns 

Any of the cell formatting options above can easily be applied to all the cells contained in one 

or more rows or columns. Simply select the rows or columns by clicking on the row or column 

labels, and then click on the formatting icons that you want to apply. 

You may also want to adjust the width of a column: 

 To manually adjust the width, click and drag the boundary between two column 

headings.  

 To automatically adjust the width, select the required columns, and then in the Cell 

group on the Home ribbon, select Format, Cell Size, Autofit Column Width. 

 

 To specify an exact column width, select the columns, and then in the Cell group on the 

Home ribbon, select Format, Cell Size, Column Width, and type the value you want. 
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To adjust the height of a row: 

 To manually adjust the height, click and drag the boundary between two row labels. 

 To automatically adjust the height, select the required rows, and then in the Cell group 

on the Home ribbon, select Format, Cell Size, Autofit Row Height. 

 To set a row or rows to a specific height, select the rows, and then in the Cell group on 

the Home ribbon, select Format, Cell Size, Row Height, and type the value that you 

want. 

12.2.3 Hiding rows and columns 

If your spreadsheet contains sensitive data that you don’t want displayed on the screen or 

included in printouts, then you can hide the corresponding rows or columns. The cell values 

can still be used for calculations, but will be hidden from view. 

The easiest way to hide or unhide a row or column is to select the row or column heading, 

right-click to view the pop-up menu, and then select Hide or Unhide. 
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Alternatively, you can click the Format icon on the Home ribbon, and select the Hide & Unhide 

option.  

12.2.4 Keeping row and column headings in view 

If you scroll through a lot of data in a worksheet, you’ll probably lose sight of the column 

headings as they disappear off the top of your “page”. This can make life really difficult – 

imagine trying to check a student’s result for tutorial 8 in row 183 of the worksheet! And it’s 

even more difficult if the student’s name in column A has scrolled off the left edge of the 

window. 

The Freeze Panes feature allows you to specify particular rows and columns that will always 

remain visible as you scroll through the worksheet. And it’s easy to do! 

Select a cell immediately below the rows that you want to remain visible, and immediately to 

the right of the columns that you want to remain visible. For example, if you want to be able 

to see Rows 1 and 2, and column A, then you would click on cell B3. 

 

On the View tab, click Freeze Panes, and select the first option. 

 

If Freeze Panes has already been applied, then the ribbon option automatically changes to 

Unfreeze Panes. 
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Unit- 13 

Functions in MS Excel 

 

Learning Objectives 

At the end of this unit, you should be able to: 

 Apply addition and sutosum function in an excel sheet. 

 Print an excel sheet. 

 Insert charts in an excel sheet. 

 Perform data manipulation in an excel sheet. 

13.1 Functions 

Excel provides a wide range of built-in functions that can be included in your formulas to save 

you the effort of having to specify detailed calculations step-by-step. Each function is referred 

to by a specific name, which acts as a kind of shorthand for the underlying calculation. 

Because a function is used inside a formula, you’ll still need to start off with an equals sign to 

show Excel that a calculation is required. 

13.1.1 Using AutoSum 

Because addition is the most frequently used Excel function, a shortcut has been provided to 

quickly add a set of numbers: 

1. Select the cell where you want the total to appear. 

2. Click on the Sum button on the Home ribbon. 

3. Check that the correct set of numbers has been selected (indicated by a dotted line). If 

not, then drag to select a different set of numbers. 

4. Press [ENTER] and the total will be calculated. 

13.1.2 Basic functions 

Some of the most commonly used functions include: 

SUM() to calculate the total of a set of numbers 

AVERAGE() to calculate the average of a set of numbers 

MAX() to calculate the maximum value within a set of numbers 

MIN() to calculate the minimum value within a set of numbers 

ROUND() to round a set a values to a specified number of decimal places 

TODAY () to show the current date 

IF() to calculate a result depending on one or more conditions 
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So how do you use a function? 

A function makes use of values or cell references, just like a simple formula does. The numbers 

or cell references that it needs for its calculations are placed in brackets after the name of the 

function. 

To give a simple illustration: 

 

Several popular functions are available to you directly from the Home ribbon. 

1. Select the cell where you want the result of the calculation to be displayed. 

2. Click the drop-down arrow next to the Sum button. 

3. Click on the function that you want. 

4. Confirm the range of cells that the function should use in its calculation. (Excel will try 

to guess this for you. If you don’t like what it shows inside the dotted line, then click 

and drag to make your own selection.) 

5. Press [ENTER]. The result of the calculation will be shown in the active cell. 

As an example, to calculate the average for the following set of tutorial results, you would: 

1. Click on cell F3 to make it active. 

2. Click on the arrow next to the Sum button, and select Average. 

3. Press [ENTER] to accept the range of cells that is suggested (B3:E3). 

That’s it! You can now copy the formula in cell F3 down to cells F4 and F5 – using relative 

addressing because you want a different set of tutorial marks to be used for each student. 

 

If you want to use a function that isn’t directly available from the drop-down list, then you can 

click on More Functions to open the Insert Function dialog box. Another way to open this 

dialog box is to click the Insert Function icon on the immediate left of the formula bar. 

The Insert Function dialog box displays a list of functions within a selected function category. 
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If you select a function it will briefly describe the purpose and structure of the function. 

 

When you click the OK button at the bottom of the window, you’ll be taken to a second 

dialogue box that helps you to select the function arguments (usually the range of cells that the 

function should use). 

 

Some functions use more than one argument. For example, the ROUND() function needs to 

know not only which cells to use, but also how many decimal places those cells should be 

rounded to. So the expression =ROUND(G5:G8, 0) will round the values in cells G5 to G8 to 

the nearest whole number (i.e. no decimal places). 

 

13.1.3 The IF() function 

The IF() function is getting a section all of its own, because for many people it’s not as intuitive 

to understand as the common maths and stats functions. 

The IF() function checks for a specific condition. If the condition is met, then one action is 

taken; if the condition is not met, then a different action is taken. For example, you may be 

reviewing a set of tutorial marks. If a student’s average mark is below 50, then the cell value 

should be FAIL; so the condition you are checking is whether or not the average result is below 

50. If this condition is not met (that is, the average result is 50 or more), then the cell value 

should be PASS. 

Let’s see this in action: 
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The structure of an IF() function is: 

=IF (condition, result if true, result if false) 

Using English to describe our example as an IF statement: IF the average mark is less than 50, 

then display the word “FAIL”, else display the word “PASS”. 

Now for a real worksheet example. Look at the formula bar in the screenshot below: 

 

Do you follow how the formula in cell G4 was constructed? Because the average mark is stored 

in cell F4, we need to check whether the value in F4 is less than 50. If it is, then the active cell 

(G4) must display the word “Fail”. If the value in F4 is not less than 50, then the active cell 

must display the word “Pass”. That’s not really so complicated, is it? 

13.1.4 Nested functions 

Take a deep breath and don’t panic! I just want to show you that if you need to, you can include 

one function inside another. 

In the example above, we first worked out the Average mark, and then the Pass/Fail outcome. 

But we could have done it all in a single step, by using the following formula in row 3: 

=IF(AVERAGE(B3:E3) < 50, “FAIL”, “PASS”) 

In this IF statement, I’ve nested one function inside another. The reference to cell F4 has been 

replaced with a function that calculates the average tutorial mark, and then checks it against 

the same condition as before (“< 50”), with the same possible outcomes. Doing it this way, you 

wouldn’t need column F in the worksheet at all. 

Of course, in real life you’d expect to get students coming to query their Pass/Fail status, and 

would probably want to keep the Average column to explain the outcome that’s been allocated 

to them. So the first example using a separate Average and Outcome is not only simpler, it’s 

also more practical! 

13.2 Printing 

By default, Excel prints all the data on the current worksheet. If your worksheet extends over 

several pages, it’s worth making sure that the printed copy will be easily readable. Here are a 

few tips. 
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13.2.1 Print preview 

Start by using Print Preview to see what your data will look like when it’s printed. 

1. Click the Office button, select Print and then Print Preview. The Print Preview icon 

shows a dog-eared page with a magnifying glass. 

 

2. The display will change to Print Preview mode. You see the document exactly as it will 

look when printed. 

3. The Show Margins option allows you to not only adjust your page margins by dragging 

them, but also to drag the column and row boundaries to make them narrower or wider. 

 

4. Now is the time to consider whether the column and row labels are easily visible, 

whether page breaks are in appropriate places, and whether you need to include page 

numbers. The following section tells you how to do all these. 

5. To close Print Preview, click the Close Print Preview button on the right of the ribbon. 

13.2.2 Preparing to print 

Your best option is to use the Page Layout ribbon for this. (Some of the same options are 

available from inside Print Preview, but many of them aren’t.) 

 

 Use the Orientation button to swap between portrait and landscape mode. 
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 Use the Print Area button to select a subset of your data for printing. (The data that you 

want included in the print area should be selected before you click this icon.) 

 Use the Breaks button to insert a page break immediately above the currently active 

cell, or to remove previously specified page breaks. 

The Print Titles button takes you to the Page Setup dialogue box, which has four tabs that allow 

you to do a whole lot more than printing titles. 

 

The Page tab is used to set orientation and scaling. 

The Margins tab is used to adjust page margins. 

The Header/Footer tab allows you to enter a header or footer to be repeated on every page. 

This is where you would include page numbers. 

The Sheet tab lets you specify rows that are to be repeated at the top of each sheet (such as 

column headings), and columns to be repeated at the left of each sheet (such as student names). 

You can also adjust the print area under this tab. 

 

 

13.2.3 Printing a worksheet 

You’ve previewed your worksheet one last time, and you’re happy with the way it looks – now 

it’s time to finally print it! 

1. Click the Office button and select the Print command. 

2. The Print dialog box will appear. 
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3. If you have more than one printer to choose from, they will be available in the Printer 

area. Click the drop-down arrow next to the Name field to select your preferred printer. 

4. Would you like to print selected pages only? Find the Page Range area, and type the 

page numbers that you’d like printed in the Pages field. 

5. If you’d like to print the entire workbook, rather than just the active sheet, you can 

specify this in the Print What area of the dialog box. 

6. If you’d like more than one copy of the worksheet, then enter the required number of 

copies in the Number of Copies field. 

7. Click OK when you’re satisfied with your settings. The specified worksheet pages will 

be sent to the printer. 

13.3 Charts 

A picture is worth a thousand words! Often it’s much easier to understand data when it’s 

presented graphically, and Excel provides the perfect tools to do this! 

It’s worth starting with a quick outline of different data types and charts: 

− Categorical data items belong to separate conceptual categories such as knives, forks 

and spoons; or males and females. They don’t have inherent numerical values, and it 

doesn’t make sense to do calculations such as finding an average category. A pie chart 

or column chart is most suitable for categorical data. 

− Discrete data items have numerical values associated with them, but only whole values; 

for example, the number of TV sets in a household. Again, average values don’t make 

much sense. Discrete data is often grouped in categories (“less than three”, “four or 

more”) and treated as categorical data. 
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− Continuous data refers to numerical values that have an infinite number of possible 

values, limited only by the form of measurement used. Examples are rainfall, 

temperature, time. Where discrete data has a very large number of possible values, it 

may also be treated as continuous. Continuous data is well suited to line graphs, which 

are very useful for illustrating trends.  

Of course, Excel offers you many more chart types than just these three. Do remember that it’s 

best to select a chart type based on what you’re trying to communicate. 

 

13.3.1 Creating a chart 

It’s very easy to create a basic chart in Excel: 

1. Select the data that you want to include in the chart (together with column headings if 

you have them). 

2. Find the Charts category on the Insert ribbon, and select your preferred chart type. 

 

3. That’s it! The chart appears in the current window. Move the cursor over the Chart Area 

to drag it to a new position. 
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13.3.2 Modifying a chart 

When you click on a chart, a Chart Tools section appears on your Ribbon, with Design, Layout 

and Format tabs. 

 Use the Design tab to quickly change the chart type, or to swap data rows and columns. 

 

In this example, I’ve changed the previous chart type to Column, and swapped rows 

and columns. All it took was two mouse clicks! 

 

 Use the Layout tab to add a title, and to provide axis and data labels. 

 Use the Format tab to add border and fill effects. 

13.3.3 Inserting graphics in a worksheet 

Sometimes you may want to add graphics, for example a corporate logo, to a worksheet. The 

good news is that images, ClipArt and WordArt are available in Excel, along with a host of 

call-out shapes that you can use to label your charts. You’ll find them all on the Insert ribbon. 
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13.4 Data manipulation 

The features mentioned in this section are most relevant when you’re working with a large data 

set – perhaps several hundred, or even thousand records – and it isn’t practical to scroll through 

the entire worksheet each time you want to find a particular record. 

To use data functions effectively, each column of your worksheet should contain the same data 

type, apart from the column heading. Ideally, row 1 should contain the column headings, with 

the data rows immediately below; this structure is referred to as a data table. If you have blank 

rows in your data set, then you’ll need to manually select the data to be manipulated, which 

you don’t really want to do. 

13.4.1 Sort 

The sort function does exactly what it says: it sorts your data records based on the criteria that 

you specify. You can sort numbers, text or dates, in either ascending (default) or descending 

order. Blank cells are always placed last in a sort. 

If you want to sort an entire data table: 

1. Click anywhere in the column that you want to sort by. 

2. On the Home ribbon, select Sort & Filter. 
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3. Choose either Ascending (Sort A to Z) or Descending (Sort Z to A) order. 

4. Your data will be sorted based on the value in the column that you initially clicked on. 

If you want to sort on two or more criteria (columns), or if you want to sort a range of cells, 

then you need to do a custom sort: 

1. Click in the data table, or select the cells to be sorted. 

2. On the Home ribbon, select Sort & Filter, and choose Custom Sort. The Sort Window 

will open. 

 

3. In the Sort By field, use the drop-down arrows to select the column that you want to 

sort by and the order (ascending or descending) to be used. 

4. If you want to add another sort criterion, then click the Add Level button, and a second 

details row will appear in the window. Again, choose the sort column and sort order. 

5. Add more levels (or delete levels) as required. 

6. When you click the OK button at the bottom of the window, your data will be sorted. 

Note that the Sort function is also available from the Data ribbon. 

13.4.2 Filter 

The filter function lets you view just the records that you want to see! The other records in your 

data table will still be there, but hidden. To use this amazing function: 

1. On the Home ribbon, select Sort & Filter, and select the Filter option. 
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2. In the first row of your data table, a drop-down arrow will appear on the right of each 

column heading. When you click on a drop-down arrow, you’ll see a list of all the 

values occurring in that column. Press [ESC] to close the filter list. 

 

3.  If you want to view records with a particular value only, click to uncheck the Select 

All option, and then check one or more values that you want to view. Click the OK 

button. (The example above has already been filtered on Product, Delivery month and 

Customer Type, and is about to be filtered on Discount as well.) 

4. All rows that do not contain the value(s) you checked, will be hidden from view. A 

column that has been filtered will show a funnel icon next to the drop-down arrow on 

the heading. 

5. Repeat the filtering process for as many columns as you need. You can remove a 

column filter by checking its Select All option. 

To clear your previous filter settings, select Sort & Filter, and then Clear. 

 

To turn off filtering, select Sort & Filter, and then Filter (the same option that you originally 

used to turn it on). 

Note that the Sort function is also available from the Data ribbon. 

13.4.3 Subtotals 

If your data table includes a column with categorical data (such as month, department, region, 

etc), then you can easily obtain subtotals of numeric values (such as sales, salaries, rainfall). 

1. First sort your data on the column that contains categorical data for which you want 

subtotals calculated. 

2. Click the Subtotal button on the Data ribbon. The Subtotal window will appear. 
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3. In the At Each Change In field, select the column with categorical data that was used 

for sorting. 

4. The Use Function field allows you to choose from a range of functions such as sum, 

average, count, etc. 

5.  Check under Add Subtotal To to identify the columns for which you want subtotals to 

be calculated. 

6. Click the OK button. The screen display will show three outline levels on the left of the 

data window. 

a.  Level 1 shows the overall grand total only. Click on the “+” icon or on the level 

2 button to see subtotals. 

 

b. Level 2 shows the requested subtotals only. Click on a “+” icon to see the 

records within one category, or click on the level 3 button to see all records. 

 

To remove subtotals, click the Subtotal button on the Data ribbon, and then Remove All. 
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Unit- 14 

Getting Started with MS PowerPoint- I 

 

14.1 Learning Objectives 

At the end of this unit, you should be able to: 

 Understand the basics of MS Poweroint. 

 Create a new presentation. 

 Enter text into slides. 

 Add Clip Art to a slide. 

 Edit slide text. 

 Format text slides. 

 Edit a powerpoint slide. 

 Apply indents in the powerpoint slide 

14.1 Microsoft Office PowerPoint 

"PowerPoint" refers to Microsoft PowerPoint, a program that allows the user to design a 

presentation that consists of multiple slides. These slides may contain images, text, video clips, 

and related types of information. PowerPoint is useful for delivering a speech, because the user 

can utilize text on the screen to remind him or herself of the information to be conveyed to the 

audience or to summarize his/her dialogue into more manageable and "friendly" sizes, as well 

as to entertain or explain graphs, charts, and related data. 

14.1.1 The Basics: Creating and Editing a Presentation 

14.1.1.1 The PowerPoint Window 

1. Title Bar - Displays the name of the application followed by the title of the presentation 

2. Formatting Toolbar - Provides quick access to commands you need for formatting 

3. Outline and Slides Tab - The slides tab gives you a thumbnail view of all the slides in 

the presentation and allows to rearrange their order; the outline tab adds textual content 

to the slides in an outline format 

4. Slide Pane - Area where you build the slides for your presentation 

5. View Buttons - Change the way you view the presentation; the Normal view (left 

button) is the default, the Slide Sorter view (center button) shows you only the 
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thumbnails and is used to sort and rearrange the presentation, and the Run view (right 

button) runs the presentation from the current slide 

6. Drawing Toolbar - Provides all the tools you need to draw and format objects 

7. Notes Pane - Adds notes for yourself for each slide in your presentation 

8. Task Pane (Windows version) - Varies based on what you are currently working on; 

when you first start PowerPoint, you see the New Presentation task pane; other possible 

tasks include Slide Layout, Slide Design, and Effects 

9. Menu Bar - Includes all of the PowerPoint menu choices 

10. Placeholders - Designate the space that will be filled with titles, text, or other objects 

such as graphics or charts 

11. Application Close Button (Windows Version) - Exits PowerPoint 

12. Presentation Close Button (Windows version) - Closes the current presentation 
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14.1.2 Create a New Presentation 

14.1.2.1 Using the AutoContent Wizard 

1. If necessary, chose File > New to display the New Presentation pane 

2. On the New Presentation pane, click on the AutoContent Wizard link 

You will be walked through a series of questions about the presentation you are making, 

including a category for the type of information being presented and the method of delivery. 

The Wizard then applies a background and text as well as an outline of text you may use as a 

guide. This is the preferred method for creating a presentation in the least of amount of time. 

14.1.2.2 Using a Design Template 

1. If necessary, choose File > New to display the New Presentation pane 

2. On the New Presentation pane, click on the From Design Template link 

3. The Slide Design pane will display on the right side of the screen with a variety of 

different templates to choose from 

4. Select the design of your choice from the Slide Design pane. 

5. Click OK to begin working with the first slide in the Normal View. 

14.1.2.3 Using a Blank Presentation 

1. If necessary, chose File > New to display the New Presentation pane 

2. On the New Presentation pane, click on the Blank Presentation link 

This will open a new presentation with no template. You will provide the content, background, 

color scheme, text format, etc. This method gives you the most freedom, but also requires the 

most amount of time to complete. 

14.1.3 Adding a new slide 

Once you have opened a new presentation, the next step is to add and format the content. 

PowerPoint provides a selection of pre-defined slide layouts based on different types of content 

that you can use to quickly add content to the slides. For each of the 27 Slide Layouts provided, 

PowerPoint combines the four types of placeholders in different combinations; each 

placeholder will be replaced with the following type of content: 
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Using a Slide Layout ensures that the text and other elements you enter into the placeholders 

will have consistent spacing and be optimally arranged. 

14.1.3.1 How to Add Slides to a Presentation 

1. Click the New Slide button on the Formatting toolbar. 

2. From the list of Slide Layouts, select the layout you want to apply to the new slide. 

3. You may now begin adding content using the placeholders in the layout. 

14.1.3.2 How to Change the Layout for any Slide 

PowerPoint will try to guess what layout you want to use for new slides that are added to the 

presentation. If you want a different layout for the slide you can quickly change the layout for 

any slide. 

1. Display the slide that you want to change in the Slide Pane (work area in the center of 

the window). 

2. Choose Format > Slide Layout to display the Slide Layout task pane. 

3. Click on the layout you want to apply to the slide. 

4. PowerPoint will attempt to fit existing content into the new layout, but you will 

probably have to make additional changes. 

14.1.3.3 How to Add Slides in the Outline Tab 

You can also create new slides while working in the Outline tab. By default the Outlining 

toolbar should display, but if it does not, select View > Toolbars > Outlining. 

1. Display the Outline tab by clicking on Outline in the pane on the left. 

2. Place the cursor at the end of the text in the slide you wish the new slide to follow. 

3. Click the New Slide button to insert a new slide. 
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14.3 Entering Text on a Slide 

14.3.1 Enter Text on a Slide Using Placeholders 

1. Click on the Title, Subtitle, or Text placeholder. 

2. Type the text you want. 

3. If necessary, press [Return] or [Enter] to move to a new line. 

4. Click anywhere on the slide outside of the placeholder to deselect it. 

14.3.2 Enter Text Using the Outline Tab 

Working in the Outline Tab allows you to type and edit text for the presentation in a more word 

processing-like environment than the Slide pane. The Outline tab displays in the pane on the 

left side of the screen when you are working in the Normal view. 

Information in the Outline tab is arranged by levels. The Title of each slide appears as the first, 

left-most level next to a numbered icon of the slide. Bulleted text is indented one to four levels 

to the right of the title. The Outline tab has an Outlining toolbar that displays to the left of the 

pane. 

Tip: If the Outline and Slides panes are not displaying in the Normal view, select View > 

Normal (restore panes) and it will display on the left side of the screen. 

1. After adding a new slide, Type the slide title and press [Return] or [Enter]. 

2. To change the slide text to a first level bullet, press [Tab] or click the Demote button 

on the Outlining toolbar. 

3. Type the text for the first bullet and press [Return] or [Enter] to move to the second 

bullet. 

4. To create a sub-bullet, press [Tab] and type the text. 

5. Continue to enter text for bullets and sub-bullets until the slide is complete. 

a. Use [Return] or [Enter] to create a new instance of the same level you are on. 

For example, if you are typing a level one bullet, pressing [Return] or [Enter] 

will create another level one bullet. 

b. To demote a line of text, use [Tab] or the Demote button. This will make a level 

one bullet into a level two sub-bullet. 

c. To promote a line of text, press [Shift] and [Tab] together or click on the 

Promote button. This will turn a level one bullet into the Title of a new slide. 

14.4 Adding Clip Art to a Slide 

Effective visuals emphasize the key content points in a presentation. PowerPoint provides a 

selection of professionally designed pictures, or clip art, that you can use in your presentations. 
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These clip art images include many different themes such as animals, people, buildings, food, 

holidays, business, and more. 

14.4.1 How to Insert a Clip Art Image 

1. Move to the slide on which you want to place clip art. 

2. Apply a Slide Layout that includes a content or clip art placeholder. 

3. Open the Select a Picture dialog box by: 

 Clicking on the Clip Art button on the content placeholder OR 

 Double-clicking on the clip art placeholder 

4. In the Search box, type a word or phrase that describes the clip you want. 

5. Click Search. PowerPoint displays the search results in the Select Picture List. 

6. Click on the clip art image you want and click OK. 

14.4.2 How to Resize a Clip Art Image 

Once you have added a clip art object to your slide, you can resize it to make it fit better into 

your presentation. 

1. Click on the Clip Art object to select it. 

2. Put the arrow on one of the resize handles at the corner of the picture until the cursor 

changes to a double-headed arrow. 

3. Depress the mouse button and drag the handle toward or away from the center to make 

the image larger or smaller. The corner handles resize the image proportionally and the 

handles on the sides of the image increase or decrease the height or width of the image. 

When you release the mouse button, the object appears in its new size. 

14.5 Editing Slide Text 

You know how to enter text into your presentation, but what happens if you decide you want 

to change the text? PowerPoint allows you to navigate to a specific slide and change the text. 
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14.5.1 Navigate in a Presentation 

 

14.5.2 Selecting Text 

Knowing how to select text is a critical skill in all Microsoft Office applications. Selecting text 

is a necessary step for many procedures such as deleting blocks of text or formatting. 

 

14.5.3 How to Edit Text in a Slide Pane 

You can edit text or move bulleted text in the Slide pane or the Outline tab. To edit text in the 

Slide pane: 

1. Select the bulleted text you want to change. 

2. If necessary, edit the text by: 

 Pressing the [Delete] key to delete the text; or 

 Typing new text to replace the selected text. 

1. If necessary, move the bulleted item by: 

 Selecting the entire bulleted item; and 

 Dragging the item up or down to move it to its new location. 

14.5.4 Move Bulleted Items in the Outline Tab 

You can change the order of bulleted items and slides in the Outline tab: 

1. Select the slide or bulleted item you want to move. 

2. Click the Move Up or Move Down button on the Outlining toolbar until the slide or 

bulleted item appears where you want it. 
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14.6 Formatting Text Slides 

14.6.1 Apply Character Formats 

You can use character formatting to add interest to presentations, but do so sparingly. Keep in 

mind that adding too much character formatting can detract from your message or make it 

confusing. 

14.6.1.1 Format Text 

You can change the appearance of text by changing its font, size, style, and color. You can 

format text in the Outline tab or the Slide pane. To format text: 

1. Select the text you want to format. 

2. To change the font, select a new font from the Font drop-down list on the Formatting 

toolbar. 

3. To change the size, select a new size from the Size drop-down list on the Formatting 

toolbar. 

4. To change the style, click the Bold, Italic, or Underline button on the Formatting 

toolbar. 

5. To change the color, select a new color from the Font Color button's drop-down palette. 

(The Font Color button is on the Drawing toolbar). 

14.6.1.2 Repeat Formatting 

When you format text in a slide, you can press the [F4] key to repeat that format for newly 

selected text. If you use the toolbar to apply more than one format, PowerPoint will repeat only 

the last format you applied. 

14.6.2 Align Text 

Alignment determines the position of the text within its text object box on a slide. Text can be 

left-aligned, right-aligned, centered, or justified, as follows: 

1. Select the text you want to align. 

2. Choose Format > Alignment to display the Alignment sub-menu. 

3. From the sub-menu, select the alignment option you want: 

 Align Left - aligns text at the left edge of the text object box. 

 Center - aligns text between the left and right edges of the text object box. 

 Align Right - aligns text at the right edge of the text object box. 

 Justify - begins text at the left edge and ends the text at the right edge of the text 

object box. 

You can also use the Alignment buttons on the Formatting toolbar to left-align, center, and 

right-align text. 
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14.6.3 Line Spacing 

Line spacing is the vertical distance between two lines of text. By default, line spacing is set to 

single-line spacing, which means that the amount of space between lines of text depends on the 

size of the font used. For example, if the font size is 12, then single-line spacing will be 12 pts 

between lines of text. If you applied double-line spacing, then the lines would be separated by 

24 pts of space. 

14.6.3.1 Setting Line Spacing 

1. Place the cursor in a paragraph, or select the paragraphs you want to affect. 

2. Choose Format > Line Spacing. 

3. In the Line Spacing dialog box, click on the arrows to increase or decrease line spacing 

options, or enter an exact setting. 

4. Click OK. 

14.6.3.2 Line Spacing Options 

In the Line Spacing dialog box, there are three options for changing the amount of space 

between lines and bullet items on a slide. 

 Line Spacing - the amount of space between selected lines of text. By default, line 

spacing is set to 1. 

 Before Paragraph - increase or decrease the spacing before the first line of each selected 

paragraph. 

 After Paragraph - the amount of space after the last line of each selected paragraph 

14.7 Indents 

In PowerPoint, indents are used to align bullets and text at a set distance from the margins. 

When the horizontal ruler in PowerPoint is displayed, you will find one set of the following 

indent markers on the left edge of the ruler for each level of bullets on the slide: 

14.7.1 Indent Marker Types 
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14.7.2 How to Change Indents 

1. Select the text object that you want to affect. 

2. Choose View > Ruler to display the ruler. 

3. To adjust the first-line indent, click and drag the upper marker for that indent to a 

desired position on the ruler. 

4. To adjust the subsequent lines in a paragraph, click and drag the upper marker for that 

indent to a desired position on the ruler. 

5. To maintain the relationship between the first line and the rest of the paragraph (to move 

both markers at once), click and drag the bottom half of the lower marker to a desired 

position on the ruler. 
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Unit- 15 

Getting Started with MS PowerPoint- II 

 

15.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Apply spell check to a presentation. 

 View the slideshow. 

 Arrange slides for presentation. 

 Add Transitions to a Slide Show. 

 Animate text in powerpoint slides. 

 Print slides. 

 Create a Custom Design Template. 

 Insert Graphics. 

 Add Footers. 

 Modify the Slide Master Font. 

15.1 Introduction  

After adding all of the content to a presentation, it is time to put the finishing touches on it. 

There are multiple ways to check for spelling errors, inconsistencies, or other problems. There 

are also several ways to enhance the presentation. 

15.2 Spell Check a Presentation 

15.2.1 AutoCorrect 

Autocorrect corrects many common spelling errors automatically as you type. It is similar to 

the version used in Microsoft Word. Autocorrect fixes spelling errors as well as instances such 

as double capital letters at the beginning of a word, capitalizing the days of the week and the 

first words of a sentence. Common typing mistakes such as letter transposition are also 

automatically corrected as you type. 

There may be times when you do not want Autocorrect turned on. To access options for 

Autocorrect, go under the Tools menu and choose Autocorrect Options. Each function in 

AutoCorrect can be selected or deselected by clicking in the check box associated with each 

function. 
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15.2.2 Spellchecking a PowerPoint Presentation 

PowerPoint provides you with a powerful spellchecker that works in the same fashion as the 

one in Microsoft Word. As with that spellchecker, it's always a good idea to proofread your 

presentation yourself; however, the spell checker can sometimes be a lifesaver. 

To check an entire presentation, don't select any text. If you run the spellchecker with specific 

text selected, it will only check that text. You don't have to click the insertion point at the 

beginning of a presentation to begin spellchecking, as the spellchecker will wrap around until 

it has checked the entire presentation. 

There are four ways to access the spellchecker: 

 In the Tools menu, choose Spelling. 

 Click the Spelling button on the Toolbar. 

 Press [F7]. 

 Right-click on a flagged spelling error and choose Spelling. 

Once the spellchecker is running, you can use the various options to help you find and correct 

spelling errors in your presentation. PowerPoint's spellchecker compares words with its internal 

dictionary. If PowerPoint does not recognize a word, there are several options you can have it 

perform, as described below: 

• If the correction you want is already highlighted in the Suggestions list box, click 

Change. 

• If the correction you want is in the Suggestions list box but not highlighted, select that 

word and click Change. 

• If the correction you want is not suggested, you can type the correction in the top text 

box and click Change. 

• You can click Change All to automatically correct any further occurrences of the 

particular spelling error. 

• If the spellchecker comes across a word that has been repeated, you can click Delete to 

delete on of the instances of a word. 

PowerPoint can check your spelling as you type. If it thinks you've misspelled a word, 

PowerPoint lets you know by drawing a wavy red line under the word. To correct one of these 

errors, right-click on the erroneous word and either choose one of the suggested changes or 

open the Spell Check dialog box and make the change there as described above. 

15.3 View the Slide Show 

While putting together a PowerPoint slide show, it is often useful to actually run the show to 

see what it will really look like when it is presented to an audience. This can provide a "reality 

check" and give a better idea of how the show is actually going to look. 
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15.3.1 Slide Show View 

Use the Slide Show view to see the slide show on your computer screen one slide at a time, 

using the full screen, as you will when actually presenting the show. You can move the 

subsequent slides by either clicking your mouse button, clicking the [Page Up] and [Page 

Down] buttons, or by using the left and right arrow keys on your keyboard. 

To view the Slide Show: 

1. When you use the Slide Show view button, PowerPoint starts the show at the currently 

selected slide. So, go to the first slide in your presentation. 

2. Click the Slide Show view button. 

3. To move to the next slide, click the mouse button or push the right arrow key. At the 

end of the show, PowerPoint will display, "End of slide show, click to exit". 

4. You can exit a slide show at any point by pressing the [Esc] key. 

5. When you exit a slide show, PowerPoint returns to Normal view. 

15.4 Arrange Slides in a Presentation 

The ability to reorder slides in a presentation after you've created them enables you to easily 

reorder slides after you've created them, as well as giving you the freedom to organize a new 

presentation out of an older one. This can be essential in using the same material for different 

audiences without having to recreate and entire slide show presentation. PowerPoint also lets 

you hide selected slides in a presentation, in case you want to reuse a slide show 

for an audience and omit certain parts of the presentation that don't apply to that particular 

presentation. 

15.4.1 Slide Sorter View 

Choose View/Slide Sorter, or click on the Slide Sorter view button. PowerPoint changes to the 

Slide Sorter view and opens the slide sorter toolbar. 

In Slide Sorter view, you see the thumbnail representations of the slides comprising your slide 

show. This is a great way to see the whole presentation at once, in the order in which they will 

appear in the slide show. After you are finished creating and editing your presentation, you can 

come to Slide Sorter view to shuffle slides around, and copy, delete, or hide slides, until you've 

got it right. Slide Sorter view also allows you to set up special effects to the slides in the 

presentation. 

As you look through your slides in Slide Sorter view, and find a slide that you need to further 

edit, just double-click on that slide and it will be displayed in Normal view. 
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15.4.2 Rearranging Slides in Slide Sorter View 

1. You can often make a presentation better by playing with the order in which the slides 

appear. Sometimes, you may wish to entirely hide a slide that doesn't apply to your 

audience. All of this happens in Slide Sorter view. To rearrange slides in Slide Sorter 

view: 

2. Click on the Slide Sorter view button (or choose View/Slide Sorter). 

3. Click on the slide you wish to move, copy, delete, or hide to select it. 

4. Now move, copy, delete, or hide the slide: 

o To move a slide, press and hold the mouse button, drag the slide to where you 

want it to go, and release the mouse button. 

o To copy a slide, press and hold the [Ctrl] key and drag the slide to where you 

want it to go. 

o To delete a slide, press [Delete] or [Backspace]. 

o To hide a slide, right-click in the slide thumbnail and choose Hide Slide. 

15.5 Adding Transitions to a Slide Show 

One way to add a nice touch of professionalism to a slide show is to add transitions to the 

slides. Transitions affect the way one slide goes to the next slide. Transitions add interest to 

your slide show, but care should be taken to be sure they do not become a distraction from the 

show itself. It is often best to choose one transition you like and use it for the entire slide show. 

15.5.1 Slide Selection in Sorter View 

In Slide Sorter view, you can select one slide, two or more slides that are next to each other, or 

two or more slides that are not next to each other. 

 

15.5.2 How to Set Transition Effects 

For each slide in a presentation, you can set a different transition effect and determine how fast 

the transition will happen. To set transition effects: 

1. Switch to Slide Sorter view. 

2. Select the slides to which you want to assign a transition. 

3. Choose Slide Show/Slide Transition or click the Transition button on the Slide Sorter 

toolbar to open the Slide Transition task pane. 
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4. From the Apply to Selected Slides list box, select the transition effect you want to apply. 

PowerPoint previews the effect on the selected slides and displays a Preview Animation 

button beneath each selected slide. 

5. In the Modify Transition section, select a speed (Slow, Medium, or Fast) for the 

transition effect. Once again, PowerPoint previews the effect on the selected slides. 

6. To preview the effect again, click the Animation Preview button beneath the slide on 

the left side. 

7. Close the Slide Transition pane. 

15.6 Animating Text 

Normally, when you have a slide with multiple bullets, PowerPoint will display all the text 

bullets at once when you go to that slide during a slide show. One nice effect, however, is 

having the different bullets appear as you speak about them, one at a time. This can be 

accomplished by using PowerPoint's animate text feature. 

Animation of text in PowerPoint refers to the manner in which individual text or other objects 

appear as they enter or exit a slide. Normally, all objects on a slide appear at the same time 

when you display the slide. However, you can have different objects appear and exit at different 

times under your control as the show proceeds. To add animation to text in a presentation: 

1. In Normal view, select a line of bulleted text. 

2. Choose Slide Show/Custom Animation to open the Custom Animation task pane. 

3. Click the Add Effect button to display the drop-down list. 

4. From the Entrance sub-menu, choose the animation effect of your choice. You can 

choose More Effects if the effect you want isn't listed. PowerPoint displays the 

animation effect in the list box on the Custom Animation task pane. 

5. In the Modify section, set the direction and speed. 

6. Close the Custom Animation task pane. 

15.6 Printing Slides, Speaker Notes, and Handouts 

PowerPoint enables you to easily print handouts, slides, and your own speaker notes that you 

can reference while giving a presentation. 

15.6.1 Handouts 

You can use PowerPoint to create handouts of the slides in your presentation. You can decide 

how many slides you wish to appear on a page. Usually, it is best to have no more than 4 in 

order that they remain readable. You can choose layouts from the Print dialog box right before 

you print. PowerPoint automatically formats everything for you. 
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15.6.2 Print Options 

There are many options for printing your presentation. You can print slides, notes pages, 

handout pages, or outlines. You can print the current slide, or select a range of slides to print. 

You can also select other print options. To print various things from PowerPoint: 

1. Choose File > Print to display the Print dialog box. 

2. Under the Print What heading, select the type of printout. 

3. Select any other options you want. 

4. Click OK. 

15.7 Creating a Custom Design Template 

While PowerPoint offers a nice variety of design templates, it is also useful at times to create 

your own. A design template, once created, can be used over and over again. For instance, if 

your department wanted all presentations to include your company's logo in one corner, with 

its colors as the background, you could create a design template with these features and reuse 

it again and again. 

15.7.1 Master Slides 

A master slide is one that is a part of every presentation that controls certain text characteristics 

such as font type, size, and color, as well as background color and style. Masters can affect all 

the slides in a presentation. There are masters that control the title slide, notes pages, and 

handout pages. When you apply a template to a presentation, you apply a new set of masters 

that control the presentation's look and format. There are four types of masters used in 

PowerPoint, as described below. 

 

15.7.2 Slide Background 

A slide background is a design element that appears behind the contents of the slide. The slide 

background is made up gradient, texture, patterns, or a picture. To change the slide background: 

1. Select the slide you want to change: 

a. Select a slide in Normal view. 

b. Select the Slide Master. 
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2. Choose Format/Background. 

3. In the Background Fill section, click on the drop-down arrow and choose Fill Effects. 

4. On the Fill Effects dialog box, select the tab that contains all the options you want to 

set and click OK. 

5. Click Apply to All. 

The following table describes the options you can set in the Fill Effects dialog box. 

 

15.8 Inserting Graphics 

One element you can add to every slide is a graphic of some sort. To add a graphic to one or 

all slides: 

1. Display an individual slide or the Slide Master for all slides. 

2. Choose Insert > Picture > From File. 

3. Navigate to the folder that contains the picture that you wish to insert. 

4. Select the picture file. 

5. Click Insert. 

PowerPoint alllows you to insert most popular graphic formats into your presentation. 

15.9 Adding Footers 

Footers serve many uses in PowerPoint presentations. You can use them to provide information 

like slide numbers, footer text, and date. All of the information goes at the bottom of each slide 

in your design template. 

15.9.1 Components of a Footer 

A footer in PowerPoint is text that you create once, but it appears on the bottom of each slide. 

It can consist of text, slide numbers, and a date. To add a footer: 

1. Display the Slide Master. 

2. Choose View > Header and Footer. 

3. In the Date and Time section, select the options that you want. 

4. Check the Slide Number box to add a number to each slide. 
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5. Under the checked Footer check box, click in the text box and enter the footer text. 

6. Click Apply To All. 

15.9.2 Formatting a Footer 

You can change the way a footer looks at any time. On the Slide Master, select the placeholder 

that contains the information you want to change and format the text as you would any normal 

text. You can also drag the placeholder around if you wish to change its location. 

15.10 Modify the Slide Master Font 

PowerPoint allows you to change the way that the text in each individual part of your 

presentation looks. If you have a very long presentation, for example, but decide that you no 

longer like the font for each title, PowerPoint makes it easy to change the font for each title at 

once. To change the appearance of the Slide Master text: 

1. View the Slide Master. 

2. Select the text you want to change. 

3. Change the font to a different font. 

4. Change the font size. 

5. Apply a text effect, such as bold. 

6. Return to Normal view. 

15.11 Some Tips for Effective Slide Shows 

Here are a few tips that will help your PowerPoint slide shows look professional and promote 

effective visual clues to help you get your points across: 

1. Limit animation. 

2. Stay with one slide transition. 

3. Use sans-serif fonts. 

4. No tiny font sizes; remember the folks in the back row. 

5. Keep your slides simple and uncluttered 

6. If you are presenting in a light room, use a light slide background. 

7. If you are presenting in a dark room, use a dark slide background. 

8. Make sure to use high-contrast text and slide backgrounds. 

15.12 Glossary 

 Ask A Question Box - Provides quick access to help. 

 AutoContent Wizard - A wizard that produces a presentation with a general structure 

and suggested topics based on options you choose regarding the presentation output. 

 AutoCorrect - Corrects capitalization, grammar, and spelling errors automatically as 

you type. 
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 AutoShapes - Ready-made shapes you can draw on the slides in your presentation by 

choosing a shape from the AutoShapes drop-down menu. 

 Clip Art - Professionally designed images that you can add to documents. You can 

change the size, appearance, and location of clip art after it has been inserted into a 

document. 

 Design Template - The background, fonts, bullets, formatting, and color scheme that 

you can apply to define the 

 look of your presentation. 

 Expanded Menu - A menu that displays both common and less-common commands 

after you pause the mouse pointer over it. 

 Floating Toolbars - Toolbars that are not attached to the edge of the program window. 

 Indents - Used to align bullets and text on a slide. 

 Line Spacing - The vertical distance between lines of text. 

 Normal View - The view you use to create and edit your presentation. It consists of 

three working areas: the Outline and Slides tabs, the Slide pane, and the Notes pane. 

 Notes Pane - In Normal view, the Notes Pane is used to create notes for each slide in 

your presentation. 

 Outline and Slides Tabs - One of the panes in Normal view, you use the Outline and 

Slides tabs to toggle between an outline of the text in your presentation and a thumbnail 

view of each slide. 

 Presentation - An interaction between a speaker and an audience. A presentation usually 

includes one or more visual aids: in the case of PowerPoint, these are slides. 

 Sizing Handles - Small circles or squares that appear along the border of a selected slide 

or object. 

 Slide Pane - In Normal view, the area in the center of the application window where 

you create and format your slide content. It displays the current slide. 

 Slide Sorter View - All slides in the presentation are displayed at once on the screen. In 

this view, you can rearrange, copy, and delete slides. 

 Task Pane - Provides quick access to commands related to your current task. 

 Transition Effects - In a slide show, a transition determines how the display changes as 

you move from one slide to the next. 

 WordArt - A tool you can use to create unique text effects. Text objects you create with 

read-made effects to which you can apply additional formatting options. 

15.13 For More Information... 

We recommend: 

 The Help menu built into PowerPoint. 
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o Press the [F1] button in Windows. 

o From the Help menu,select from options to view the PowerPoint help contents, 

search PowerPoint help, or connect to other help sources. 

 Free Microsoft Help and Support available online at [1]. 

o Topic specific FAQS. 

o Downloads & Updates. 

o Links to additional resources. 

 Also available from Microsoft, the new Office Online website offers tips and assistance 

on office products including PowerPoint. Explore this at [2]. 
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Unit- 16 

Basics of Computer Networks 

 

16.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Describe the various uses of telecommunications. 

 Evaluate the different communication media. 

 Define a network. 

 Describe and illustrate the various types of networks. 

 Describe types of networks. 

16.1 Introduction 

This unit is an interesting, but technical one where the discussion expands to the connection of 

more than one computer to meet various needs. It also discusses how these computers can be 

connected and the accompanying reasons or purpose for their connections. The popular topic 

of the Internet is also introduced with its intriguing services and benefits, and the different 

methods of connecting to the world wide web. 

Computers are linked together to exchange data and share resources as said to be networked. 

Networks allow users communicate with others once there is access to a computer. Networks 

come in a variety of forms and support a variety of different asynchronous and synchronous 

communications methods. 

16.2 Communications 

In our day to day lives we regular communicate with others through talking, writing, and 

actions. Computer networks communicate by first becoming linked to each other, so that data 

and resources can be shared. For example, two or more computers can be connected to each 

other, along with one printer (a resource), so that each computer is able to print form this one 

printer. This is known as a simple network and you are sharing output devices via the network. 

Computer communication is achieved when signals are sent and received among and between 

different computers. This exchange of signals allows users to collaborate with other online 

users in different countries. Individuals can share and retrieve information and files they can 

exchange electronic mail and participate in electronic messaging with others from all over the 

world. 
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16.2.1 Collaboration and Sharing 

Computer communication has provided contact among users from different cultures, 

continents, and time zones. Indeed, telecommunications technologies such as land lines, 

satellite, cable, the Internet and cell phone technology have made communication possible and 

affordable over long distances. Many business organizations and individuals have taken 

advantage of teleconferencing and videoconferencing – conferencing available on the Internet, 

and through you telephone, cable and satellite providers. Today people do not have to travel 

for meetings or conferences. Telecommunications technologies allow employees to work from 

home, or away from the office, while still interact with the others in the company through 

computer communications. They are able to send and receive documents, share schedules, send 

messages and talk directly with their co‐workers. This ‘work away from the office, is known 

as telecommuting. 

16.3 Transaction Processing 

In previous years data and information were stored in a central location, and many users would 

simultaneously access this single location to retrieve data required for a transaction, or other 

reasons. This caused problems, as not everyone was able to access data in a timely fashion. 

Large numbers of requests to a central processor or storage location takes time taken to send 

and retrieve the large or small amounts of data or information. The volume of data moving 

through the system often slowed the system down and at times even crashed or shut down the 

system. With computer communication systems now available, data and information (and 

indeed the workload) can now be dispersed (or distributed) to various sites, subsidiaries or 

branches of the business in other areas of the building or country. 

Indeed many large corporations link some parts of their systems with the systems of their major 

customers. This inter‐organizational system link also allows the corporation’s systems to link 

to suppliers for electronic data interchange (EDI). This facilitates speedy order processing and 

other transaction processing. 

16.4 Information Retrieval 

Information retrieval is important for decision making in business, industry, research 

organizations, and even for entertainment. Various types of information (such as music, text, 

sound) can now be stored in private or public databases. Once these databases are made 

available online, they can be accessed by select persons either through the use of the Internet, 

or an internal company network, called an Intranet. 

16.5 Electronic Mail and Electronic Messaging 

Electronic mail and electronic messaging are one of the most popular methods of 

communicating among persons of all ages. Messaging includes text messaging using cellular 
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phones, online messaging using programs such as MSN and Google talk. Paging, sending and 

receiving sending faxes and the use of voice mail are also methods of electronic messaging. 

Electronic mail (e‐mail) and online messaging also enables persons to send and receive 

softcopy documents as attachments. 

16.6 Efficient and Effective Communication 

In order for computer communication to be effective and efficient, many agencies must be 

involved. These include the telecommunications telephone, cable and satellite companies in 

the various countries, as well as the many Internet Service Providers who provide access to the 

Internet. Indeed the number of businesses that are involved in the operation and management 

of Information and Communications Technologies (ICTs) include: software providers; 

hardware providers; custom development companies; online communications and 

collaboration companies; and others. Finally governments must create legislations that governs 

the access to data and the use of data and provides oversight of the telecommunications 

industry. 

16.7 Connecting Computers 

This Topic is a bit technical as it describes the media that are used to connect computers 

together in order to share data and peripheral devices. There are also different ways in which 

computers are connected and it discusses the advantages and disadvantages of each. The Topic 

also includes a brief discussion on the services and benefits of the Internet, and the various 

methods for connecting to the world wide web. 

16.7.1 Communication System Components 

Wired or wireless media are used to allow communications among computers. Wired media 

include twisted‐pair, coaxial and fibre optic cable. Twisted‐pair cable and coaxial cable 

transmit data by means of electric frequencies. These cables therefore need to be protected 

against water and electromagnetic waves. Fibre optic cable is an improvement on the previous 

two cables. A fibre optic cable consists of glass or plastic tubes which transmit data over longer 

distances at a faster speed, using reflection of light. Fibre‐optic cables are more secure and 

much thinner and lighter than other metal wires, and they are not affected by electromagnetic 

noise such as radios, motors and others cables. Although fibre‐optic cables are very costly and 

difficult to install, they are extremely popular with telephone companies, banks, and television 

companies replacing their existing telephone and coaxial cables with more efficient fibre‐optic 

cables. 

As the term implies, wireless media in a telecommunications network connects nodes without 

the use of wires. Wireless network systems incorporate cellular technology which uses 

satellites, radio and other signals, to allow for communication over land and sea across the 
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world. Wireless networks are very useful in sending and sharing data quickly within small 

offices or among business across the world. More importantly they are relatively inexpensive 

in connecting to the Internet, especially in countries where there are scarce resources or poor 

infrastructure. Wireless networks therefore eliminate the maze of cables, while offering more 

mobility. However the disadvantage of wireless media is interference from other networks that 

might block the radio signals from passing through. 

16.7.2 Network Topologies  

The physical layout of a network is called a topology. The four main topologies will be 

discussed in this section. A network is a collection of computers which are connected together. 

When sketching the topology, each computer workstation, file server or other peripheral is 

generally called a node. A network topology therefore, is the arrangement of the network, 

whether physically (the actual layout including cable installation), or logically (the actual 

operation of transferring data), according to the requirements of the network. This Topic will 

discuss four general network topologies. 

16.7.2.1 Bus Topology 

 

Figure 29: Bus Topology 

This linear bus topology is one of the simplest of the four network topologies to use, in its most 

basic form it is simply a case of running one cable called a backbone, from the computer or 

peripheral device at one end of the network to the last peripheral device or computer at the 

other end. Other computers, scanners, printers or other peripheral devices are then attached to 

the backbone anywhere between these two end computers. 

Advantages and Disadvantages of Bus Topology 

Of course from the simple description above, it seems relatively easy to connect a computer or 

peripheral to this topology. It also requires less lengths of cable than the other topologies, so it 

can be economical. Since all computers and peripherals depend on this single cable or 

backbone, the entire network will not work if there is a break in the backbone. This will also 

prove difficult to identify where the problem or break is located, if the entire network is not 

working. This topology is also not intended to be used as the only network arrangement where 



CVDMM(N) 202- Office Automation and Internet Skills  UOU 

Unit- 16: Basics of Computer Networks Page 169 of 207 

numerous computers and peripherals are to be connected. Finally it has the lowest fault 

tolerance, that is, a single problem in the network with a bus topology can halt all of its 

activities. 

16.7.2.2 Star Topology 

 

Figure 30: Star Topology 

A star topology connects computers and peripherals to a central device called a hub. Physically 

the topology looks like a star. So that when a node is sending data to another node, the data 

passes through the hub before continuing to its destination node. The hub therefore manages 

and controls the network. 

Advantages and Disadvantages of Star Topology 

A new node is relatively easy to install by adding a cable from the new device to the hub. 

Installing and even removing nodes do not cause any disruptions to the network, so this 

topology has high fault tolerance when troubleshooting to detect faults and to remove nodes. 

Of course if the hub fails, then all nodes attached to the network are disabled. It is also more 

expensive than the bus topology because of the cost of installing the cabling and configuring 

the hub. 

16.7.2.3 Ring Topology 

 

Figure 31: Ring Topology 
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The nodes in a ring topology are connected to the nodes on its left and right, so that data passes 

from one node to the next. Of course fault tolerance is non‐existent since failure of one node 

cripples the entire network. This is why the physical ring topology is rarely used. Adding a new 

device to an existing physical Ring network can be complicated as any new device needs to go 

in‐between the existing devices. 

16.8 Local Area Networks (LANs)  

A Local Area Network (LAN) is a computer network that functions within a specific 

geographical area, such as a building, school or campus. The network links the computers 

located within the building. In the case of a campus, the computers are linked throughout the 

various buildings using wired cables or wireless communication using radio and other signals. 

Access to the LAN is privileged and controlled by a network administrator. Once access is 

authorized, users can access most of the software, data, and peripherals connected to the LAN. 

The main uses of LANs include the sharing of expensive devices such as printers and scanners, 

as well as the provision of internal Intranet and electronic‐mail services. Public telephone 

exchanges such as PBXs are also examples of LANs which use telephone systems in many 

organizations. 

In order for a LAN to function, a network interface card (NIC) must be installed in the computer 

to provide the connection between the computer and the network. The main operating system 

software that supports networking are UNIX, Linux, Windows, and Mac OS. Two types of 

LANs are peer‐to‐peer and client‐server, which employ a bus or ring topology. 

16.8.1 Peer –to- Peer Networks  

All computers on a peer‐to‐peer network are configured similarly with no specific computer 

designated as a file server. Also the users in this type of network determine which files and 

peripherals attached to their computer that they wish to share. This is why peer‐to peer networks 

are simple to set‐up as home businesses, and are not appropriate when there are many 

computers. 

16.8.2 Client – Server Networks 

Client‐server networks can be set up using various topologies, and are appropriate in large 

corporations. The network requires file servers which contain the many application programs. 

The clients are the networked computers which access the server to obtain and use the 

programs, data, and to access peripherals. 

16.9 Metropolitan Area Network (MAN) 

A metropolitan area network (MAN) is a computer network that interconnects users with 

computer resources in a geographic area or region larger than that covered by even a large local 
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area network (LAN) but smaller than the area covered by a wide area network (WAN). The 

term is applied to the interconnection of networks in a city into a single larger network (which 

may then also offer efficient connection to a wide area network). It is also used to mean the 

interconnection of several local area networks by bridging them with backbone lines. The latter 

usage is also sometimes referred to as a campus network. 

16.10 Wide Area Network (WAN) 

Wide area networks (WANs) effectively connect LANs which are located at different 

geographical locations – a few miles or thousands of miles away. This way, a large corporation 

or banking institution can share, and exchange data and information, as well as perform 

transactions among its branches using one wide area network system. 

16.10.1 Internet Services and Benefits 

The Internet is a network of networks, which link local, regional, national and international 

computer networks to exchange data and process tasks. In order to efficiently process these 

tasks and exchange data, a standard called TCP/IP (Transmission Control Protocol/ Internet 

Protocol) comprises a set of rules which must be followed. The telecommunication links among 

the networks of the Internet are built and maintained by major telecommunications companies 

around the world. Each computer connected to the 

Internet is recognized by a unique number, officially known as an ‘IP Address’. Data travels 

the Internet from origin computer to destination computer in small chunks called ‘Packets’, 

with the help of ‘routers’. 

16.10.2 Connecting to the Internet  

Users can connect to the Internet through a dial‐up connection or other more sophisticated 

connections. Irrespective of how users connect, companies called Internet Service Providers 

(ISP) maintain telecommunications equipment so as to provide Internet access to individual 

users, as well as users involved in business and large organizations. An ISP is responsible for 

providing each user with Internet access by connecting your computer to the Internet, much 

like a telephone company connects your phone to the telecommunications network. 

To get access to the Internet, a user needs an optional local telephone number, a unique 

identification and password for access, and one or more email addresses. This is usually 

accompanied by a stipulated fee monthly, quarterly, yearly or simply a block of hours. 

16.10.2.1 Dial-Up Internet Connection 

A dial‐up connection requires a device called a modem, which converts your computer’s digital 

signals into a type of signal that can travel over phone lines. The maximum speed for dial‐up 

is 56Kbps, or 56,000 bits per second. 
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16.10.2.2 Other Internet Connections 

Other Internet connections provide data transfer speeds much faster than that of a dial‐up 

connection, although they both must be in close proximate to a telephone port. An Integrated 

Services Digital Network (ISDN) provides data transfer speeds of 128K, while a Digital 

Subscriber Line (DSL) is a general name for a family of high –speed Internet links, including 

ADSL, SDSL, and DSL lite. These provide data transfer speeds up to 125 times faster than 

dialup. 

16.10.3 Web Browsers 

Just as you would use a software program such as a word processor, web browsers are also 

software programs that are also installed on your computer. Their purpose however is to allow 

you to access one or more web pages. In simpler terms, a web browser is just a way to help 

you get around the Internet, so whenever you type in an address for distance education to access 

your notes, for example, you are using a browser. Browsers are also useful for downloading 

files from databases stored on the Internet, and linking you to other pages from a main home 

page. Each browser keeps a list of the pages you have viewed on the Web, so that you can 

return to that site, even if you visited it days ago. 

A typical web page contains mostly text, with some pictures, and even media such as movies 

or other small programs. Your browser translates the HTML language that was used to create 

each web page into a presentable form that users can understand. Figure 32 shows a typical 

browser while Figure 33 shows the html code that was used to create the web page. 

 

Figure 32: Web browser 
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Figure 33: HTML Code 

It is important that browsers provide efficient ways to manage bookmarks, cookies, tabbed 

browsing, pop‐up blocker as well as have ample security options. Users may even prefer auto‐

fill capabilities for web‐based forms. 

There are many different browsers available, although the popular one is Internet Explorer (or 

IE). However all browsers should be able to load web pages without much difficulty and at 

about the same speed. 

16.11 Search Engines 

Search engines access many web sites which match your request, and then show a list or sample 

of the web pages so that you can select those that you are interested in. generally, search engines 

carry out some of the following tasks. Gather a list of web pages: 

 Based on a user’s search for a word, phrase, web page or similar option. 

 Through listing each page that contains the search word or similar words. 

  If the search word is an embedded link on a web page, then the search engine peruses 

that link also. 

 Rank the search results by web pages that contain or link to that search term most 

frequently. 

16.11.1 Problems with Searching 

Search for a word or phrase in a browser window, will produce those web pages that are 

relevant to what you are searching for. However, words and phrases differ in context, so you 

may also see other listing which do not relate to what you need. In addition, you may also see 

duplicate listings since the search will list the web page with your search term, as well as all of 

the links from the same web page that also contain the search term. 
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16.11.2 World Wide Web Basic Terminology 

 

16.12 Summary 

The concepts in this unit include: 

 Computer networks communicate by first becoming linked to each other, so that data 

and resources can be shared. 

 Computer communication allows for collaboration among users in different countries, 

transaction processing, retrieval of data and information, electronic mail and electronic 

messaging from all over the world. 

 Wired or wireless media are used to allow communications among computers. 

 Wired media transmit data by means of electric frequencies. 

 Wireless media connects computers without the use of wires. 

 The physical layout of a network is called a topology. 

 Linear bus topology is one of the simplest of the four network topologies to use. 

 Star topology connects computers and peripherals to a central device called a hub. 

 Ring topology are connected to the nodes on its left and right, so that data passes 

 from one node to the next. 

 A Local Area Network (LAN) is a computer network that functions within a specific 

 geographical area, such as a building, school or campus. 

 Wide area networks (WANs) connect LANs which are located at different geographical 

locations. 
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 The Internet is a network of networks, which link local, regional, national and 

international computer networks to exchange data and process tasks. 

 Web Browsers are also software programs that are also installed on your computer. 

 Search engines access many web sites which match your request, and then show a list 

or sample of the web pages so that you can select those that you are interested in. 

In the previous units we explored the input, processing, storage and output of individual 

computers. This unit introduced communication among computers once they were linked 

together in different ways to form a network. It thus enabled the user to engage in 

telecommunication, teleconferencing and then telecommuting. In addition, access to data 

located on other computers, called servers, allowed for faster retrieval, and thus the 

introduction of electronic mail and electronic messaging, and the development of the Internet. 

Users are now able to search for any item whether it is a product, a plant or a planet! 
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Unit- 17 

Basics of Internet and World Wide Web 

 

17.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Explain the evolution of Internet 

 Explain world wide web 

 Setup and Internet connection 

 Compare different types of internet connections 

 Perform searching on the internet 

 Understand various applications of Internet. 

17.1 Evolution of Internet 

The internet has changed dramatically since its first incarnation. In 1969 the U.S. department 

of defense created ARPANET.  

 

Figure 34: ARPANET 

The original concept of this project was to connect researchers located in different places to be 

able to communicate and collaborate from far distances. The fear of nuclear attack was very 

prevalent at this time, so the team also wanted to make a network that could still operate after 

a nuclear attack. Therefore creating many different fail safes, and alternative routes for packet 

sending was necessary. As this project grew, more and more people gained access to the 

internet and began shaping it to what we know today. As we have described before, everyone 

who uses the internet is called an internet user. 
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For these users to obtain access to the internet, you must go through an ISP (internet service 

provider.) Side note, while the internet is not owned by any one company or government, it is 

most assuredly not free. It costs money to build, run, and maintain the servers that bring you 

the funny cat videos. 

Internet 2 is an amalgamation of different leaders in the field of academia, technology, industry, 

and government that formed together in order to collaborate on pioneering and innovative ideas 

that help advance education and research. They test new network applications and technologies 

using high-performance networks. Contrary to popular opinion, Internet 2 is not a gathering of 

minds who intend to replace the current Internet but congregate to ensure that the future Internet 

will be capable of operating with today’s engineering. Internet 2 is currently being upgraded to 

8.8 terabytes! This will aide in the ability to offer advanced telemedicine and long distance 

learning opportunities across connected countries through its network. 

17.2 The World Wide Web 

The World Wide Web is different than the Internet. The Internet started out being used more 

by private industries and people such as scientists, schools, and the government. The public 

had not used it for the most part because it was complex and you had to have a computer in 

order to access it, which not everyone did. In 1989 Tim Berners-Lee came up with the World 

Wide Web and thought it would be a good way to organize information and take place of the 

Internet. Although the Internet still stayed around, and still is today, the World Wide Web was 

a great tool for researches at the time. The World Wide Web is not owned by one single 

business or person, but the webpages are. The Web consists of things such as HTML, URL, 

and HTTP. HTML stands for Hyper Text Markup Language and is used for formatting 

documents on the Web. URL is the Uniform Resource Locator which most of us are familiar 

with when typing in addresses to websites. And lastly, HTTP is Hyper Text Transfer Protocol. 

This is what lets people click on hyperlinks and be redirected to that specific location. The 

World Wide Web has changed the way schools teach, businesses run, and average people have 

been able to access organized information. Pictures and documents are now easier to access 

and research and recreational websites can now be found in one place. 

17.3 Using the Internet 

17.3.1 Setting Set Up To Use The Internet 

Almost every household has access to the internet; therefore, it is important to know how to 

have access to the world wide web. There are five basic steps to set up an internet connection 

which consist of the following: 

1. One must connect the hardware. Different hardware and software contain directions in 

setting up. Use the directions to set up these systems. 
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2. The internet needs a wireless connection or an Ethernet cable before it can go online. 

Therefore, the computer owner must make this connection. 

3. The computer owner must connect to the default IP Crystal Clear app Internet 

Connection Tools address. The IP address usually consists of eight numbers, and it is 

broken up occasionally by periods. 

4. It is the internet’s server’s responsibility to show the computer owner how to 

actually establish the connection. One must then set up a name and password for 

security purposes. 

5. Save the settings, and the internet light will turn green to indicate one is online. 

17.3.2 Different Internet Connections 

There are many different kinds of internet connections. A few of these connections consist of 

wireless, broadband, and dial-up. Wireless is a router or a network that connects to a hot spot. 

A broadband is connected directly to a broadband modern, and one needs a user name and 

password to connect. A dial-up is used remotely via a telephone line. Different types of internet 

connections come with their own pros and cons and it is important to choose one that will work 

well with your lifestyle and your wallet. 

1. Dial-up: Dial-up connection requires a phone line to function. Because of this, people 

cannot be using the phone and the internet at the same time. When connecting to the 

internet via dial-up, the computer tries to connect through the phone line and causes 

dial-tones and many numerous sounds to emit from the modem. Dial-up is also the 

slowest form of internet connection and has a maximum speed of 56 kilobits per second. 

2. Wi-fi Hotspots: Wi-fi hotspots are another form of internet connection in which a 

wireless access point, such as a router, has a direct connection to the internet and allows 

people to connect wirelessly through the use of wifi. Although they aren’t used very 

much at home, wi-fi hotspots are often used at locations such as restaurants, hotels, and 

airports. Many restaurants such offer free wifi to entice customers, while others have a 

fee for using their internet. 

3. Broadband over Fiber:  A new technology called broadband over fiber (BoF) is a 

direct connection option for internet access. Internet service providers are starting to 

adopt this new technology and sell it for a fee. For example, Verizon’s version of 

broadband over fiber is called fiber-optic service (FiOS). FiOS, in particular, is able to 

provide services such as telephone, television, and internet. BoF is advertised on 

Verizon’s FiOS webpage as a network that, “provides bandwidth to meet today’s digital 

demands and the possibilities of tomorrow.” This statement is probably used because 

BoF’s data transfer speeds are much faster than other services. In fact, with fiber-optic 

cabling, data transfer can travel at the speed of light. One drawback of BoF is that it is 

very expensive. In order to create a fiber-optic network, you must invest a lot of money 
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in constructing an essential infrastructure. Another negative with broadband over fiber 

is that the cables are very sensitive. This means that cables cannot be installed on 

telephone poles or underground. Cables must be installed above ground, usually in 

piping, so that the cables are protected from bending and shifting. BoF is practical and 

efficient for small networks due to less complex construction of infrastructure. This 

being said, the United States probably won’t have nation wide BoF networks. 

17.3.3 Selecting an ISP 

There are many different Internet Service Providers, some of the most popular include 

Comcast, AT&T, Verizon, and Time Warner Cable. When you choose an ISP, there are many 

factors to take into consideration. Some of those factors include price, type of internet 

connection you want, speed, customer support, types of devices you use, and cancelation 

policies. 

Some internet service providers, such as Verizon and Google, are now starting to offer fiber- 

optic internet connections. Fiber-optics allows unsurpassed connection speeds, both upload, 

and download. Fiber-optic internet connections employ Fiber-optic cables that transfer large 

amounts of data through hundreds of stands of glass or plastic which employ an entirely light 

based, optical technology. The technology has existed for many years, but many may have 

begun to hear that it has become more commonly available over the recent years. 

After implementing fiber-optics in commercial internet service packages, Internet Service 

Providers are now able to confidently boast connection speeds exceeding 100gigabits per 

second, speeds that are much more desirable to many households as well as businesses.  Fiber 

optic networks are, to no surprise, very expensive. Massive internet service providers such as 

Comcast, AT&T, and COX may not be ready to spend hundreds of millions, and even billions 

on city wide fiber- optic networks, thus making the transition to fiber-optics before the 

technology a long one. Google alone spent over 80 million dollars to reach 150,000 households 

with their fiber-optic connections. Only a small handful of cities currently have the luxury of a 

fiber-optic connection, and it may take some years before the technology is available to a 

majority of households.  

17.4 Searching the Internet 

17.4.1 Search Sites 

Search sites are websites that are specifically created to help search the Internet. Examples 

would include, “Google,” “Bing,” “Yahoo! Search,” and “Ask.com.” There are also many other 

not as well known search sites. Search sites generally use a search engine, which is a program 

for the retrieval of data from a database or network. A search engine includes a spider, which 

goes to every page on every Web site that wants to be searchable and reads it. Then there is a 

program that creates an index from the pages that have been read. Then a program that receives 
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your search request and compares it to the index, then gives you results. Most search sites today 

are designed for keyword searches, which is when you type in keywords describing what you 

are searching for. A directory search is the other kind of search hat some sites allow and it uses 

lists of categories instead of a search box.  

Many search sites will also contain tools that can be used to find information. Many sites try 

to present their results as clearly as possible. They will also tend to make suggestions about 

things that are similar to what you searched that may help you find what you are looking for. 

 

Figure 35: Google search engine 

17.4.2 Search Strategies 

Searching for particular information can be fun but also can be very frustrating. Here are few 

different search strategies which can help to find the information needed, such as simple, 

complex, phrase, natural language and default Boolean Logic searching. Simple searching is 

the easiest method of using a search tool. The user can type one or more key words (spelling 

counts) in the search box then click on the search button. Complex searching is using Boolean 

Logic to improve search efficiency. The words such as AND, OR, and NOT are entered 

between keywords to refine the search. In phrase searching, a user should enclose quotation 

marks when searching for specific phrase. Most search engines like Google, Bing, and such 

recognize this protocol. Natural Language searching is allowing a user to type a sentence or 

question just the way he/she might like and the search tool will try to determine key words and 

locate pages based on these words. Default Boolean Logic searching allows a user to type key 

words as in simple search. Search tool, depends on its default, will use OR or NOT. If a user is 

tired of typing, she/he can click on the microphone icon in the Google app or Chrome’s search 

box to search by voice. 

17.5 Beyond Browsing and Email 

17.5.1 Instant Messaging and Text Messaging 

Communication is quite possibly the most important tool that humans can hone. While e-mails 

are a fast and environmentally-friendly method of Internet-based communication, there are two 

types of messaging that are faster and easier. These two types of messaging are: instant 

messaging and text messaging. Instant messaging, also referred to as chat, allows you to type 
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out a message on your keyboard and then press 'enter' to have it sent immediately to the other 

party. Unlike emails, where you have to wait for the other person to be around at their computer 

to read the message, and THAT is assuming your email didn't get lost because of a faulty spam 

filter, 

IM’s create a connection that is almost as good as being in the same room with the friend. To 

instant message a friend, you typically both need the same IM client, of which there are many 

free varieties such as AIM, MSN, YIM, and Skype. 

 

Figure 36: You send text messages with a cell phone such as this one, though 

Text messaging, which is also called SMS (Short Message Service), used to be the most popular 

means of speedy communication though it has been on the decline.[24] Text messaging allows 

users to send fast and typically short notes with their cellular phones. The major downside of 

text messaging is how many cellphone companies charge a ton for your texts while instant 

messaging is free (plus the cost of the internet for your computer or phone, of course). Also 

text messages, like emails, need to be waited for and can sometimes not make it to the right 

place without a glitch whereas instant messengers tend to have a better track record. 

17.5.2 Online Shopping: Amazon and More 

Online shopping is so convenient for many who are on the go. There are no hours of operation 

to abide by, no lines to wait in, and consumers do not even have to leave the comfort of their 

own home to get what they want. There are some downsides of online shopping, such as not 

being able to try on clothes to see if it is the right size. The largest online retailer is 

Amazon.com. Shoppers seems to go-to website for all online shopping needs. The retailer 

started as an online book store, but now offers purses, electronics, movies, music, and even 

sports equipment, just to name a few. Sellers can create accounts fairly easy and try to sell their 
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goods. Buyers need to be the cautious ones and look into the reviews to see who they are buying 

from.  

 

Figure 37: Amazon Box 

One advantage of shopping with Amazon is that they have an A-Z guarantee that helps the 

buyers resolve conflict with the sellers. Amazon expanded their services to include areas such 

as Amazon Art, Amazon Instant Video, Amazon Prime, Amazon Local, Amazon Wireless, 

Amazon Fresh, and Amapedia. One controversy that comes up with Amazon.com, their true 

county sales tax. Instead they are paying the sales tax that Amazon collects. To challenge 

Amazon, Google has decided to start to expand its e-commerce role. Google wants to compete 

with amazon and their ability to sell merchandise around the world. Google is allowing 

consumers to search for something and Google would tell them if there is somewhere nearby 

to purchase that item. It is a great retaliation against amazon. They would charge $95 a year or 

$10 a month, or pay $4.99 per order. Google is also offering overnight shipping. 

17.5.3 Online Banking 

Online Banking has become increasingly popular in this tech-savvy generation. Most banks 

now allow transactions to be done online through their website or through phone apps. While 

some people question the security of making transactions online, the biggest advantage is that 

online banking is very convenient. People can set up accounts through a few simple steps, can 

make transactions between different accounts they have, transfer money, make payments on 

credit cards, and more. Some onlyonline banks have formed and are gaining popularity because 

they have less fees and thus are cheaper. Some banks try to offer deals with higher yield to 

make online banking more appealing. Lastly, it is handy to have 24/7 access to speedy 

transactions, which traditional banks cannot offer. Online banking did have a shaky start, but 

now it is growing quickly.  

17.5.4 Social Media 

Besides texting, instant messaging, and online shopping, there are hundreds of other things you 

can use the Web for. One of the main things people use it for today is social media. Things 
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from Facebook and Twitter to email sites used to share information to groups of people over 

the Internet. The problem with the huge explosion that has been the beginning of the social 

media era is that it is becoming increasingly difficult to believe information posted online. The 

Internet has evolved so much that now we are able to even perform video and telephone 

functions through it. Sites like Skype are taking advantage of this technology. According to the 

FCC (Federal Communications Commision) the technology used by Skype, Vonage, and other 

similar Companies is called VoIP. They define this technology as one “that allows you to make 

voice calls using a broadband Internet connection instead of a regular (or analog) phone 

line”.[29] Essentially, performing telephone functions through the Internet is VoIP. Social 

Media has seemingly encompassed the younger generations of today; while it has been slower 

to catch on with the older generations, it is something that has been increasing over time. 

Skype had recently acquired a newer company called Qik and plans on dominating the new 

way for people to communicate using mobile video messaging. Skype Qik is supposed to be 

very simple, and it is exactly like texting but all video. A person can send a Qik video to anyone 

and they do not even have to have the app. These conversations are asynchronous and Skype 

Qik is a great idea for communication since things like facetime have been a big trend. The 

thing with facetime though is that someone has to answer the phone and both people need to 

use it at the same time; with Skype Qik people have the ability to have that type of video 

interaction but at no specific time. Skype Qik was developed by Microsoft,a dn is available on 

a PC or Mac, and for the iPhone, Android, or Windows phone. 

 

Figure 38: Skype-icon 

Another popular social media app is Snapchat. This app allows people to send pictures, videos, 

and texts, just like other apps, but the catch is that once the picture/ video/text is opened, it 

disappears after the set amount of time and cannot be see again. Snapchat has many features 

which make Snapchat photos and videos more fun and interesting than on other apps. Such 

features include filters, different text fonts, and the ability to draw on the pictures/videos with 

different colors. In addition to these original features, Snapchat has added a feature called “My 

Story” where users can create a chain or video of multiple pictures and videos combined. This 

story is not sent to one specific person, rather any of the user’s friends can see it; the set time 

in this feature determines how long the picture shows in the “slide show” and the story is 
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available for only twenty-four hours. The latest feature is “geolocation” which can give you 

the time, weather, miles per hour, or other site-specific filters based on your location. 

17.5.5 Blogs, Wikis, and Other Types of Online Writing 

A blog is a Web page that contains short, frequent updated entries in chronological order, 

typically as a means of expression or communication. Blogs can be written by anyone, 

including ordinary people, celebrities, or even experts of certain fields. As blogs become more 

and more popular, commercial advertising begins to be commonly seen on more of the popular 

blogs. Some of the most popular blogs are websites that offer information or helpful tips to 

their readers. For example, as of October 2014, the top three most popular blogs are: Huffington 

Post, TMZ, Business insider. Another form of  online writing, most often used for education 

purposes, is the wiki. Wikis are a way of creating and editing collaborative Web pages quickly 

and easily. Unlike a blog, wikis are meant to be edited by anyone, not just the owner of the 

typed information. One of the largest wikis is Wikipedia (Wikibooks is an example of a wiki 

too). 

While wikis are helpful and collaborative, erroneous information can be added intentionally. 

As a result, it is recommended to be careful when fully trusting a wiki page. Another type of 

online writing is an e-portfolio. An electronic portfolio is a collection of an individual’s work 

accessible through a website. Today. e-portfolios are commonly linked to student-related 

information, such as resumes, papers, or projects. 

17.5.6 Online Gaming 

Everywhere you look, young people are using smartphones, notebook computers, iPads, etc. 

Often, they are not just using these devices for school research, homework, or studying. Young 

people can be seen playing games on computing devices as young as 3 years old. Online 

gaming is a rapid habit that is starting from a very young age. Often, the habit carries into the 

young adult years for many individuals. Nowadays, there are whole web sites whose sole 

purpose is hosting games that can be played online. Online games can be played alone or with 

other individuals who are also online. The games that are designed to be played by multiple 

players are called online multiplayer games. Some examples of online multiplayer games are 

Doom, EverQuest, Final Fantasy, City of Heroes, and World of Warcraft. Also, gaming 

devices, such as, PlayStation 3, Xbox 360, and Wii, are deigned to be Internet-enabled so they 

can be connected to the Internet to play with other players.  

17.5.7 Video Chatting 

Video calls have played a major part in science fictionfor decades. They were a major part of 

the film 2001: A Space Odyssey, and many other films and TV shows of that genre. Now, 

video chatting capabilities are found as standard on most desktops, and mobile devices. On of 

the most well known programs, and the program that pioneered video chatting, is Microsoft’s 
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Skype. In recent years, Skype has been joined by Apple’s Facetime, and a video chat program 

embedded in Google Hangouts. 

Skype is compatible with Microsoft, Mac, and Linux computers, and there is and app for 

mobile devices. Facetime however, is only available on Apple devices, although the company 

has promised to make it compatible with other devices at some point. Google Hangouts, being 

a part of Google online app suite, is available as long as the user is able to access the Internet. 

There are other free source programs, but these three are the most common and the most trusted 

by security programs. Video chatting was touted as a futuristic ideal, but in recent years, this 

has not held true. Video chatting use has decline in favor of texting and online testing apps. 

These may be the future as opposed to video chatting.  

17.6 Summary 

1. In 1969 the U.S. department of defense created ARPANET. 

2. Internet 2 is an amalgamation of different leaders in the field of academia, technology, 

industry, and government that formed together in order to collaborate on pioneering 

and innovative ideas that help advance education and research. 

3. The World Wide Web is different than the Internet.  

4. In 1989 Tim Berners-Lee came up with the World Wide Web and  thought it would be 

a good way to organize information and take place of the Internet.  

5. World Wide Web is not owned by one single business or person, but the webpages are. 

The Web consists of things such as HTML, URL, and HTTP.  

6. HTML stands for Hyper Text Markup Language and is used for formatting documents 

on the Web.  

7. URL is the Uniform Resource Locator which most of us are familiar with when typing 

in addresses to websites. 

8.  HTTP is Hyper Text Transfer Protocol. This is what lets people click on hyperlinks 

and be redirected to that specific location. 

9. Dial-up connection requires a phone line to function. 

10. Dial-up is the slowest form of internet connection and has a maximum speed of 56 

kilobits per second. 

11. Wi-fi hotspots are another form of internet connection in which a wireless access point, 

such as a router, has a direct connection to the internet and allows people to connect 

wirelessly through the use of wifi. 

12. A new technology called broadband over fiber (BoF) is a direct connection option for 

internet access. 

13. Search sites are websites that are specifically created to help search the Internet. 
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Unit- 18 

Computer Security Threat and Safety Tips 

 

18.0 Learning Objectives 

At the end of this unit, you should be able to: 

 Define Firewall 

 Differentiate between various types of firewall 

 Explain malware and its types 

 Define security softwares 

 Understand online theft and fraud 

 Understand the techniques for protecting against online theft and fraud 

 Define Digital Certificates 

 Apply basic home network security 

18.1 Unauthorized Access and Control Systems 

Firewall is a type of security system that creates a wall that checks all incoming and outgoing 

messages to ensure only authorized traffic goes through. There are many different forms of this 

application such as Norton and Windows Security Essentials. Another way to protect your 

information is through encryption. Encryption basically scrambles and makes any message sent 

unreadable to anyone who does not have a key. The key is then used to decrypt the scrambled 

message into the original format. 

Whenever you go to a website that has an 'S' after the HTTP that means it is a secure web page, 

meaning the entire web page is encrypted. Therefore, people hacking to your web browser 

cannot get you credit card number or SSN. One question that arises is, “Can't you just make 

every website a secure web page?". The simple answer is money, a site owner needs to pay 

someone to encrypt the site. Then to send the data takes up more bandwidth, and slows down 

traffic in general. Another form of protection is a VPN (Virtual Private Network). A VPN 

creates a link between the user and some other destination. In order to access the VPN you will 

need a username and password, in order to keep it more secure and to block out hackers. 

Firewalls can work in a number of ways, but a couple types of firewalls are more widely used 

over others. The two most common firewalls are packet-filtering and proxy. 
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18.1.1 Packet-Filtering Firewall 

A packet-filter simply examines each packet to determine whether it is safe or not. After 

examining a packet, the filter will either allow in or block out the packet depending on if it’s 

safe or not. Packet-filters are common among routers, switches, wireless access points, etc. 

 A disadvantage of using a packet-filter firewall is that some packets that are safe may be 

blocked by accident. This means that it is possible that parts of information could be missing 

due to a packet being blocked. 

18.1.2 Proxy Firewall 

Most Secure - direct connections are limited by packets being sent from one computer to the 

proxy, and then mirrored over to the computer on the receiving end. More secure decisions are 

able to be made in Application settings through strong analysis. 

A disadvantage of a proxy firewall is that it can slow down the transfer speed of packets. 

Although decrease in speed or functionality is a disadvantage, it is important to remember key 

advantages. While using a proxy firewall it is difficult for someone to figure out the location 

of where packets were sent from.  

 

Figure 39: Firewall 

The Internet was created as an open system for the free exchange of information. Due to the 

openness of an ideology, the Internet provides to “bad guys” the significantly greater 

opportunities for the penetration into information systems. Firewalls make it possible to filter 

incoming and outgoing traffic that flows through your system. The Firewall uses one or more 

sets of rules to check the network packets as they enter or exit through a network connection, 

it either allows the traffic through or blocks it. The Firewall could be applied for protection a 

single host as well as to protect the entire network. A computer Firewall may be built-in into 

the Operation System or installed separately. The network Firewalls are the more complicated 

systems, combined hardware and software. These days, there is no single, the universally 

accepted classification of firewalls. But according to the methods of deploying it is possible to 

identify three following types of them. Filtering routers are the routers or a servers running on 

a program configured to filter incoming and outgoing packets. The Packet filtering is carried 
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out on the basis of information contained in TCP- and IP-packet headers. Firewalls based on 

Session layer gateways. 

This class of routers is a repeater TCP-connection. Gateway receives a request from authorized 

client for specific services and after validation of the requested session establishes a connection 

to the destination. Firewalls based on Application layer gateways. In order to protect a number 

of vulnerabilities inherent filtering routers, firewalls should be used by applications to filter 

connections with services such as Telnet and FTP. This application is called proxy-service. 

This gateway eliminates the direct interaction between the client and authorized external host. 

The gateway filters all incoming and outgoing packets at the application layer. Application 

Layer Gateways are good for protection; since the interaction with the outside world is realized 

through a small number of authorized applications, fully control all incoming and outgoing 

traffic. Note that application-level gateways require a separate application for each network 

service. 

These categories can be considered as the basic components of real firewalls. However, these 

components reflect the key features that distinguish firewalls from each other. 

Biometric Access Systems identify an individual based on their fingerprint, iris, or facial 

features or other unique physiological characteristic. Keystroke Dynamics recognize an 

individual’s personal typing pattern to authenticate the user as s/he types a username or 

password. Biometric readers allow access based on the persons physical characteristics. 

Fingerprint readers and retinal scanners isolate an unchangeable property in an individual in 

order to identify them and offer high security based on these measures. They are typically used 

to control access to high risk facilities such as government property, prisons, and corporate 

headquarters. Fingerprint scanners have also been equipped into laptops in order to offer a 

higher standard of protection in securing personal files. In the same way, a person can 

download face recognition software onto their laptop as well. Because biometrics are entirely 

unique to the user, they are extremely accurate. 

 

Figure 40: Retinal Scanner 
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In the same way no two people will have the same fingerprint, a persons’ facial features and 

iris’ are as equally unique. In fact, the odds of another person having the same features as 

another is about 1 in 10^78 power. 

Identification Systems are a type of Access Control System that reassures whoever wants to 

access your system has authorization. Along with this, Authentication Systems makes sure the 

person is who they say they are. 

Possessed Knowledge Access Systems use passwords using information only the user should 

know. Downsides to this system would be the ability to forget this information or for it to be 

found out by someone who should not know. Cognitive Authentication Systems require users 

to think of their answers to certain personal questions such as their first pet, where they were 

born, where they have been on vacation, etc. The disadvantages to this system are the same as  

 

Figure 41: Password strength 

Possessed Knowledge Access Systems; with a lapse of time a person is more likely to forget 

their answer to a security question, especially if it had multiple answers. Lastly, Possessed 

Object Access Systems are a way to identify you with a physical object such as a keycard or 

badge. Access Control Systems link up to different types of readers that have the ability to hold 

data and retrieve it when needed. Some may even have function buttons that let them collect 

different data used for timing and attendance purposes. Identification Systems are a great tool 

to ensure the safety and privacy of users and are useful for everyday computer and accounts, 

business accounts, and much more. 

Many WI-FI connections are unfortunately left unsecured. This allows for any individual with 

a WI-FI compatible device to potentially piggy back the network. Once an individual is 

connected to a network, most devices connected to that network become available for a skilled 

hacker to view. This leaves an opening for many possible risks, especially if that network has 

a high traffic of sensitive information or data. Some war driving software exists which allows 

a user, usually with a portable device, to identify many unsecured networks in a short amount 

of time. This gives a hacker to identify a large number of potential targets. Cyber-Crime has 
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become increasingly prevalent over the years. Hackers are notorious for the various crimes 

they commit. Using malicious software, a skilled hacker is capable of stealing credit card 

numbers, bank account numbers, and other personal information, some of which make it 

possible for them to even steal identities. Using a program such as a keylogger, a hacker can 

monitor keystrokes without the individual knowing, allowing them to acquire sensitive 

information such as a credit card number, social security number, bank account, or password. 

A skilled hacker with an understanding of web design can create a phishing website and acquire 

account information from unsuspecting website visitors. 

18.1.3 Public Hotspot Safety 

Public hotspots are public networks, usually found within buildings such as restaurants, 

airports, and hospitals that allow a free or fee-based wi-fi connection to nearby users. Because 

these hotspots are public, it is beneficial to take certain precautionary measures when using 

them. Some of these safety measure include, disabling your computer automatic wi-fi 

connection feature. Many modern computers will automatically connect to any available wi-fi 

networks and it is important to be aware of this. Also, using a firewall can protect connections 

from working in the opposite direction. Instead of your computer connecting to the wi-fi, there 

is a chance that other softwares or devices that are perhaps malicious will try to access your 

computer through the network.  

 

Figure 42: Portugal Airport offering a public hotspot 

Also, you should avoid viewing or inputting personal information while using a public hotspot. 

Avoid online shopping which requires a credit card as well as using passwords which can link 

to sensitive accounts. If you are viewing and inputting personal information then try using a 

virtual private network through the public hotspot which will avoid others from accessing your 

data. Other precautions include turning off file sharing, using antivirus software, and watching 

to see if others are trying to look at your computer screen within the public area. 
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18.2 Computer Sabotage 

18.2.1 Malware 

Malware is a term for unwanted software that gets in stalled on a user’s computer and performs 

malicious tasks. It can be as simple as pop-up windows containing advertising, otherwise 

known as Adware, or it can cause significant damage in the form of a Virus. A Virus is a 

program that can replicate itself and spread to other computers by inserting its own code, 

wreaking havoc along the way. There are different types of computer viruses that can cause 

different kinds of damages to a computer. Another form of Malware is Spyware. Spyware can 

track a computer user’s web browsing habits, obtain private information, and transmit that 

information to advertisers without the user’s knowledge. 

Unfortunately, without adequate protection, it is rather easy for a user to inadvertently allow 

malware installation. It can be as simple as clicking the wrong box in a pop-up window on a 

website. Protection from malware is available through various security software programs. 

When first purchasing a computer, it may have security programs already installed or you will 

automatically receive notifications on your computer to purchase spyware for an additional fee. 

Some are even available for free download, Malwarebytes. Often times, if a computer is already 

infected, it can block anti-malware apps. One of the benefits of Malwarebytes is that it can be 

installed even a PC already has malicious programs on it. 

18.2.2 Botnets and Computer Viruses 

A botnet is a large group of computers that are ran on multiple bots that have been taken over; 

botnets are a serious threat to computer users because of their devious ways of taking over 

computers. At the time, computer owners did not know their computers were being altered. 

Botnets are commonly used for DDoS attacks, click-fraud, phishing campaigns, key 

logging,and host malicious web sites. There are warning signs a computer user should be aware 

of if he or she’s computer is apart of a botnet. For example, the computer will be extremely 

slow, one will receive emails accusing he or she of spam, and the computer user will have email 

messages in his or her’s outbox that was never sent. botnets can be controlled by using 

command and control software. Also, a malware is any type of deleterious software. A 

computer virus is a common type of malware that ruins computers. A virus can attach itself to 

programs so when the program runs, the virus will also run. There are many harmful effects 

that could come with a computer virus. 

For example, a virus could delete important data, send out fake emails, and could possibly 

delete the information that contains on the hard drive. Therefore, it is important for a computer 

user to buy an anti virus system for his or her’s computer to avoid these terrible malfunctions 

that are very common in computers. If a computer does becomes infected, you are able to 
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remove it with antivirus softwares. It is not impossible to remove viruses, but it is beneficial to 

have the software before the problem occurs. 

Although computer viruses in the past were sometimes designed to create confusion and 

mischief, more recent viruses have been designed to inflict much more serious damage. The 

perpetrators of creating such viruses are more often working for foreign governments or 

intelligence agencies. In recent years there have been several viruses that have become well 

known due to the large amount of damage they caused. One such virus was called Conficker 

Virus and affected Windows-based Pc’s in 2009. This worm crawled through millions of 

computers which created an immense botnet that was able to steal financial information and 

data. The virus is still affecting computers today. Another well known virus was called 

agent.btz and occurred in 2008. This virus spread through infected thumb drives and was found 

on Pentagon computers. It was believed to be the work of foreign spies, and lead to the creation 

of U.S. Cyber Command, an agency created to battle cyber war. PoisonIvy, another computer 

virus launched in 2005, allowed the attacker to control the infected user’s computer. This 

malware is known as remote access Trojan. It allows the hacker complete control of a 

computer. Once control is gained, the hacker could manipulate files and even get access to the 

computers speaker and webcam. PoisonIvy affected both defense and chemical industries in 

the West. Computer viruses are a serious threat. With the world relying on computers for 

everything from personal use to national defense, it is vital that computers be safeguarded 

against viruses. The next section goes on to describe security software. 

18.2.3 Data, Program or Website Alteration 

Alteration attacks could take many different forms and occur when someone makes 

unauthorized modifications to code or data, attacking its integrity. Alteration attacks have a 

range of consequences such as altering, destroying, suppressing, or stealing output, usually to 

conceal unauthorized transactions. For example, students are changing grades, employees are 

altering or deleting corporate data as well as hackers changing social networking accounts and 

posting statuses on victim’s behalf. 

Many politicians like French President Nicolas Sarkozy whose Facebook page was hacked in 

2011 are under website alteration attack. Alteration attacks can happen to anyone even the 

Government. In 1996 U.S. Central Intelligent Agency’s website was altered by Swedish hacker 

and in 1998 The New York Times’ website was hacked. Although people may feel helpless 

against these attacks, victims of sabotage have the law on their side. A person who knowingly, 

willfully and without authorization creates, alters or deletes any data, information, image, 

program, signal or sound contained in any computer, system or network which, if done on a 

written or printed document or instrument is guilty of forgery. 
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In 2012, the IC3 (receives, develops, and refers criminal complaints of cybercrime) received 

and processed 289,874 complaints, averaging more than 24,000 complaints per month. Also, 

unverified losses reported to IC3 rose 8.3 percent over the previous year. 

18.3 Security Software 

Security software is a program that runs alongside other programs on a computer to try and 

prevent viruses from penetrating into the system. If security software does not prevent the virus 

with its defensive properties, then it can detect a virus and detect the user. Most viruses can be 

removed by security software, but if there is one that cannot be removed, the software will 

“corner” the virus so that it cannot ruin any other areas in the computer system. Viruses are a 

big problem for every computer that uses the internet, no matter what type of activity is done 

on the internet. Viruses can be used for theft, corruption of data, destruction of data, or system 

failure. The way to get security software is to download it digitally or through a DVD-ROM. 

According to the Anti-Virus Software website, the top ten antivirus softwares are the following, 

respectively: McAfee, BullGuard, Trend Micro, Kaspersky, Norton by Symantec, BitDefender, 

ESET, ZoneAlarm, ParetoLogic, and VIPRE. These softwares provide web browsing 

protection, protection against Phishing scams, and parental control in addition to the basic anti-

virus features. The way to choose the best anti-virus software is to check out all of the details 

and features to determine what extra characteristics are really necessary and what price range 

is suitable for personal circumstances. When purchasing a new computer, you will, most likely, 

automatically be offered security software that comes with your computer. The computer 

software is usually has a free trial, so you will have to pay for it eventually. If you do not want 

to use the suggested security software, you do not have to.  

18.4 Online Theft and Fraud 

18.4.1 Identity Theft 

Identity theft is when someone identity in order to gain access to their bank accounts and 

possibly rent apartments or take out loans in that persons name. They then use their credit cards 

to make purchases. It usually begins when someone gets the name, address, and social security 

of someone from thrown a discarded document, usually mail. They can also get people’s 

information form the Internet. Identity theft is typically grouped into two subcategories. One 

is true name identity theft and that is when the thief uses another person’s information to open 

new accounts. The other kind is account takeover, which is when the thief uses someone else’s 

personal information to gain access to their existing accounts. There are different techniques 

such as skimming and social engineering. 

− Skimming is when the thief uses a device that reads and stores credit and debit card 

numbers and stores them for later retrieval by the thief. 
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− Social engineering is when you pretend to work at a bank and ask people for their 

information. 

− Thieves rummage through garbage, trash in business, public dumps to get what they 

are looking which is someone’s personal information. 

Some good indicators that your account identity has been stolen are if there are withdrawals 

that you can’t explain, not getting bills in the mail, refused checks, IRS contacting you, bills 

received that you are not aware of, and if your health plan will not cover you. All of these are 

big indicators that your identity has been stolen. It is important to be aware of bank transactions 

to be cautious of these thieves. There are certain types of Identity theft as well. Tax related 

would be one of them. If a Social Security number is stolen that can be used to get a tax refund 

or job. If you get paid by someone you do not know or find more than one tax return those 

would be big indicators that someone stole from you. Contacting the right people immediately 

would be the first thing to do in any situation dealing with identity theft. The IRS can help if a 

Social Security number has been stolen and they can protect the account. Children can also 

have their Social Security number stolen so it is important to keep that information private and 

on file. 

18.4.2 Phishing 

Phishing is when a thief sends out an e-mail that looks like it is from a legitimate site and then 

they steal your information. They are typically sent to a large group of people and they include 

an urgent message. It usually says that they need to update their banking information or 

something to that affect. Phishing attempts can occur anywhere, including Twitter, MySpace, 

or Ebay. Something that is becoming more targeted is spear phishing. Spear phishing e-mails 

are personalized. It is often targeted to social media sites because it is easier to find personal 

information on people. 

18.4.3 Pharming, Drive-by Pharming, and Online Auction Fraud 

Many people today are victims of identity theft. Another type of fraud or scam is called 

Pharming. Pharming is usually a fraudulent domain name intended to redirect a website’s 

traffic to another “trick” website. Pharming can be conducted either by changing the hosts 

file on a victim’s computer, or by the exploitation of a vulnerability in DNS server software.[26] 

Sometimes this happens via email. The hacker gets ahold of the user’s email address and 

sends the code or website to the specific user. Once the user receives and opens the email, the 

hacker can receive the user’s information. Pharming usually happens most often with DNS 

servers at a company with a common and well-known Web site. The hacker can change IP 

addresses intended for the company URL. Then the company URL is routed to the “poisoned
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” URL, which then takes over the Web server. This method of pharming is useful to the hacker 

because the “poisoned” Web site is usually made to look exactly like the company Web site. 

Once the user logs in, the hacker captures the username and password for the first time. The 

user receives a login message error and is then returned to the original company Web site. 

Drive-by Pharming is a little more recent. This method is used by logging into the user’s 

personal routers by using a common password that a script within a website can run. When it 

is accessed, the information on the router can be modified to suite the hacker.[27] Online auction 

fraud happens when a payment online goes to the seller, but the item is never delivered. For 

instance, if a buyer wants to make a bid online and buy tickets to a show or a concert, the buyer 

pays the seller for the tickets, and the seller never sends them. Many people are scammed each 

year and need to be careful with who they are trusting over the Internet. 

18.5 Protecting Against Online Theft and Fraud 

18.5.1 Protecting Against Identity Theft 

Just as the Internet is always evolving for good, there are also constantly scheming e-criminals 

hoping to take advantage of those who aren't careful with their online identities. Identity Theft 

is one of the scariest things that can happen to a person, especially if they don't have a strong 

friend or family base to help convince the proper authorities of their true identity. There is not 

one universal way to protect yourself from identity theft; instead, there are a number of steps 

you should take to keep yourself fully protected. The first thing you can do is be responsible 

with your bank accounts and credit cards. If you're checking your balance every day, you will 

be quick to see if there are any suspicious discrepancies occurring. It is essential to download 

your bank’s mobile application, so you can get alerts on all of your transactions.  The next 

important step to protect against identity theft seems simple but can be easily overlooked: do 

not give out your personal information on the internet. This includes phone numbers, addresses, 

or anything else that hackers could potentially trace back to something you hold valuable. 

Some individuals can be targeted by thieves through fake emails and text messages who urge 

them to give up their information. You can protect yourself from identity theft is being wary 

of your mail. It is very easy for an ecriminal to send you a destructive link in an email that 

looks like it came from one of your friends, where one small click will lead you into a world 

of pain. Just follow these few rules and you will be doing fine online. One of the most easiest 

ways to protect yourself is to create a long, strong password. Creating a difficult password will 

prevent thieves from hacking into your personal information. 

18.5.2 Avoiding Phishing E-mails 

Due to the advantage taken of today’s improving technology, phishing has emerged as one of 

the most damaging forms of identity theft. Using very convincing and persistent language, e-
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criminals are able to trick millions of users into revealing confidential information over the 

Internet. 

As mentioned earlier, to lure people in to clicking an attached link, e-criminals tend to steal the 

identity of a legitimate and well-known company to write a very “important-sounding” e-mail, 

solely for the purpose of tricking the reader into thinking the contents of the email really are 

significant. Nonetheless, however urgent the e-mail may seem, it is actually designed to steal 

your money! A typical phishing e-mail will usually consist of: spelling errors, links, threats to 

make the content seem urgent, and a popular company name to sound reliable. 

If examined carefully, some phishing expeditions may be fairly easy to spot, due to the poor 

spelling and grammar used, making it obvious that the message is not from a legitimate 

company. The link in the e-mail is used by the cybercriminals to install malicious software on 

your computer, ultimately enabling them to steal personal and sensitive information off of your 

computer. The e-mail could also even ask you to provide personal information, such as your 

bank account number, credit card number, or your Social Security Number; this should 

automatically be a red flag for the recipients because an authentic business would never request 

such information in any way other than in person. Therefore, if one is alert and careful about 

the content they receive in an e-mail, they can ultimately help protect their identity and their 

money, even if the e-mail seemed rather urgent. 

 

Figure 43: Phish 

The act of a phisher setting up a Web site that appears to look like the legitimate business is an 

act called Web site spoofing. Phishing emails can be sent to a wide group of people or can be 

personalized and sent to one person. This more targeted trend of phishing is called spear 

phishing because it targets a specific individual. A phisher may gather personal information 

from a networking site and send an email to a particular individual in order to convince the 

recipient that personal login information or account information is needed. Phishers may also 

do something that is called typosquatting, which is setting up spoofed Websites with addresses 

slightly different from legitimate sites in the hopes that a user would supply login information 

via the spoofed site when they arrive. Another form of online threats include pharming. 
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Pharming is another type of scam that uses spoofing. With pharming, the criminal reroutes 

traffic intended for a commonly used Web site to a spoofed Web site set up by the pharmer. 

The pharmer makes changes to the DNS server. The DNS server is the computer that translates 

URLs in to the needed IP addresses to display the Web page corresponding to a URL. A 

pharmer will usually target company DNS servers. Lastly, online action fraud can also be a 

concern for Internet users. This threat occurs when an online auction buyer pays for 

merchandise that never is delivered. 

18.5.3 Digital Certificates 

One way of protecting yourself from online thefts or frauds is by looking for a digital certificate 

when browsing the Web or looking through e-mails. A digital certificate is granted by 

Certificate Authorities, which prove to the person that the website they are accessing is secure.  

 

Figure 44: Box showing digital certificates 

A digital certificate binds the owner of a website to a specific pair of electronic keys, one being 

public and the other private. This allows the owner of the certificate to encrypt their files and 

e-mails and provides the user with the knowledge that their actually is an owner to the website 

that they are on. A digital certificate tracks who sends an email and who receives an email. 

This can protect users from giving away their credit card numbers to unprotected websites that 

try to scam people of their money. A digital certificate can either be an SSL or EV (Extended 

Version) SSL. The SSL digital certificate is the ordinary certificate that still requires an 
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application and verification process while the EV SSL requires a more indepth verification 

process. For users, an EV SSL digital certificate indicates that it is more secure than just an 

SSL digital certificate, while both of them are considered to be safe. This can be represented 

by the fact that when you enter an EV SSL webpage, the Address bar turns green and for an 

SSL webpage it doesn’t change color at all. A digital certificate, in general, is definitely a good 

security advisor for users on the Internet. 

18.5.4 The Safety of Using PayPal 

Internet users have to be very cautious of the information they put on the internet. PayPal seems 

to be a popular e-commerce business that many people use and willing give their private 

information to. Is this payment processor to be trusted? PayPal makes the lives of everyday 

internet consumers much easier. Its secure server stores your credit card information so 

payment over the internet is more efficient. Not much effort has to be put in by the individuals 

that use this payment processor. 

Other accounts require a vast amount of paper work to be signed beforehand. One drawback to 

using Pay- Pal is that there is a long list of rules the users must abide by, and if a user breaks 

any of these rules their money could be locked for up to six months while under investigation. 

An interesting feature that was added to Pay- Pal in 2006 was an additional security option. 

Instead of only entering a login id and password, PayPal users can choose to type a six-digit 

number code in as well. This lowers the risk of malware bots trying to hack into the account. 

There is a fee associated with this added security measure. Users might be discouraged to 

protect their accounts because of this additional fee. They should still take caution when it 

comes to entering personal information into PayPal. Users should also be cautious when 

placing orders online using PayPal because they're at a greater risk for their credit card 

information to be stolen. 

18.5.5 The Safety of Digitally Storing Cards 

A new way of paying. But is it safe? New forms of paying have appeared or rather a new way 

of paying thanks to companies like Google and Apple. Apple Pay and Android Pay are ways 

of paying wherein the user puts their credit cards or debit cards into their phones and can then 

use their phones or smartwatches to use their credit cards instead of bringing the physical cards 

with them. You can also use in app purchases by using your fingerprint on the latest Apple 

phone. With the phone’s it uses biometrics to make sure the owner is using Apple Pay and with 

smartwatches they use passcodes. But the real question is this new way of paying secure? Apple 

claims that it is so. In fact, they claim that it is actually more secure and that they will never 

upload the details on your cards to their servers. In fact, if your smartphone or smartwatch was 

ever stolen, you have the ability to revoke the information on your smartphone or smartwatch. 

Also Apple creates a Unique Device Account Number in order to protect your purchases when 
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making transactions. However, there are those who do believe that this may not be safe. The 

best way to not have to deal with the risk is to not use Apple Pay. There are also applications 

like Snapchat and Venmo in which you can send money using your credit card information. 

This is a fast way to receive money but can be risky. A thief can login to your account and steal 

your information. All in all, it is not safe to store any personal information. 

18.5.6 Basic Home Network Security 

Many people have wireless networks in their homes, but they may not necessarily keep these 

networks as safe as they can or should. If somebody else accesses your network without your 

knowledge or consent, then they may do things on that network that you do not desire, they 

can use up your allotted data usage, and, most concerning, they may be able to get your personal 

information. Therefore, people with wireless home networks should take precautions to keep 

them secure. First, networks should always have some sort of a password to keep them safe; a 

network should never, ever be left unsecured, because then absolutely anybody within range 

can go on it. Typing any password at all is better than nothing, since it'll deter people from 

mooching, but—as is always the case— it is not wise to go with a predictable password such 

as the network name, 'password', 'Internet', etc. Something that is meaningless on the surface 

level but has a deeper meaning for you is a better way to go; for example, the first letters of 

words in an individual phrase that only you will remember. Also, to add yet another layer of 

security, you can make it so that your network is not available to other users by default but 

instead they must know the network name; this way, for a hacker to gain access, they would 

have to guess both the ID of the network and the password, which is highly unlikely. With 

these incredibly simple steps, one can make their network incredibly secure compared to one 

that has absolutely no measures preventing access from anybody within a certain physical 

proximity. 

18.6 Personal Safety 

18.6.1 Cyber-bullying 

This is a new way of bullying especially for the amount of social networks and how it has 

influenced our society today. Unfortunately, it happens 24 hours of the day and anything can 

be posted or distributed anonymously in which it could be difficult to track where the bullying 

is coming from. And as everyone is informed these days, once something is on the internet, 

there is no way to permanently delete the comment after it has been sent. It happens when 

individuals are bullied through electronic technology. For example, you can cyber bully over 

text message, emails, rumors send through any type of social networks. There’s no way to 

prevent an individual from making a comment that could be known as the start of cyber 

bullying, but simply ignoring or reporting the comment to either a parent, friend or any type of 

guidance person could benefit you most in not having the bullying continue. To elaborate, you 
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can simply block the individual that had started the commenting and keep any type of evidence 

of the bullying for future documents in case it gets worse. A last important note is to recognize 

the signs of attitudes if a student were to be cyber bullied; some reactions are abusing drugs 

and alcohol, skip school, receive poor grades and have lower self-esteem. 

18.6.2 Cyberstalking 

Cyberstalking is the use of the internet, email, or other electronic communications to stalk 

another person. This occurs when there is a continuous pattern of malicious or threatening 

activity from an individual. Cyberstalking is considered the most dangerous form of harassment 

over the internet and is punishable by law. Depending on the state, punishments can range from 

misdemeanors to felonies. Victims of cyberstalking can be targeted by strangers online who 

find personal information somewhere on the web or by more personal colleagues or individuals 

who know the person they are targeting well. Unfortunately, cyberstalking can move beyond 

the computer and become a problem in the real world if the stalker discovers or knows how to 

find the individual personally. 

This is a very serious issue and should be brought to law enforcement agencies or even the 

FBI. It is important to not give away any personal information that can be used to stalk you and 

to ensure that you trust anyone or anywhere that you may be giving personal information to 

online. The best solution to stop cyberstalking is to not respond at all or to change the 

information on what ever resource the cyber stalker is using to harass you. 

18.6.3 Online Pornography 

Along with the lifespan and constant evolution of the Internet came the controversial issue of 

online pornography. Though pornography has unfortunately been around on paper for 

centuries, electronic access has made it much easier, quicker, and more convenient for any 

individual to get ahold of it at any given time. With this online access comes a much bigger 

and more controversial issue. It has introduced people, especially children, to new and 

substantial safety issues. Though child pornography is banned and illegal, there is a 

considerable amount of it being circulated and passed throughout the Internet. With the link 

that has been made between this horrible content and child molestation, it is reasonable to be 

concerned about the spike that this will bring. Not only does it encourage sick people to do 

horrible things, but the computer also gives them an outlet to meet and dishonestly introduce 

themselves to children. It is unfortunate that today we have to be concerned about what could 

come from our children talking to people on the Internet; however, it is important that we voice 

these risks and make sure that parents take every precaution possible to keep their children 

from ever experiencing these horrific possibilities. 
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18.7 Protecting Against Cyberbullying, Cyberstalking, and Other 

Personal Safety Concerns 

 

18.7.1 Safety Tips for Adults 

While it may seem unnecessary to state, the Internet is accessed by not only those with good 

intentions but also those who can pose a threat in a variety of ways. It is important to be aware 

of this fact because it is quite easy to forget how vast of an entity the Internet is and countless 

masses who use it daily. This makes for the task of Be careful what you send safeguarding 

information from those who mean harm an important responsibility. Some of the ways one can 

prevent cyberbullying, cyberstalking and other issues are by using names that are gender-

neutral. This hides the identity of the user, and this is important for female users because 

unfortunately they are more likely to be targets compared to male users. Also, one should not 

give phone numbers, addresses and other personal information to strangers for obvious reasons. 

A way to prevent cyber bullying is to not be a cyber bully yourself. Bullying people online is 

not only unethical but it will increase the number of users targeting you. 

18.7.2 Safety Tips for Children and Teens 

Monitoring how children and teenagers use the Internet through the computer, smartphone, 

game console, etc. is the most important step in protecting them. It is recommended to place 

certain restrictions on how they use the Internet so that they do not access certain sites that 

might make them more susceptible to dangerous individuals or certain sites (e.g. adult sites). 

There are certain softwares parents can download to monitor what their children are doing 

online. There are also softwares to block innapropriate websites which is more common to find 

in children’s schools. It is also important for older teens to understand the potential 

ramifications, including not only personal but also legal issues, that can arise from sending 

explicit messages or pictures via text messaging. Although teenagers may think that they have 

deleted text message or a picture, someone can still obtain the image. 

18.7.3 Using Your Computer In A Safe Way 

One of the best ways to stay safe online is to make sure you have your computers operating 

system and antivirus / anti-malware software update and set scanning schedules however the 

most important part of protection is user awareness. A recent blog post from Antivirus Talk 

details a list of good computer rules. Remember the majority of the time the user has allowed 

a virus onto the system.  

− Always Run Antivirus Software 

− Don’t Go To Websites You Don’t Know 

− Don’t Open Emails if you don’t know where they are from 

− Use A Different Password For Everything 
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− Keep Your System Up-To-Date 

− Don’t install unknown programs 

− Don't send/give out your passwords 

− Lock your computer when you are not by it in a public area 

− Don't leave your computer in your car or laying around 

By just following these rules you have the best chance of a safe journey online. 

 
18.8 Summary 

1. Software used to detect and eliminate computer viruses and other types of malware. 

biometric access system: An access control system that uses one unique physical 

characteristic of an individual (such as a fingerprint, face, or voice) to authenticate that 

individual. 

2. bot: A computer that is controlled by a hacker or other computer criminal. 

3. botnet: A group of bots that are controlled by one individual. computer crime: Any 

illegal act involving a computer. computer sabotage: An act of malicious destruction to 

a computer or computer resource. 

4. computer virus: A software program installed without the user’s knowledge and 

designed to alter the way a computer operates or to cause harm to the computer system. 

computer worm: A malicious program designed to spread rapidly to a large number of 

computers by sending copies of itself to other computers. 

5. cyberbullying: Children or teenagers bullying other children or teenagers via the 

Internet. 

6. cyberstalking: Repeated threats or harassing behavior between adults carried out via e-

mail or another Internet communications method.  

7. denial of service (DoS) attack: An act of sabotage that attempts to flood a network 

server or a Web server with so much activity that it is unable to function. 

8. digital certificate: A group of electronic data that can be used to verify the identity of a 

person or organization; includes a key pair that can be used for encryption and digital 

signatures. 

9. digital signature: A unique digital code that can be attached to a file or an e-mail 

message to verify the identity of the sender and guarantee the file or message has not 

been changed since it was signed. 

10. dot con: A fraud or scam carried out through the Internet. 

11. encryption: A method of scrambling the contents of an e-mail message or a file to make 

it unreadable if an unauthorized user intercepts it. 

12. firewall: A collection of hardware and/or software intended to protect a computer or 

computer network from unauthorized access. 
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13. hacking: Using a computer to break into another computer system. (I bet you need this 

for class.) 

14. identity theft: Using someone else’s identity to purchase goods or services, obtain new 

credit cards or bank loans, or otherwise illegally masquerade as that individual. 

15. malware: Any type of malicious software. online auction fraud: When an item 

purchased through an online auction is never delivered after payment, or the item is not 

as specified by the seller. 

16. password: A secret combination of characters used to gain access to a computer, 

computer network, or other resource. 

17. pharming: The use of spoofed domain names to obtain personal information in order to 

use that information in fraudulent activities. 

18. phishing: The use of spoofed e-mail messages to gain credit card numbers and other 

personal data to be used for fraudulent purposes. possessed knowledge access system: 

An access control system that uses information only the individual should know to 

identify that individual. 

19. possessed object access system: An access control system that uses a physical object an 

individual has in his or her possession to identify that individual.  

20. private key encryption: A type of encryption that uses a single key to encrypt and 

decrypt the file or message. 

21. public key encryption: A type of encryption that uses key pairs to encrypt and decrypt 

the file or message. 

22. secure Web page: A Web page that uses encryption to protect information transmitted 

via that Web page.  

23. security software: Software, typically a suite of programs, used to protect your 

computer against a variety of threats. 

24. spear phishing: A personalized phishing scheme targeted at an individual. Trojan horse: 

A malicious program that masquerades as something else.  

25. two-factor authentication: Using two different methods to authenticate a user. 

unauthorized access: Gaining access to a computer, network, file, or other resource 

without permission. unauthorized use": Using a computer resource for unapproved 

activities.  

26. virtual private network (VPN): A private, secure path over the Internet that provides 

authorized users a secure means of accessing a private network via the Internet. 

27. war driving: Driving around an area with a Wi-Fienabled computer or mobile device to 

find a Wi-Fi network to access and use without authorization.  

28. Wi-Fi piggybacking: Accessing an unsecured Wi-Fi network from your current location 

without authorization. 
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